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Preface

Preface

This Administrator’s Guide describes ScanMail for IBM Domino (SMID) and provides
installation and uninstallation instructions to help you configure SMID functions for
your specific needs.

The ScanMail Administrator s Guide discusses the following topics:

*  Introducing ScanMail and ScanMail Suite for IBM Domzino 5.6 provides an overview of
the product and description of all new features in this release.

e nstalling ScanMail for IBM Domino provides step-by-step instructions on installing
ScanMail for IBM Domino.

*  Getting Started with SMID provides recommended procedures to configure SMID
after you have installed it.

*  Configuring Scan Tasks provides procedures to create policies, rules, or expressions
that SMID will use to protect a Domino environment.

*  Performing Administrative Tasks provides procedures to monitor server status and
create rules for individual or groups of Domino servers.

*  Updating Components provides procedures to update antivirus and content security
components.

o Sending ScanMail for IBM Domino Notifications provides procedures to send ScanMail
notifications.
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Using the 1og and Quarantine Databases provides procedures to maximize the use of the
ScanMail Log and Quarantine databases.

Using ScanMail for IBM Domino with Trend Micro Control Manager provides details on
how to use Trend Micro Control Manager™ to manage ScanMail.

Removing SMID provides procedures for removing ScanMail for IBM Domino.
Troubleshooting provides troubleshooting tips.

Getting Support provides guidelines to get more information.

Additionally, the ScanMail Administrator’s Guide contains the following appendices:

Understanding Threats in a Domino Environment provides information on the types of
threats found in a Domino environment.
ScanMail for IBM Domino Best Practices provides installation instructions to improve

opetration and obtain maximum performance for SMID.

Program File and Folder 1ists provides a list of the SMID and Control Manager files
and folder structures that are available upon a successful application installation.

SMLD 5.5 and SMID 5.6 Feature Comparison provides a comparison of ScanMail for
Lotus Domino 5.5 and ScanMail for IBM Domino 5.6 features.
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What’s New in Version 5.6

ScanMail for IBM Domino represents a significant advancement in anti-malware,
Advanced Persistent Threat (APT) Prevention, content security, and data loss
prevention for IBM Domino environments. ScanMail Suite for IBM Domino provides
state-of-the-art detection based on heuristic rule-based scanning, recognition of
Approved/Blocked Senders lists and signature databases. It also includes anti-spam,
content filtering, and data loss prevention that may be applied according to the needs of
your organization.

Note: IBM has changed its product name from IBM Lotus Domino to IBM Domino since
the release of Domino 9.0. From version 5.6, Trend Micro renames ScanMail for
Lotus Domino (SMLD) to ScanMail for IBM Domino (SMID) accordingly.

Configuration improvements make SMID more flexible and scalable than ever before.
*  Enhanced Web Reputation

*  Enbanced Approved/ Blocked Lists

*  Log Search

*  Enbanced APT Prevention

*  Enbanced EUQ

*  Enbanced Macro Scan

*  IBM Domino 9.0 Support

e IPv6 support

Enhanced Web Reputation

Web reputation scanning can provide the latest protection against Web threats and
attacks based on Trend Micro's Smart Protection Networks (SPN). In this version of
ScanMail, category information about malicious URLs, for example, social and porn
sites, will be provided in web reputation detection logs. Moreover, for performance
consideration, administrators are allowed to choose the type of messages that will be
scanned by Web Reputation. For example, they can choose only to scan SMTP mails to
save resources. After scanning, notification for web reputation detection will be

provided.
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Enhanced Approved/Blocked Lists

In previous ScanMail versions, there is a size limit for both Approved/Blocked Senders
list in Anti-spam filter and Approved URL list in Web Reputation. In this version, those
lists that are redesigned have no size limit.

Log Search

In previous ScanMail versions, the log database (smvlog.nsf) cannot be searched. The
log search function is critical for security incident investigation. In this version, the log
search function is provided, and search conditions are configurable.

For details about the log search function, see Searching for Logs on page 8-5.

Enhanced APT Prevention

From version 5.5, ScanMail is integrated with Advanced Threat Scan Engine (ATSE)
and Deep Discovery Advisor (DDA) for Advanced Persistent Threat (APT) prevention.
With the help of the latest sandbox technology, DDA will return the detection result for
unknown risks and zero-day attacks, including the security risk level. In this version,
administrators are allowed to set their own APT prevention level.

More and mote email attacks come from specific countries. This version of ScanMail
can block email attacks from those countries by checking character sets.

Enhanced EUQ

In SMLD 5.5, if you enable the End User Quarantine (EUQ) feature, it will be applied
to all users. In SMID 5.6, the feature has been enhanced to apply to targeted
users/groups and mail templates.

Enhanced Macro Scan

Macro scan uses heutistic scanning to detect macro viruses/malwate and strips all
detected macro codes. This version allows administrators to configure the heuristic level
for macro scan.

IBM Domino 9.0 Support
This version of ScanMail supports the latest IBM Domino 9.0.
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IPv6 support
This version of ScanMail supports IPv6.

Audience

ScanMail for IBM Domino documentation assumes a basic knowledge of security
systems and administration of IBM Domino™ email and information sharing system
functions. The Administrator’s Guide and Domino-based online Help are designed for
Domino and network administrators.

Document Conventions

To help you locate and interpret information easily, the ScanMail documentation (Help
and Administrator’s Guide) uses the following conventions.

TABLE 1-1. Conventions used in SMID documentation
CONVENTION DESCRIPTION
ALL CAPITALS Acronyms, abbreviations, and names of certain com-

mands and keys on the keyboard

Bold Menus and menu commands, command buttons, tabs,
options, and ScanMail tasks

Monospace Examples, sample command lines, program code, and
program output

Configuration notes

Note:

Recommendations
Tip:

Reminders on actions or configurations that should be
WARNING! avoided

vii
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Chapter 1

Introducing ScanMail and ScanMail
Suite for IBM Domino 5.6

ScanMail for IBM Domino (SMID) offers comprehensive virus protection and content

security for the Domino environments, providing real-time scanning for viruses, adware,
and spyware hidden within email attachments and databases. ScanMail for IBM Domino
prevents viruses and other malicious code from entering your Domino environment.

ScanMail Suite for IBM Domino provides an added layer of protection through
revolutionary anti-spam technologies and data loss prevention. ScanMail Suite for IBM
Domino performs spam detection before it performs real-time mail scanning,

This chapter discusses the following topics:

Product Overview on page 1-2

Types of Scans on page 1-7

Understanding Policies, Rules, and Filters on page 1-9

ScanMail Protection Strategy on page 1-12

Planning for a Policy-Based Antivirus and Content Security Profection on page 1-12
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Product Overview

ScanMail for IBM Domino (SMID) works in real time to prevent viruses, malicious code
(also known as malware), and unwanted content from entering your Domino
environment through mail, replication, or infected documents. Malware scanning is
performed in memory, which significantly increases the scanning speed.

ScanMail is designed to operate as a native Domino server application and thus provides
administrators with a familiar, intuitive interface. The configuration interface for
ScanMail is fully integrated with the Domino server and supports remote management
from any IBM Notes workstation, Web browser, or Domino R8/R9 Administration
Client. This version of ScanMail for IBM Domino is designed to run on the

Microsoft ™ Windows ™ and Tinux.

The ScanMail Standard version provides security risk scanning in all modes and
component update. The ScanMail Suite version additionally provides Web reputation,
content and spam filtering, end-user quarantine functionalities. The Suite with Data
Loss Prevention version provides all the features from Standard and Suite versions and
additionally provides Data Loss Prevention.

ScanMail is fully compatible with Trend Micro Control Manager™, the Trend Micro
centralized management console that lets you consolidate your antivirus and content
security protection into a cohesive solution.

Administrators can specify which databases are to be scanned, and users are prevented
from overwriting a clean document with an infected version. Manual database scanning
cleans existing infections.

ScanMail helps administrators enforce company email policies, increase overall server
efficiency, and minimize virus outbreaks. Administrators can create rules to block
certain file types and block, delay, and prioritize messages. A corporate policy can be
implemented to deal with malware incidents in several ways:

*  Isolate the infected file for later cleaning or other action.

*  Send the infected item to the intended recipient along with a notification that the
file is infected and has not been cleaned.

*  Delete the infected file.
*  Block the infected file and prevent it from being delivered.

e Alert the administrator.
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By using a multi-threaded scan engine and memory scanning, ScanMail is able to
maximize efficiency and minimize impact on IBM Domino servers. Administrators can
identify servers that don’t require scanning, thus eliminating redundant scanning,

To see where ScanMail fits in a comprehensive approach to protecting your
environment, see:

http://www.trendmicro.com/us/business/index.html

ScanMail for IBM Domino Standard Features

ScanMail for IBM Domino Standard version features include:

*  Multi-threaded in-memory scanning process for fast performance.

*  Support for true file formats for both malware scanning and attachment blocking,
*  Support for multiple instances of ScanMail on multiple Domino servers.

*  Real-time mail scanning, and real-time, manual, and scheduled database scanning.

*  Customizable scanning options, such as limiting the extracted file size for
compressed file scanning and enabling message body scanning,

*  Advanced scanning options, which include:

*  Anincremental scanning option that saves considerable server time and
resources during manual and scheduled database scans because it allows
selective scanning of new and newly modified documents.

*  Notes script scanning to eliminate malicious code at the source before it can do
any damage.

*  Rich Text and Stored Form hot spot scanning.

*  Safeguard against Advance Persistent Threats (APTSs) through latest technologies,
such as Advanced Threat Scan Engine (ATSE) and Deep Discovery Advisor.

*  Ability to create policies and rules that define how ScanMail protects the Domino
environment, updates components, sends notifications, and trusts cluster servers.

*  Scheduled and manual component updates.
*  ScanMail scan and update notifications.
*  Proactive outbreak prevention through Control Manager (CM).

*  Trusted server configuration for multi-server environments, which allows certain
servers to be configured so that messages scanned on trusted servers will not be
scanned again, thus saving server time and resources.

1-3
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* A Quarantine database that allows easy viewing of quarantined email and
attachment information.

*  Complete logging and reporting capabilities, which include statistics and charting.

*  Integration with Trend Micro Threat Connect information portal.

ScanMail for IBM Domino Suite Features

ScanMail for IBM Domino Suite version contains all the features of the Standard
version and the following additional features:

*  End-user quarantine

*  Anti-spam filtering

*  Filter message content by subject or body text

*  Filter message by attachment content or attachment file name

*  Scan attached MS Office documents, PDF, .txt, .html, and .rtf files

*  Web reputation filtering

ScanMail for IBM Domino Suite with Data Loss Prevention
Features

ScanMail for IBM Domino Suite with Data Loss Prevention version contains all the
features of the Suite version and the Data Loss Prevention (DLP) Filtering,

ScanMail for IBM Domino Versions Comparison

A brief comparison of ScanMail Suite and Standard features is shown in Table 7-1.

TABLE 1-1. Comparison of Features for ScanMail for IBM Domino Standard and
Suite Versions

SUITE WITH
FEATURE STANDARD | SUITE DATA Loss
PREVENTION
Antivirus Yes Yes Yes
Anti-Spam No Yes Yes
Web Reputation Service (WRS) No Yes Yes
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TABLE 1-1. Comparison of Features for ScanMail for IBM Domino Standard and
Suite Versions

SUITE WITH
FEATURE STANDARD | SUITE DATA Loss
PREVENTION
Active Update Yes Yes Yes
Control Manager Agent Yes Yes Yes
End User Quarantine No Yes Yes
Advance Persistent Threats (APT) Pre- |Yes Yes Yes
vention Filtering
Threat Connect Integration Yes Yes Yes

Content Filtering

Subject/Attachment/Body/MS Office, |No Yes Yes
PDEF, .txt, .html, and .rtf files

Data Loss Prevention (DLP) Filtering

Subject/Attachment/Body/MS Office, |No No Yes
PDE, .txt, .html, and .rtf files

Note:  Advance Persistent Threats (APT) Prevention Filtering is NOT supported on
Windows 32-bit.

How ScanMail Works

The Trend Micro scan engine uses both rule-based and pattern recognition technologies
and includes MacroTrap technology, which detects and removes macro viruses.
Frequent, automatic virus pattern and scan engine updates occur through a Web-based
download mechanism, which does not require a shutting down ScanMail.

ScanMail scans and cleans attachments and document content on all entry points, as
illustrated in Figure 1-1:
*  Email attachments are scanned in real time at the IBM Domino mail server.

*  Database events are monitored and attachments are scanned immediately.

1-5
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*  Databases and modified data are scanned during replication.

*  Existing attachments in mailboxes and Domino databases are scanned to root out
old infections.

Attachments

ScanMail
for
IBM

Domino

Messages in
real-time

Databases and

modified data

FIGURE 1-1. ScanMail detects and removes threats before infections
can spread to the desktop.

ScanMail maintains a comprehensive activity log with detailed information for the
infected file.

Java-based charts help administrators identify virus infections throughout the enterprise
environment. Reports from different servers can be consolidated through Notes
database replication.

ScanMail Components
The ScanMail Setup adds the following components to a Domino server after a
successful installation:
*  databases
*  database templates

e tasks



Introducing ScanMail and ScanMail Suite for IBM Domino 5.6

*  notes.ini entries

Types of Scans

ScanMail scans messages processed by the Domino mail router task, databases,
documents, directories. ScanMail processes these items based on filters and rules that
are defined in policies that you specify. See Planning for a Policy-based Antivirus and Content
Security Protection on page 4-2.

Note: ScanMail provides a default policy to automatically protect Domino servets as soon
as the installation finishes. The default policy cannot be deleted.

ScanMail does #7of scan the following:

*  Encrypted mail messages and their attachments

*  Password-protected files

*  Files that contain more than 20 layers of compression

*  Partal / incomplete messages

ScanMail provides the following types of scans:
*  Real-time mail scanning
*  Real-time database scanning

*  Manual and scheduled database scanning

Real-time Mail Scanning

Real-time mail scanning allows ScanMail to scan @/ email transactions— messages to
and from individual Notes Clients, and messages to and from a Notes Client and users
not in the Domino network (those using the Internet, for example). ScanMail protects
users against receiving malware from other Notes users and from outside sources.
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Real-time Database Scanning

Real-time database scanning allows ScanMail to monitor all database document
modifications as the documents are opened or updated in real time. ScanMail performs
real-time monitoring on all or selected databases, and scans and filters databases that are
designated for replication to or from other servers.

To maximize efficiency, ScanMail checks only those documents that have been modified
and immediately scans them for malware. After scanning, ScanMail closes the document
and the replicator task proceeds to the next document. Trend Micro uses this method
because it is faster and more precise, which is especially important when Domino
performs replication with remote servers through costly or slow telephone lines.

Real-time database scanning does not interrupt the entire replication process; rather, it
prevents only the infected file from being saved, and replication of subsequent
documents is unaffected.

Real-time database scanning can be time-consuming and processor intensive if your
Domino server includes many databases and thousands of frequently updated files. To
minimize overhead, you might want to activate real-time scanning only for the databases
that are most vulnerable to virus infections. For example, user databases are probably
more vulnerable to virus infections than Domino program databases. Documents and
attachments in user mail files are protected by real-time message scanning and do not
need to be rescanned.

To protect databases that are not modified frequently, use manual or scheduled database
scanning,

Manual and Scheduled Database Scanning

1-8

Manual and scheduled scanning applies only to Notes databases. Although ScanMail
does not scan other types of files on the hard drive:

e all file types contained within a Notes database can be checked for viruses, which
includes OLE attachments and script bombs.

*  all mail documents within the Notes database will be checked for content security,
and data loss prevention.
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Note:  ScanMail invokes the real-time mail scan task and applies its settings when manually
scanning mail.box databases. If the real-time mail scan task is not running when a
manual scan is invoked, a message appears on the Domino console and log file.

If you select the Incremental Scan option for scheduled and manual scanning
operations, ScanMail scans only documents that are new or have been modified since
the last manual or scheduled scan. By limiting the scan to these documents, you can save
server resources and time.

WARNING! The scheduled or manual scan may not be able to detect malware if the
virus pattern file used at the time of scanning is out-of-date. By enabling
incremental scan in a scheduled database rule or manual scan, infected
documents will never be rescanned and the malware will not be detected.
Trend Micro recommends using the latest antivirus components to run a
full manual scan at least once a week (preferably during non-peak hours).

See Understanding Threats in a Domino Environment on page A-1 for more information.

Understanding Policies, Rules, and Filters

ScanMail for IBM Domino (SMID) provides the ability to create policies that define how
it protects the Domino environment, updates components, sends notifications, and
trusts cluster servers. ScanMail implements one policy per server. ScanMail provides a
default policy that includes a real-time mail scan rule that automatically protects all
Domino servers that do not have an explicit policy implemented after a successful
installation. Figure 1-2 depicts the relationship of a server policy and the rules and filters
that make up the policy.

* A policy is composed of rules that define how ScanMail protects the Domino
environment, updates components, sends notifications, and trusts cluster servers.
ScanMail applies a policy to a server, which means it has the ability to share policies
across applicable platforms (for example, Domino servers hosted on a Windows
server can implement the same policy).

*  Rules define:

¢ how ScanMail scans mail in real-time
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*  how ScanMail performs real-time database scans
*  when ScanMalil initiates a scheduled database scan
*  when updates occur for the antivirus and content security components
*  how notifications are delivered
You can define unlimited rules per policy. However, the more rules that you have,
the longer it takes to evaluate a given message.
*  Rules contain fi/ters, which actually define the scanning actions for messages and

attachments.

Notification |
Rule

Mafl Scan |
Rule

Database |
Scan Rule

S - ) 4age Rl
General settings Atfachment Filter
Scan Options filter Scan Restrictions

Security Risk Scan

Content Filter

Script Filter

Data Loss Prevention Filter

APT Prevention Filter

FIGURE 1-2.  Policy-filter-rule relationship
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ScanMail Rules

ScanMail provides the rules described in Table 7-2, which define how ScanMail scans
messages and databases.

TABLE 1-2.

Types of ScanMail rules

TYPE OF RULE

DEFINES HOW SCANMAIL...

Mail scan rule

scans and filters message content and attachments in real time.
To create a real-time mail scan rule, see page 4-9.

Database scan rule

scans databases in real time. To create a real-time database
scan rule, see page 4-14.

Scheduled scan rule

scans databases according to a schedule. To create a sched-
uled database scan rule, see page 4-16.

Scheduled update rule

updates antivirus and content security components. To create a
scheduled update rule, see page 6-5.

Notification rule

delivers a notification. To create a notification rule, see page

ScanMail Filters

Filters are subsets of a scan rule (mail scan, database scan, or scheduled scan) and

actually define scanning actions for messages, attachments, and content. Types of

filtering options include:

TABLE 1-3.

ScanMail filtering options

FILTERING OPTION

PROVIDES OPTIONS TO SET SPECIFIC SCANNING ACTION
ON...

Security Risk Scan

virus and other malware types.

APT Prevention Filter

attachments with document exploits.

Scan Restrictions

compressed, encrypted, and other attachment types. Security
Risk Scan must be enabled.

Message Filter

various message types.

Attachment Filter

unwanted attachments.
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TABLE 1-3. ScanMail filtering options

PROVIDES OPTIONS TO SET SPECIFIC SCANNING ACTION

FILTERING OPTION ON...

Content Filter messages with unwanted content based on administra-
tor-defined explicit rules.

Data Loss Prevention | messages that violate custom data loss prevention rules.
Filter

Script Filter messages with stored form or rich text hot spot content.

ScanMail Protection Strategy

An organization must design a protection strategy that provides optimal protection for
the enterprise. The key decision factors for selecting appropriate ScanMail protection
strategies are:

*  What is the overall corporate I'T security strategy?
*  What are the available resources (processor, memory) on the Domino servers?

*  Where and how can malicious code enter the Domino environment (for example,
email messages, attached files to documents in Domino databases, script bombs)?

Planning for a Policy-Based Antivirus and Content
Security Protection

Trend Micro recommends establishing and maintaining a standard antivirus and content
security setting using the policy-based features. Policies allow you to:

*  Automate redundant creation of antivirus and update settings, and other
maintenance tasks

*  Easily configure all of the servers in an environment from a single server

When planning for policy-based antivirus and content security protection, consider the
following activities:

*  Create group policies based on the ScanMail default policy.

In a large network with multiple servers that perform common roles, creating a
common set of protection settings once rather than repeatedly to each individual
server saves configuration time and maintenance considerably.
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By basing a policy on the default policy (see Understanding Policies, Rules, and Filters on
page 1-9), you can easily and quickly create a common set of mail and database
real-time and scheduled scanning protection settings once, rather than repeatedly to
each individual server.

Create group policies to assign settings applicable to all Domino servers in a specific
geographical or administrative segment. In a multi-server environment, define
server groups based on similar functions or characteristics to ensure that ScanMail
applies the appropriate policy to all servers in a group.

Create policies that have a common purpose. For example:

¢ A policy for all Domino email servers that requires the same
protection—real-time mail scanning

¢ A policy for all servers that requires real-time and scheduled database scanning

Decide which servers belong together, and define the set of protection, update, and
notification methods that apply to them. For example, you can create and then apply
a policy protecting a mail server to other servers that also act as mail servers.

Create unique policies to assign settings to specific Domino servers.

A unique policy assigns a default configuration to individual users, user groups, or
servers. For example, to set scheduled scanning that will run only on certain days of
the week, create a policy with a scheduled scan rule and then assign it to individual
or groups of database servets.

Planning to Implement Rules and Filters in a Policy-Based
Environment

Trend Micro recommends the following strategies for implementing rules and filters for

optimal antivirus and anti-spam protection for a Domino environment:

Create real-time mail scan rules for all messages and attachments.

Implement filter rules for unauthorized attachment types and extensions (see
Table 4-8, “Recommended file extensions to block,” on page 4-48 for the recommended list).

Create real-time database scan rules for all databases.
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Tip: Consider excluding user mail files (create real-time mail scan rules to scan
messages), Domino system databases, and other large size databases that do not
change often. This helps allocate server resource to databases that are constantly

changing,

*  Create a scheduled update rule for antivirus and content security components.
¢ Create a scheduled database scan rule of all Domino databases.

*  Purchase ScanMail for IBM Domino Suite with Data Loss Prevention to implement
prevention against unwanted spam or suspicious URL messages.

¢ Enable comprehensive data loss prevention

¢ Enable anti-spam protection and specify which actions to take.

¢ Enable Web Reputation protection and specify which actions to take.
¢ Set filter levels in accordance with IT security policies.

¢ Enable and specify approved senders and blocked senders.

In addition, determine the appropriate number of scan tasks on your system. See Types of
Scans on page 1-7 for details about the ScanMail scan tasks.



Chapter 2

Installing ScanMail for IBM Domino

This chapter guides you through installing ScanMail for IBM Domino (SMID). This
chapter also lists the system requirements for SMID and contains post-installation
configuration information and instructions on how to register and activate your
software.

This chapter contains the following topics:

*  Planning SMID Deployment on page 2-2

*  Upgrading Domino Server on page 2-3

o Testing SMID at One Location on page 2-4

*  Recommended System Requirements on page 2-5

*  Installing SMID 5.6 on page 2-9

e Starting the Domino Server on page 2-41

*  Registering and Activating SMID on page 2-42

o Testing Installation with EICAR on page 2-45

*  Checking SMID Files and Folders on page 2-45
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Planning SMID Deployment

Deployment is the process of strategically distributing SMID servers to provide optimal

2-2

antivirus and content security protection for your Domino environment. Careful

planning and assessment are requited to deploy applications like SMID to a

homogenous or heterogeneous environment.

Trend Micro recommends that you consider the following before deploying SMID to

your network:

Select a Domino server in your organization that will serve as the central SMID
servet.

Install SMID on the central server and enable replication of SMID databases.

Create replicas of newly installed smconf.nsf and smvlog.nsf databases for
other Domino servers.

To avoid replication conflicts, permit only the Domino administrator in charge of
SMID policies to modify the Configuration database on each Domino server.

Initiate push replication from the SMID Log database replicas to the master
smvlog.nsf to centralize logging of virus and other malware incidents across the
network.

Decide whether to enable pull replication of the master Update database to replicas
on other Domino servers so that only the central Domino server needs to connect
to Trend Micro ActiveUpdate to download the latest component updates, and
peripheral servers can select Replicated database as the update source (see Seszing
the Update Source starting on page 6-9).

WARNING! If you have version 5.6 and its previous version installed in the same net-

work, you must disable the Design elements replication setting in the pre-
vious version to avoid user interface conflicts.
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Upgrading Domino Server

If you are planning to upgrade the Domino server and you already have SMID installed,
consider the following:

1. Back up the following SMID files to save the original configuration:

*  All program files in the following folder:
Windows: C: \Program Files\Trend Micro\ScanMail for Domino
Linux: /opt/trend/SMID

*  All data files in the following folder:
Windows: C: \Program Files\IBM\Domino\data\smd
Linux: /local/notesdata/smd

Upgrade the Domino server.

After you have completed the Domino server upgrade, verify if SMID works
normally. If not, do the following:

a. Stop the Domino server.
b. Copy the files you backed up in Step 1 to their respective folders.
c. Open the notes.ini file, and add the following:

e At the end of ServerTasks add:
, SMDemf , SMDreal , SMDsch, SMDmon, SMDcm

e At the bottom of the file add:
EXTMGR_ADDINS=SMDext
SmStopMail=1

ScanMailInstallPath=c:\Program Files\Trend
Micro\ScanMail for Domino

SMLD_EUQ ENABLED=0
SMDSkipTaskList=COMPACT, FIXUP, UPDALL , UPDATE

Note: c¢:\Program Files\Trend Micro\ScanMail for Domino is
only an example here. Replace it with the original path where you have
installed the SMID binaries.

4. Start the Domino server.

2-3
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Testing SMID at One Location

Trend Micro recommends a pilot deployment of SMID before implementing it full
scale. A pilot deployment:

Allows you to gain familiarity with SMID.
Allows you to develop or refine the company’s network policies.

Can give the I'T department or installation team a chance to rehearse and refine the
deployment process and test whether your deployment plan meets your
organization’s business requirements.

Provides an opportunity to determine how features work and the level of support
likely to be needed after full deployment.

Can help determine which configurations need improvements.

To test SMID at one location:

o

Prepare for a test deployment (see Preparing for a Test Deployment on page 2-4).
Select a pilot site (see Selecting a Pilot Site on page 2-5).

Create a rollback plan (see Creating a Rollback Plan on page 2-5).

Deploy and evaluate the pilot (see Deploying and Evaluating SMID on page 2-5).

Preparing for a Test Deployment

During the preparation stage, complete the following activities:

Decide on the SMID replication model for the test environment.

A hub and spokes model is a common SMID replication model. In this model, the
network administrator configures the SMID settings from the hub SMID server.
Then, the other servers, or spokes, automatically pull the settings from the hub
server.

Evaluate the possible deployment methods to determine which are suitable for your
particular environment.
Establish TCP/IP connectivity among all systems in a heterogeneous trial

configuration.

Send a ping command to each agent system from the hub server and vice versa to
verify biditectional TCP/IP communications.
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Selecting a Pilot Site

Select a pilot site that best matches your production environment, including other
antivirus and management software installations such as Trend Micro™
ServerProtect™, Control Manager, and the services you plan to use. Try to simulate the
topology that would serve as an adequate representation of your production
environment.

Creating a Rollback Plan

Trend Micro recommends creating a contingency plan in case there are issues with the
installation, operation, or upgrade of SMID. Consider your network’s vulnerabilities and
how you can retain a minimum level of security if issues arise. Also take into account
local corporate policies and IT resources.

Deploying and Evaluating SMID

Deploy and evaluate the pilot based on expectations regarding both antivirus and
content security enforcement and network performance. Create a list of successes and
failures encountered throughout the pilot process. Identify potential pitfalls and plan
accordingly for a successful deployment.

This SMID test deployment and trial can be rolled into the overall production
installation and deployment plan.

Recommended System Requirements

Individual company networks are as unique as the companies themselves. Different
networks have different requirements depending on the level of network complexity.
This section describes the recommended system requirements for SMID server.

2-5
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SMID for Microsoft Windows

Table 2-4 lists the hardware and software requirements for ScanMail for IBM Domino

5.6 for Windows.

TABLE 2-4. SMID for Windows Hardware and Software Requirements

Hardware / Software Requirement
Processor Intel™ Pentium™ or higher and compatibles (32-bit and 64-bit
chips as appropriate), or equivalent
Memory * 512-MB minimum
* 512-MB or more recommended per CPU
Disk Space 1.5-GB minimum per partition

Disk swap space

Twice the physical RAM installed

Protocols

* NetBIOS over IP (32-bit processor only, only
Microsoft IP is supported)

* NetBIOS over IPX (32-bit processor only)

* TCP/IP (includes IPv6)

Domino Server

¢ Lotus Domino 8.0.1 (32/64-bit)
¢ Lotus Domino 8.0.2 (32/64-bit)
¢ Lotus Domino 8.5 (32/64-bit)

¢ Lotus Domino 8.5.2 (32/64-bit)
¢ Lotus Domino 8.5.3 (32/64-bit)
* IBM Domino 9.0 (32/64-bit)

IBM Notes

* Lotus Notes 8.0.1
¢ Lotus Notes 8.0.2
¢ Lotus Notes 8.5

¢ Lotus Notes 8.5.2
¢ Lotus Notes 8.5.3
¢ IBM Notes 9.0
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TABLE 2-4. SMID for Windows Hardware and Software Requirements

Hardware / Software

Requirement

Platform

MS Windows 2003 Server Standard Edition

MS Windows 2003 Server Enterprise Edition Service
Pack 2

MS Windows 2003 Server

MS Windows 2008 Server

MS Windows 2008 R2 Service Pack 1

MS Windows 2008 R2 Server

MS Windows 2012 Server

Browser

Microsoft Internet Explorer 6.0 Service Pack 2
Microsoft Internet Explorer 7.0
Microsoft Internet Explorer 8.0
Microsoft Internet Explorer 9.0

Trend Micro Control Manager

Trend Micro Control Manager 5.0 with patch 3 and
hotfix 1728

Trend Micro Control Manager 5.5 with service pack 1
Trend Micro Control Manager 6.0

SMID for Linux

Table 2-5 lists the hardware and software requirements for ScanMail for IBM Domino

5.6 for Linux.

TABLE 2-5. SMID for Linux Hardware and Software Requirements

Hardware / Software Requirement
Processor Intel™ Pentium™ 4 Processor 1.3-GHz or higher
Memory * 512 MB minimum

512 MB or more recommended per CPU
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TABLE 2-5. SMID for Linux Hardware and Software Requirements

Hardware / Software

Requirement

Disk Space

1.5-GB minimum per partition
500-MB for program files
450-MB for the /tmp folder

Disk swap space

Equal to the physical RAM installed required
Twice the physical RAM installed recommended

Protocols

TCP/IP (includes IPv6)

Domino Server

Lotus Domino 8.0.1 32-bit
Lotus Domino 8.0.2 32-bit
Lotus Domino 8.5 32-bit
Lotus Domino 8.5.1 32-bit
Lotus Domino 8.5.2 32-bit
Lotus Domino 8.5.3 32-bit
IBM Domino 9.0 32-bit
IBM Domino 9.0 64-bit

IBM Notes

Lotus notes 8.0.1
Lotus notes 8.0.2
Lotus notes 8.5
Lotus notes 8.5.1
Lotus notes 8.5.2
Lotus notes 8.5.3
IBM notes 9.0

Platform

Novell SUSE Linux Enterprise Server (SLES) 10
Novell SUSE Linux Enterprise Server (SLES) 11
Red Hat Enterprise Linux (RHEL) 5
Red Hat Enterprise Linux (RHEL) 6

Browser

Microsoft Internet Explorer 7.0
Microsoft Internet Explorer 8.0
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TABLE 2-5. SMID for Linux Hardware and Software Requirements

Hardware / Software Requirement

Trend Micro Control Manager e Trend Micro Control Manager 5.0 with patch 8

¢ Trend Micro Control Manager 5.5 with hotfix 1273
¢ Trend Micro Control Manager 6.0

Other

¢ compat-libstdc++-33-3.2.3-69.e16.i686.rpm (on
RHELG 64-bit)

¢ glibc-2.12-1.107.e16.i686.rpm (on RHEL6 64-bit)

* nss-softokn-freebl-3.12.9-11.e16.i686.rpm (on RHEL6
64-bit)

Installing SMID 5.6

There are several pre-installation tasks that can help to make the installation process
easier. Additionally, note the following points before installing SMID version 5.6:

You cannot automatically roll back to SMLD 5.0/5.5 after installing version 5.6.

To roll back to SMLD 5.0/5.5, remove SMID 5.6, and then perform a fresh
installation of SMLD 5.0/5.5. Refer to the SMLD 5.0/5.5 documentation for details
on how to install this version.

You cannot install both SMLD 5.0/5.5 and SMID 5.6 on the same physical
machine. (Windows only)

You must shut down the Domino server before installing or removing SMID.

For partitioned servers, install only one version of SMID for all partitions. However,
you can install separate binaries for each partition.

Note: If you want to install separate binaries for each partition, make sure to disable
binary sharing during SMID installation.
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Pre-installation Tasks

Before installing SMID, perform the following tasks:

1.

9.

10.

Log on the Windows platform as administrator or log on the Linux platform as
root uset.

Determine the notes. ini location(s) (including its location on partitioned
servers, if applicable).

Determine the Domino Data and Domino Binary paths.

Ensure that the uset/group that has the administrator authority used to manage the
SMID databases exists. The default group is LocalDomainAdmins.

Check the available disk space to verify there is at least 1.5-GB of free space. See
Recommended System Requirements on page 2-5 for the hardware and software
requirements for your platform.

Close any open Notes Clients.

Close any open Notes account sessions.

Shut down all Domino servers installed on this machine completely before:
*  Installing SMID 5.6 for the first time

*  Upgrading from SMD 3.1 for Linux 32-bit

*  Upgrading from SMLD 5.0 for Windows

*  Upgrading from SMLD 5.5 for Windows and Linux 32-bit

*  Removing SMID 5.6

Prepare the SMID Activation Code. See SMID Activation Code on page 2-43.

If upgrading from SMD 3.1 for Linux, remove CMAgent. Refer to the SMD 3.1
Administrators Guide for the procedure.

Once you have verified that the target server is ready, install the SMID program files and
set up the SMID databases.

Setup Modes

You can use the following methods to install SMID:

210

Wizard-based installation is an interactive installation that requires user input
when installing SMID on a server.
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The wizard-based installation provides a series of interfaces that help simplify the
SMID installation. See Running a Wigard-Based Installation on page 2-11.

*  Silent installation requires no user intervention when installing SMID.

The silent installation makes use of a response file, which contains all of the
information that Setup requires. Script files can help you quickly install SMID on
multiple or partitioned Domino servers. See Running a Silent Installation on page 2-38.

Setup Options
There are four Setup options:
*  Fresh install installs SMID for the first time.
*  Install installs the same SMID version to newly added Domino server(s).
*  Upgrade upgrades an existing SMID installation to the latest version or build.

*  Install and Upgrade installs SMID to additional Domino server(s) and upgrades
an existing SMID installation to the latest version or build.

Running a Wizard-Based Installation

Run the corresponding Setup program to initialize the wizard-based installation.

Installing SMID 5.6 for Windows
To install SMID 5.6 from a graphical user interface:
1. To navigate to the Setup program, do one of the following:

*  Ifyou are installing from the Trend Micro Enterprise Protection CD, go to the
SMID folder on the CD.

*  Ifyoudownloaded the software from the Trend Micro Web site, navigate to the
relevant folder on your server.

2.  Double-click setup.exe.

2-11
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The InstallAnywhere screen appears (Figure 2-1.) followed by the SMID install
screen.

InstallAnywhere

! Installbnewhere is preparing to install...

Cancel

[C] 1997-2008 Acresso Software Inc. and/or InstallShield Co. Inc.

FIGURE 2-1. InstallAnywhere screen

After the SMID InstallAnywhere screen completes its progress, the SMID
Welcome screen appears.

2 ScanMail for IBM D =100 x|

Welcome to Trend Micro
ScanMail for IBM Domino 5.6
Setup

Setup will install Scaniail for IBM Domino on aur
SEMVEr(s).

Trend Micro recommends that you exit all Windows
programs before running this Setup program

Click Next> to continue or Cancel to exit

WARNING: This program is protected by copyright [aws
and international treaties

Erevious

Cancel

FIGURE 2-2. SMID Welcome screen
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3. Click Next. The License Agreement screen appears.

for IBM Domino =100

Please read the following license agreement carefulhy:
IMFORTANT: READ CAREFULLY. USE OF IREND MICRO 3
SOFIWARE AND SERVICES BY BUSINESS AND OTHER
ENTITIES IS SUBJECT TC THE FOLLOWING LEGAL TERMS
AND CONDITIONS

Trend Micro License Agreement

Trial and Paid Use License - Enterprise and SMB
Software and Services

Perscnal Use License - Trend Micro Email
Encrypticn Client

Date: June 2013

English/Multi-country

Irtiresedu;

1. Scope. This Agreement applies to all Trend ;l

(¥ T3ctapt the tarms of the Licenss Agreament

{1 do NOT scoapt the terms of the Licanse Agreement

In

Cancel

Previous

FIGURE 2-3. SMID License Agreement screen
Select I accept the terms of the license agreement to continue with the SMID

installation. If you do not agree with the terms of the license, click I do NOT
accept the terms of the license agreement; the installation then stops.
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4.

5.

Click Next. The Product Activation Code screen then displays.

2 ScanMail for IBM Domino

=1alx|

Activate ScanMail for IBM Domino to enable scanning and security
updates. Activation is 3 2-step process that you must complete during
installation.

Step 1. Register

Use the Registration Key that came with your product to register
online (https://olr.trendmicro. com/registration/). (Please skip this step
if the product is already registered.)

Step 2, Activate

Enter the Activation Code that you received after registration to
= activate your product.

iian Corrgls

Initroel

Format: (XX-X3XXX-KXXXN-XXXHX KKK XXX 00

Cancel

Previous

FIGURE 2-4. Product Activation Code screen

On the Product Activation Code screen shown in Figure 2-4, you must enter the
correct SMID Activation Code to activate SMID (see page 2-43).

Note:  Obtain the Activation Code to activate an SMID Trial, Standard, Suite, or
Suite with Data Loss Prevention version for a new installation. You may
use the same Activation Code used for SMLD 5.0/5.

expired.

5 if it has not yet

If you have not registered SMLD:

i.  Go the Trend Micro Product Registration Web site

(https://olr.trendmicro.com/registration) and follow
the on-screen instructions to register your product. Register your product
to ensure you are eligible to receive the latest security updates and other
product and maintenance services. After registration is complete, Trend
Micro sends the SMID Activation Code (AC) to the email address you

specified during registration.

Type or paste the SMID Activation Code (see page 2-43) or click Next, to skip
product activation. Do one of the following:
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ii. Use the Activation Code you have received from Trend Micro to activate
SMID.

If you have an Activation Code:

Type the Activation Code for SMID. To use SMID 5.6, you need to obtain a
Standard, Suite or Suite with Data Loss Prevention Activation code (see page
2-43) to activate the software.

If you want to use the Configuration database to activate SMID later:

Leave the Activation Code field blank. Setup installs SMID; however, the SMID
scan or update task will not load. Activate SMID immediately after installation
to protect your Domino environment (see SMID Activation Code starting on
page 2-43).

Click Next. The Installation Type screen then displays.

¥, ScanMail for IBM Domino Il P ] 5 |

Select a ScanMail for IBM Domino platform:

% 64-hit ScanMail for IBM Domina
" 32-bit ScanMail for IBM Domino

Warning: ScanMail and Domino must use the same platform {32 or
64-bit), otherwise ScanMail will not function.

Cancel

FIGURE 2-5. Installation Type screen

From the Installation Type screen, select from the following:

64-bit ScanMail for IBM Domino
32-bit ScanMail for IBM Domino
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Note: The Installation Type screen (Figure 2-5) will not display if you install SMID to a
Windows 32-bit Operating System or if you are upgrading from SMLD 5.0/5.5.

WARNING! The Domino server platform must match the SMID installation type,
otherwise SMID will not function. For example, if the Domino server
is 32-bit, you must install SMID 32-bit. If the Domino server is 64-bit,
you must install SMID 64-bit.

7. Click Next. The Select Domino Server screen then appears. Select the
notes. ini server where you want to install SMID.

Note: If you have a partitioned server, install SMID on the partitions you want to
protect.

Also, if you ate upgrading from SMLD 5.0/5.5, the existing notes. ini
server file will display. This file cannot be removed, but you can Add other
locations.

%2 ScanMail for IBM Domino =) x|

ScanMail for IBM Domino 5.6 can be installed on multiple Domino
SEFVErs,

Server(s) where ScanMail is already installed:

List the notes.ini for server(s) where ScanMail will be installed:

I

Add | Remove

Warning: ScanMail and Domino must use the same platform (32 or
64-bit), otherwise ScanMail will not function,

Previous

FIGURE 2-6. Select Domino Server screen
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In

FIGURE 2-7.

Cancel

=10l x|

ScanMail for IBM Domino 5.6 can be installed on multiple Domino
SErVErs,

Server(s) where ScanMail is already installed:

| List the notes.ini for server(s) where ScanMail will be installed:
C:'Program Files\IBM\Domino'notes.ini

| oo |

Warning: ScanMail and Domino must use ﬂ'll%ame platform {32 or
&4-bit), otherwise ScanMail will not function,

Previous

Select correct location for notes.ini

WARNING!

A warning message will display if you select a location where SMID

is currently installed. Be sure to select a new location.

After selecting the notes. ini path, click Add > Next. The Validate Domino
Server screen displays.
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8. From the Validate Domino Server screen, verify the domino and data directories
path.

=10l x|

Werify the Domino program and Domino Data directories for each notes.ini
to continue the ScanMail installation.

Notes.iniPath | Domino Binary Path | Domino Data Path |
C:\Program Files\[BM\... C:\Program Files\IBM\... C:\Program Files{IBMY, ..

FIGURE 2-8.  Verify the Domino program and Data directories screen

Click Next. The Analyze Domino Server screen displays.
=lolx|

Previous

FIGURE 2-9. Analyze Domino Server screen
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9. After the configuration analysis screen progress completes, click Next. The SMID
Configuration screen displays.

=1olx|

Setup will install ScanMail for IBM Domino 5.5 on the following server(s).

[# Share single SMID binary for all Doming servers

IC:\ngram Files\Trend Micro Browse

FIGURE 2-10. SMID Configuration screen
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10. From the SMID Configuration screen, type or Browse for the location to install
ScanMail for IBM Domino. If you clear the Share single SMLD binary for all
Domino servers option, the screen shown in Figure 2-11 appears.

=10l x|

Setup will install ScanMail for IBM Domino 5.6 on the following server(s).

[ Bhare single SMID binary for all Doming servers

ServerPath | SMLDPath [Browse| Stetus [ Option |
C:\Program ... C:\Program ... ... __|ScanMail 5.5... Fresh Install

Click here to browse for a new path

Previous

Cancel

FIGURE 2-11. Choose server install path

Note: Trend Micro recommends that you do not install SMID product binaries in the
Domino Data folder. Otherwise, SMID may generate extra logs.

11. If you cleared Share single SMID binary for all Domino servers, click ... as
shown in Figure 2-11 to browse for a new server path.
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12. Click Next. The Database Replication Selection screen appears.

By default, Setup enables replicating all databases except the Quarantine database.
If you want to change the default settings, select or deselect the SMID databases
you want Setup to replicate.

¥l ScanMail for IBM Domino =10 x|

Select which ton

¥ Configuration Database : smconf.nsf

[¥ Update Database : smency.nsf
[¥ Log Database : smvlog.nsf
[ Quarantine Database - smquar.nst

[¥ File Types Database : smitypes.nsf

Previous

Cancel

FIGURE 2-12. ScanMail database replication settings

If you plan to install SMID on several servers and replicate databases, you may want
to disable replication of the Configuration database on subsequent servers. Select
one server as the primary or administrative server to replicate to all other servers.

Note: Remember to schedule the replication of the Configuration database after installing
SMID so that all servers receive the default policy.

13. Click Next. The Default Policy Selection screen appears. Select which server(s)
should get the default policy. If there are server(s) with SMID installed and the
Configuration database is being replicated, you may skip this option on subsequent
installations.
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2-22

A single SMID server, central (hub) server, or the first server from a group of
partitioned servers should always receive the default policy. If the default policy is
not installed on a server, reload SMDReal on that server after you create a new
policy.

Note:  All servers must have a policy present for SMDReal to opetate propetly. Upon
completion of installation, schedule replication of the Configuration database so
that all servers will receive the default or other policy that you specify.

=101 x|

Setup creates a default policy for the ScanMail Configuration
Database, The default policy enables ScanMail to automatically
protect a Domino environment immediately after Setup successfully
finishes,

Important:

If the Configuration Database and other ScanMail servers are initially
replicated to a single Domino server, other Domino servers will not be
protected until the first replication takes place. Trend Micro
recommends setting-up ScanMail database replication to other Domino
servers after the product installation.

Select which server(s) should get the Configuration Database default
policy:

¥ C:'\Program Files\[BM\Domino'notes.ini

Previous

Cancel

FIGURE 2-13. SMID default policy screen

14. Click Next. The ScanMail Administrator screen appears.
Do one of the following:

*  Type a single administrator account / group that will have Manager access to
all SMID databases.

*  Ifthe target servers are partitioned servers and you have different administrator
groups for each partition, specify different users or user groups for each
partitioned server and then type the administrator account for each server in
the Type the Administrator account field
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Specify the user or group that will hawe Manager access to ScanMail
databases.

[ Specify a different user or group for each Domino server

Type the Administrator account:

LocalDomainAdmins

Cancel

Previous

FIGURE 2-14. Specify user or group access screen

Note:

If the account you specify does not exist, then create it when you complete the

installation. Ensure that the account has administrator authority.
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15. Click Install. The installation begins.

»r IBM Domino

FIGURE 2-15. Setup installs SMID on selected server(s).

16. After the installation shown in Figure 2-15 completes, the Installation Complete
screen displays.

or IBM Domino Pl 3

Setup has successfully installed ScanMail for 1BM Domino to the following
Server(s) path{s):

C:'\Program Files\[BM\Domino\notes.ini

Iriiracl

Previous

FIGURE 2-16. SMID Installation Complete screen
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17. Click Next. The Introduce Control Manager Agent screen displays.
=10l x|

Introducing Control Manager agent for ScanMail for IBM Domino 2

Trend Micro(TK) Control Manager(TM} is an enterprise-level
central

management application that manages Trend Micro and
third-party

antivirus and content security products atthe gateway, mail
Server,

file server, and corporate desktop levels. The Control Manager
Web-based management console provides a single monitoring
paint for

antivirus and content security products throughout the network
(products like: ScanMail for IBM Domino).

Control Manageris separately purchased and installed. If your
organization is using Contral Manager, install the Control

Manager

aaent for Scaniail for IBY Domino ta manaae it from the Control 2

In

Carnce/

Previous

FIGURE 2-17. Introduce Control Manager Agent screen

18. Click Done to close the Setup screen.

See Testing Installation with EICAR on page 2-45 to confirm that SMID has been
successfully installed.

If you are running ServerProtect or another antivirus product on the Domino server where you
will install SMID, see Registering and Activating SMID on page 2-42.
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Installing SMID 5.6 for Linux
To install SMID 5.6, perform the following steps:
1.  Open Terminal. To navigate to installation program, do one of the following:

*  Ifyou are installing from the Trend Micro Enterprise Protection CD, navigate
to the SMID folder on the CD.

*  Ifyoudownloaded the software from the Trend Micro Web site, navigate to the
relevant folder on your server.

Note: The installation file uses the / tmp file system as temporary folder by default.
However, you can change the temporary folder by setting the IATEMPDIR
environment variable to a different directory on a partition with enough free disk
space.

To set the variable, enter one of the following commands at the UNIX command line
prompt before running the installation:

*  Tor Bourne shell (sh), Bourne-again shell (bash), Korn shell (ksh), and Z
shell (zsh):

$ IATEMPDIR=/your/directory/with/free/space

$ export IATEMPDIR
*  For C shell (csh) and TC Shell (tcsh):

$ setenv IATEMPDIR /your/directory/with/free/space
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To make sure that the install.bin file has the execution privileges, type the
following command:

chmod 755 install.bin

Run the installation file install.bin, by typing the command:
Jinstall.bin -i console

The installer starts unpacking the file.

Fommn -(0] x|

FIGURE 2-18. Unpacking Installer file
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After unpacking of installation file is complete, the Welcome screen appears as
shown in Figure 2-19.

0.204.131.222 - PuTTY

FIGURE 2-19. Welcome screen

Press Enter to continue the installation. The License Agreement screen appears.

It OTHER ENTITIE: TE

FIGURE 2-20. License Agreement screen
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On the Licence Agreement screen, press Enter to continue scrolling to the next
screen of Licence Agreement. If you want to move to the end of the agreement,

type skip or s and press Enter.

04.131.222 - PuTTY

ENTEE to go to the ne
ip

FIGURE 2-21. License Agreement screen

At the end of the License Agreement, Type 1 if you agree and accept the terms of
the license agreement. If you do not agree with the terms of the license, type 2; the

installation then stops after confirmation.
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6. Press Enter. The Product Activation screen appears.

7oL

omwpleted during

er online (ht

FIGURE 2-22. Product Activation screen

7. On the Product Activation screen shown in Figure 2-22, you must type the correct
SMID Activation Code to activate SMID (see page 2-43).

Note: Obtain the Activation Code to activate an SMID Trial, Standard, Suite, or Suite
with Data Loss Prevention version for a new installation.

Do one of the following:
*  If you have not registered SMID:

i.  Go the Trend Micro Product Registration Web site
(https://olr.trendmicro.com/registration) and follow
the on-screen instructions to register your product. Register your product
to ensure you are eligible to receive the latest security updates and other
product and maintenance services.

ii.  After registration is complete, Trend Micro sends the SMID Activation Code
(AC) to the email address you specified during registration. Use this
Activation Code to activate SMID.
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If you have an Activation Code:

Type the Activation Code for SMID. To use the full functionality of SMID 5.6,
you need to obtain a Standard, Suite or Suite with Data Loss Prevention
Activation Code (see page 2-43) and activate the software.

If you want to use the Configuration database to activate SMID later:

Leave the Activation Code field blank. Setup installs SMID; however, the SMID
scan or update task will not load. Activate SMID immediately after installation
to protect your Domino environment (see page 2-43).

Press Entet.

If you chose to proceed without the Activation Code, the setup will prompt for the

confirmation. Do one of the following:

a.

b.

To continue installing SMID without the Activation Code, type 3 and press
Enter.

If you want to type Activation Code at this point of installation:

i. Type n1 and press Enter. The setup will prompt for the Activation Code.

ii. Type the SMID Activation Code. and press Enter.

The Add or Remove Domino Server screen appears.

10.204.131.222 - PuTTY

e the option number [default 1]

FIGURE 2-23. Add or Remove Domino Server screen
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9. On the Add or Remove Domino Server screen shown in Figure 2-23, type 1 and
press Enter to add notes. ini server where you want to install SMID.

Note: If you have a partitioned server, install SMID on the partitions you want to
protect.

Accept current setting, and go to the next step option start the installation of
selected Domino server (notes. ini). If you have not selected at least one
notes.ini, Accept current setting, and go to the next step option would
be ineffective. You must select at least one Domino server (notes. ini)
before starting the installation process.

a. Press Enter. Add Domino Setver - Notes.ini Path [Step 1/4] screen
appears as shown in Figure 2-24. Type the path where notes. ini file is
located.

10.204.131.222 - PuTTY

.ini file, and then type the file namwe

Sini) .

ini file : I

FIGURE 2-24. Domino server selection screen
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b. Press Entet. Add Domino Setrver - Replication Setting [Step 2/4] scteen
appears.

31.222 - PuTTY

hat will he i for replication.

FIGURE 2-25. Replication Settings screen

By default, Setup enables replicating all databases except the Quarantine
Database. If you want to change the default settings, select or deselect the
SMID databases you want Setup to replicate or ignore. To select or deselect
SMID database, do the following:

i.  Type the corresponding option number from 1 ~ 5 (for example, if you
want to select Quarantine Database, type 4).

ii. Press Enter.

Tip: If you plan to install SMID on several servers and replicate databases, you
may want to disable replication of the Configuration database on
subsequent servers. Select one server as the primary or administrative
server to replicate to all other servers.
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2-34

Note:  Remember to schedule the replication of the Configuration database after
installing SMID so that all servers receive the default policy.

After making your selection, type O (zero) to accept setting, and proceed to
next step.

Press Enter. The Add Domino Server - ScanMail Management [Step 3/4]
screen appears.

up that

£ 0Or group name

FIGURE 2-26. ScanMail Management screen

The default administrator group is LocalDomainAdmins. If you want to
specify another user or group for the administration tasks, type a single
administrator account or group that will have Manager access to all SMID
databases.

Note:  If the account you specify does not exist, then create it when you complete
the installation. Ensure that the account has administrator authority.
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d. Press Enter. The Add Domino Server - Install Path [Step 4/4] screen
appears.

10.204.131.222 - PuTTY

FIGURE 2-27. Installation Path selection screen

Type the installation path where you want the Setup to install the SMID. By
default, Setup will install the SMID at /opt /trend.

Note:  If SMID 5.6 has already been installed on one partition servers, the default
installation path for the subsequent installation(s) will remain same and

cannot be changed.
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2-36

e. After typing the installation path, press Enter. The selection of one Domino

Server completes and the Add or Remove Domino Server screen appears

again, displaying the list of selected Domino server(s).

he the option number [default 1]

FIGURE 2-28. Add or Remove Domino Server screen

On the Add or Remove Domino Setver screen shown in Figure 2-28, select

one the following:

Type O (zero) to select current settings and start the installation of selected
Domino server(s).

Type 1 to add another Domino server (notes. ini), and follow
Substep a to Substep d of Step 9 on page 2-32.

Type 2 to remove Domino server(s) previously selected.
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10. Press Enter. The Summary screen appears. Type Y or ¥ to start installing the
selected Domino server(s).

Mail for IEM Domino 5.6 on the following Domino

ini)

ule 81 :

FIGURE 2-29. Installation Summary screen

11. Press Enter. The installation begins.

131.222 - PuTTY

FIGURE 2-30. Setup installs SMID on selected server(s)
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After the installation shown in Figure 2-30 completes, the Installation
Complete message displays on the screen.

204.131.222 - PuTTY

led on the following Domine

FIGURE 2-31. ScanMail Installation Complete screen

Note: If this is the first time you install SMID, quit the current terminal session and
start a new session.

Running a Silent Installation

Silent SMID installation minimizes the number of installation steps, which simplifies
installation. The script file, which is in a * . txt format, provides the required
information necessary to complete an SMID installation.
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Before you begin this installation process, do the following:

Ensure that the required hardware and software components are in place and
working. Refer to the hardware and software requirements for your platform as

mentioned in the following table:

PLATFORM TABLE TITLES AND LOCATION
Windows Refer to Table 2-4, “SMID for Windows Hardware and Soft-
ware Requirements,” on page 2-6.
Linux Refer to Table 2-5, “SMID for Linux Hardware and Soft-
ware Requirements,” on page 2-7.

Ensure that the Domino server is stopped and all other Notes applications are
closed; otherwise, you may corrupt shared files, and Setup may not run properly.
Prepare an installation script.

Use an installation script (that is, an answer or script file) to record a previous SMID
installation and automate SMID installation on all the servers where you want to
install SMID. Alternatively, use an installation script to customize the type of SMID
setup or to specify options to install on the Domino server.

Note: Silent installation supports fresh SMID installation as well as upgrade to version
5.6. However, it will only install or upgrade SMID on the servers specified in the
record script. If you want to do silent installation where a previous version of
SMID is installed, make sure to add all the servers’ information in the script file.

Installing SMID for Windows

To install SMID in the silent mode:

1.

From the command console, type information as follows to record the silent
installation script file while installing SMID to a single or multiple Domino
server(s):

setup.exe -r “{script absolute path and file name}”
For example:

setup.exe -r “c:\smd_silent.txt”
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Note: Run this command from a command line prompt opened in a graphical desktop
environment when recording a script file for a silent SMID installation.

InstallAnywhere

: ) Installsmwwhere is preparing to install...
k- |

[C] 19597-2007 Macrovision Europe Ltd. and/or Macrovizion Corporation

FIGURE 2-32. Recording SMID installation on a Windows server

2. On the command console, type the following command to invoke silent
installation:

silentinstall.bat

rator: Command Prompt

>
>8ilentInstall.bat c:ssmd_silent.
CzJrem
C:x>rem Silent install Script
IC=x>rem
Silent installation of ScanMail for Lotus Domino begins at Thu 85/18-/2012 9:58:
.15
nsetup.exe” —f c:inemd_silent.txt —i silent
nstallation of ScanMail for Lotus Domino ends at Thu B5-18-2012 9:51:31
file - C:xUsers“ADMINI“iNAppDatasLocalsTemp\2\8MLDInstallSucceedFileFlag

Setup has successfully installed ScanMail for Lotus Domino.

RS

FIGURE 2-33. Running a silent SMID installation on a Windows server

3. Open the silent installation log file for the Setup result, smdins. log, which is
created in the user’s default temp folder. You can access this folder by typing:
“0/owindir%\temp” as the explorer addtess. Follow the steps in Testing Installation
with EICAR on page 2-45 to check whether the SMID installation is successful.
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Installing SMID for Linux

To install ScanMail in the silent mode:

1.

From the Terminal console, type the following to record the silent installation script
file while installing SMID to a single or partitioned Domino server:

Jinstall.bin -i console -r {path and script file name}

For example:

Jinstall.bin -i console -r /tmp/silent.txt

On the Terminal console, type the following command to invoke silent installation:
Jinstall.bin -i silent -f {path and script file name}

For example:

Jinstall.bin -i silent -f /tmp/silent.txt

Open the silent installation log file for the Setup result, smdins. 1og, which is
created in /var/1og folder. Follow the steps in Testing Installation with EICAR on
page 2-45 to check whether the SMID installation is successful.

Starting the Domino Server

After installing SMID version 5.6, start the Domino server to launch the SMID tasks
and test the installation with EICAR (page 2-45) to confirm whether SMID is
successfully installed. Additionally, refer to Getting Started with SMID on page 3-1 for
additional post-installation configuration.

To start the Domino server on Windows platform:

1.
2.

Make certain you are logged on as the Administrator.

Click Start > Programs > IBM Applications > Domino Server.

To start the Domino server on Linux:

1.

If you have installed the SMID for the first time on the server computer, open a
new Terminal (shell) session.

Make certain you are logged in with the Domino user account and not as root.
Check this by issuing the command whoami or id.
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3. Change to your Domino data directory (for example, Llocal /notesdata),
and then type the following command at the Terminal to start the Domino server:
$ <Domino binary directory>/server —jc &

Tip: If you have not customized your shell environment, run the following command
to locate and execute the Domino startup script:

<Domino binary directory>/server

Note: Replace <Domino binary directory> with your actual Domino binary
directory.

Refer to your Domino documentation for more information on how to start a Domino
servet.

SMID and Other Antivirus Products

If you are running ServerProtect or another antivirus product on the Domino server where you
will install SMID, exclude the SMID smd and temporary directories on each partition from
scanning (refer to your temporary directory settings found in Ses a Scanning Directory) to
prevent a scanning conflict.

If you are using ServerProtect, refer to the ServerProtect documentation for instructions
to exclude Domino folders and directories from scanning.

Registering and Activating SMID
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Use your Registration Key to register your product on the Trend Micro Online
Registration Web site at the following:

https:/ /oltr.trendmicro.com/registration

Register your products to ensure eligibility to receive the latest security updates and
other product and maintenance services. After completing the registration, Trend Micro
sends an email that includes a SMID Activation Code, which you can then use to activate
SMID.
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SMID Activation Code

SMID has four types of Activation Codes:

* A Trial AC allows you to implement the full functionality of SMID. During the trial
period, SMID performs malware and unwanted content filtering and scanning, as
well as component update. When a Trial AC expires, all SMID functions are
disabled, leaving your Domino environment unprotected.

* A Standard AC allows you to implement limited SMID functionalities. SMID
Standard edition provides security risk scanning in all modes and component
update. However, data loss prevention, content and spam filtering are unavailable.

* A Suite AC allows you to implement SMID, including content and spam filtering,
Web Reputation and End User Quarantine (EUQ).

* A Suite with Data Loss Prevention AC allows you to implement ScanMail's full
functionalities, including content and spam filtering, Web Reputation, End User
Quarantine (EUQ) and Data Loss Prevention.

SMID displays the remaining number of days before a Trial version, Standard edition,
Suite, or Suite with Data Loss Prevention edition expires via the Domino server console.
Trend Micro recommends registering and obtaining a Suite or Suite with Data Loss
Prevention AC before the expiration date to allow uninterrupted Domino environment
protection.

Obtaining an SMID Activation Code

Activate the SMID server to keep your antivirus and content security updates current.
To activate your product, register online and obtain an SMID Activation Code using
your Registration Key.

If you have purchased the full version from a Trend Micro reseller, the Registration Key
is included in the product package. Register online and obtain an Activation Code to
activate the product.

Activating SMID

After you have obtained an Activation Code either from your product package or
purchased through a Trend Micro reseller, activate SMID to use all of its functions,
including downloading updated program components.
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To activate SMID:

Eal

Open the SMID Configuration Database.
On the left menu, click Administration > Product License.
Creating a License Profile (see page 5-18).

Delete the license profile created during installation (see page 5-18).

Convert to a Full Version

Upgrade and activate the full version of SMID to continue using it beyond the trial

period. Activate SMID to use all of its functions, including downloading updated

program components.

To convert to a full version:

1.

AR

Purchase a full version Registration Key (from a Trend Micro reseller).
Register your software online.

Obtain and take note of the Activation Code.

Creating a License Profile (see page 5-18).

Delete the corresponding license profile for the trial version (see page 5-18).

Renew SMID Maintenance
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Standard maintenance support is included in the initial purchase of product licenses and

consists of one year of virus pattern updates, product version upgrades, and telephone
and online technical support. Maintenance is due 12-months from the original purchase

and every year thereafter.

To renew product maintenance for a full version:

1.
2.
3.

Open the SMID Configuration Database.
On the left menu, click Administration > Product License.

On the working area, double-click the target platform; for example, Windows (all
versions).

Click View detailed license online.
Follow the instructions in the Existing user registration.
Click Save & Close.
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Testing Installation with EICAR

Trend Micro recommends testing SMID and confirming that it works by using the
European Institute for Computer Antivirus Research (EICAR) test file. EICAR
developed the test script as a safe way to confirm that your antivirus software is properly
installed and configured.

WARNING! Never use real viruses to test your antivirus installation.

Use EICAR to trigger a virus incident and confirm that email notifications are correctly
configured, and that there are no issues with logging.

Note: The EICAR file is a text file with a *. com extension. It is inert. It is not a virus, it
does not replicate, and it does not contain a payload.

To test the SMID installation with EICAR:

1. Open an ASCII text file and copy the following 68-character string to it.

X50!P%@AP[4\PZX54(P™)7CC)7}SEICAR-STANDARD-ANTIVIRUS-TEST-
FILEISH+H*

2. Save the file as eicar test.com to a temp directory and then close it.

3. Attach eicar_ test.com to an email and send it to yourself or a test mailbox.

Check the virus log in the SMID Log Database or check the notification sent to the
administrator (if Notification is set).

Checking SMID Files and Folders

See the following appendices for details about SMID and Control Manager files and
folders:
o ScanMail for Windows on page C-2

*  ScanMail for Linux on page C-3
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Chapter 3

Getting Started with SMID

This chapter presents post-installation and post-activation tasks that you need to
perform to configure SMID.

This chapter includes the following topics:

Understanding the SMID Interface on page 3-2

Getting Help While Using ScanMail on page 3-3

Running a Mannal Scan After Installation on page 3-3

Adding ScanMail Database Icons to the Notes Workspace on page 3-3
Signing ScanMail Databases with a Different ID on page 3-4
Defining Access and Roles to ScanMail Databases on page 3-4
Accessing ScanMail Databases on page 3-6
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Understanding the SMID Interface

The SMID interface layout is as follows:

—
“~ TREND MICRO"ScanMail N ol BT

Action Buttons ———— = Back | Edit
Sumy v o

Policy Name: Defaut Header Section

}  Data Loss Prevention

Sener Setings This polcy applies to servr/server groups: (o severs)

CM Agent Setings

Outbreak Preventon

Deep Discovery Advisor Setiings  Mail Scan | Database Scan | Scheduled Scan | Scheduled Update | Notifcations | Cluster Trusting

b ctons
Log Databast W Enctle mal scan
Guarantne Database 7 Aopythe stictst i ol eciens wth corfctig ke 2
Update Database
Filler Lists Database I Enate Tiend Mico Artcpan 2 Catgas |
b Administation I Enbis Web Reputsion Configue.
7 Ao spam s bt e th o he it Jurk elder 7 Corligue.
(CleateHewRule | _Renove s | _0iganize s
Active [Priority _|Rule Name Source. Fiter Enabled | Exit Flag [When Valid
Secuny sk Scan O Avays
Left Menu

Working Area

b Show change sty

[ 177 dosument scected

FIGURE 3-1. ScanMail interface

«l[<o4l[z2" <l onine =]

The interface contains the following areas:

TABLE 3-6. ScanMail interface layout description

Area Purpose
Action buttons allows you to perform specific actions, such as Edit the settings or navigate
Back to the previous displayed document
Header section includes links to the ScanMail Help Database, Trend Micro Web site, and
other support tools
Left menu provides shortcuts to each ScanMail feature and other ScanMail databases
Working area is the central area of the ScanMail interface, and allows you to configure

and set ScanMail options

Tip: ScanMail databases are best viewed using a screen area of 1024 x 768 pixels.
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Getting Help While Using ScanMail

The ScanMail Help database contains information on all the ScanMail features and
provides cross-reference links to related topics. Additionally, the How To sections often
provide systematic solutions to common configuration questions. Consult this list when
looking for information on how to perform an operation in ScanMail.

To get help while using ScanMail, do one of the following:

¢ Select Contents and Index from the list on the header section of ScanMail
databases

*  Click the underlined label or the help icon (?) that precedes an option for a tool-tip
description of the options

Note: Tool-tips are not available when accessing ScanMail databases through a Web

browset.

Running a Manual Scan After Installation

Trend Micro recommends running a manual scan (see Running Mannal Scan on page
4-64) of all Notes databases to find and clean any existing viruses.

After performing the initial scan of all Notes databases, schedule ScanMail (see Creating
Scheduled Database Scan Rules on page 4-16) to periodically scan the Notes databases on
the local or remote hard disk.

Adding ScanMail Database Icons to the Notes
Workspace

The Notes Workspace provides quick access to the ScanMail databases.

To add a ScanMail database icon to the Notes workspace:

1. From a Notes workspace, click File > Open > IBM Notes Application.
2. Enter the path and file name in the Filename field.

3. Click Open.
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Refer to the Notes Workspace topic in the IBM Notes Help for more information on the
Notes Workspace.

Signing ScanMail Databases with a Different ID

Sign ScanMail databases with a different ID if you want to:

*  Replace the server. id used to sign databases during installation and assign
another ID.

To sign ScanMail databases with a different ID:

1. On the IBM Notes Client, click Files > Security > Switch ID to switch to the ID
that will be used to sign ScanMail databases.

2. Start the IBM Notes Administratot, select the Domino server where ScanMail has
been installed; then, click the Files tab.

Select All database types from the Show me list.

=

Select the ScanMail databases from the list. Typically, ScanMail databases are found
in the SMD folder.

Select Database > Sign from the list of available Tools.
On the Sign Database window, select All design documents.

Clear Update existing signatures only (faster) if this option is selected.

® 3w

Click OK to complete the operation.

Defining Access and Roles to ScanMail
Databases

Use a Notes Client to define accounts that can access ScanMail databases. These
accounts have unlimited access to ScanMail functions.

Note: If an account is not included in the ScanMail databases accesses and roles, it will not
be able to access the ScanMail functions, even if the account has administrator
privileges.
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To define access to ScanMail databases:

1. From a Notes Workspace, select the ScanMail icon.
2. Click File > Application > Access Control....

3.  On the Basics tab of the Access Control List window, change the database's default
access to No Access.

Set the following options:
User type: Unspecified
Access: No Access

The ScanMail administrator should appear as a Person or Group in the same list as
-Default-, along with the ScanMail server, LocalDomainServers, and
OtherDomainServers.

4. If either the ScanMail administrator, ScanMail server, LocalDomainServer, or
OtherDomainServer do not appear in People, Servers, Groups, click Add... and

a. In the Names window, select an address book from the box in the upper left
cornet.

b. Select a person from the list displayed in the left pane.

c. Click Add > to add the name to the list. Repeat until you have found all the
names.

d. Click OK when finished.
5. Back in the Basics tab, highlight the ScanMail administrator’s name. Assign the
ScanMail administrator the following rights:
User type: Person or Person Group
Access: Editor or higher

6. Assign the ScanMail administrator Delete documents privilege, and continue
assigning access rights as specified in Table 3-7.
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TABLE 3-7. Access Control List for ScanMail Databases

PERSON, SERVER, OR GROUP RECOMME:\DIEEACCESS DELETg g:_::g:MENTs
-Default- No Access Not selected

ID used to sign ScanMail Manager Selected

databases

ScanMail Administrator(s) Editor (or higher) Selected

Domino server Manager Selected
LocalDomainServers (if you Editor (or higher) Selected

are using replication)

OtherDomainServers No access Not selected

ScanMail requires at least Editor access to perform manual and scheduled scans of
the Notes databases, and Delete documents privilege to delete logs older than the
specified number of days (see page 8-8). Do not select any check boxes for the
Default user.

7. On the Roles group, click the [PolicyCreator], [PolicyModifier], and
[PolicyReader] roles to enable access to ScanMail database components with
restricted access.

8. Click OK

For more information on assigning roles and refining Notes database access, refer to the
Notes help—Restricting access to documents and local databases.

Accessing ScanMail Databases

There are two ways to access a ScanMail database:
*  Using a Notes Client

*  Using a compatible Web browser
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Accessing ScanMail Databases Using a Notes Client

The Notes Client provides quick, easy access to ScanMail features.

To access a ScanMail database using a Notes Client:

1.
2.
3.
4.

5.

Open a Notes Client.

Click File > Open > IBM Notes Application.

In the Server text box, specify the Domino server where you installed ScanMail.

In the Database list, locate the ScanMail Configuration Database

(smconf.nsf).
Click Open.

.2 Display Summary of Al Servers

K

Server Status - SMD55/Dominod (local server)
Policy applied

Riealtime scan has been running since
Status last Lpdated

Product Information
Product license:

Froduct version
Scan engine version

Advanced Threat Scan Engine version
Virus pattsm version:

Virus pattem version in updaie database
‘Spyware pattem version

nieliTrap paitem version

nteliTrap Exception pattem version:
Contert fiter engine version:

Arti-spam engine version:

Ant-spam pattem version (Master):
Arti-spam pattem version (ncremental)
URL fitering engine version

Data loss prevertion fiter

Realtime Scan Status
Mail scan status:
Database scan status:

Smart Protection Status
Web reptation
Scan service source:

Operating System Information
Flatfom:

Defaut
E]

05/20/2013 0217 FM
05/20/2013 0217 PM

Sjune with Data Protection, Activated

5.6, Buid 1001
37481031
3731022
346700
6.821.00
1337.00
0.167.00
0.811.00
7.1.0.1051
681017
13284
19284 004
35.1047
7.1.0.1051

Enabled
Disabled

Disabled
None

Windows 64bits

FIGURE 3-2. The Configuration Database displays Server Summary

as the default first page

IBM Notes creates a database icon for ScanMail in the Notes Workspace.
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Accessing ScanMail Databases Using a Web Browser

3-8

The ScanMail Configuration, Quarantine, Log, Update, and Help databases are
accessible through a Web browser for those who are using Domino server and running
the Notes / Domino HTTP task, provided that the Domino Server document has been
configured to allow database access with a Web browser.

Domino provides password security for ScanMail. System administrators can configure
the password (see Set the Internet Password for ScanMail Database Access through a Web Browser
on page 3-9) for each person under the HTTP password in the Address Book. The
Access Control List, as set from the Notes Workspace, can further control access.

To access a ScanMail database using a Web browser:

1. Open a Web browser.

2. In the Address text box (or similar), type the following Web address:
http://{Domino server}/smd/smconf.nsf

where {Domino server} represents the Domino server’s host name or IP
address.

Summary

Display Summary of All Servers

b configuration

b Actions Server Status - SMD55/Domino9 (local server)
Policy applied: Default
stz Real-time scan has been running since: 05/20/2013 02:17 PM
Quarantine Database Status last updated: 05/20/2013 02:17 PM
(el Product Information
b Administration Product license: Suite with Data Protection,Activated
Product version: 5.6, Build 1001
Scan engine version: 9.748.1031
Advanced Threat Scan Engine version: 9.73.1022
Virus pattern version: 9.467.00
Virus pattern version in update database: 6.821.00
Spyware pattem version: 1.337.00
IntellTrap pattern version: 0.167.00
InteliTrap Exception pattern version: 0.811.00
Content filter engine version: 7.1.0.1051
Anti-spam engine version: 6.8.1017
Anti-spam pattem version (Master): 19284
Anti-spam pattern version (Incremental): 19284.004
URL filtering engine version: 3.5.1047
Data loss prevention filter: 7.1.0.1051
Real-time Scan Status
Mail scan status: Enabled
Database scan status: Disabled

Smart Protection Status
Web reputation: Disabled
Scan service source: None

Operating System Information
Platform: Windows 64bits

FIGURE 3-3. Access ScanMail databases using a Web browser
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Limitations when Accessing ScanMail Databases Using a
Web Browser

There are limitations when using a Web browser to access ScanMail:

*  You must save a policy, rule or filter that you have created before you can configure
it.

*  When accessing the ScanMail Configuration database, the following options are
unavailable:

e ScanMail Databases
¢ Domino Administrator

*  Some elements to view and operate Data Loss Prevention Filtering, and Local
Smart Scan Sources are not fully supported. Additionally, some elements to view
and operate Content Filtering for Database scan is not fully supported.

*  When accessing the ScanMail Log Database, the following options are unavailable:
»  Statistics > Database scan history

*  Log Maintenance > Deletion Settings > Manual deletion

Set the Internet Password for ScanMail Database Access
through a Web Browser

Set an Internet password to securely access ScanMail from a Web browser. ScanMail
uses Domino’s own password schema for restricting database access.

To set the Internet password for accessing a ScanMail database:
1. Open the Address Book and select the Person you will grant access.
2. Type a password in the Internet password field.

3. Click Save and Close.

For additional information regarding Internet passwords, consult the IBM Notes /
Domino documentation.
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Accessing other ScanMail Databases through the
Configuration Database
Use the Configuration Database to access other ScanMail databases.
To access other ScanMail databases through the Configuration database:
1. Open the ScanMail Configuration database.
2.  Click the corresponding link to access:
*  Log database
*  Quarantine database

*  Update database



Chapter 4

Configuring Scan Tasks

This chapter explains how to set up policies for different individuals and groups in your
organization to enforce real-time and scheduled malware and unwanted content
protection. In addition, it provides manual scanning instructions.

This chapter contains the following topics:

*  Planning for a Policy-based Antivirus and Content Security Protection on page 4-2

*  Managing Policies on page 4-3

*  Creating Rules on page 4-9

*  Organizing Rules on page 4-19

*  Introducing ScanMail Filters on page 4-20

*  Configuring the Scan and Filter Settings on page 4-25

*  Running Manual Scan on page 4-64
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Planning for a Policy-based Antivirus and
Content Security Protection

Trend Micro recommends that you use the policy-based features in SMID to establish
and maintain a standard antivirus, data loss prevention, and content security setting,

Policies allow you to:

Automate redundant creation of antivirus and update settings, and other
maintenance tasks

Easily configure all of the servers in an environment from a single server

When planning for policy-based antivirus and content security protection, consider the
following activities:

Create group policies based on the ScanMail default policy.

In a large network with multiple servers that perform common roles, you can save
considerable configuration time and maintenance when you base a policy on the
default policy (see Understanding Policies, Rules, and Filters on page 1-9). You can easily
and quickly create a common set of mail real-time and scheduled scanning
protection settings once rather than repeatedly for each individual server.

Create group policies to assign settings applicable to all Domino servers in a specific
geographical or administrative segment.

In a multi-server environment, defining server groups based on similar functions or
characteristics ensures that ScanMail applies the appropriate policy to all servers in a
group.

Create policies that have a common purpose. For example:

¢ A policy for all Domino email servers that require the same
protection—real-time mail scanning

¢ A policy for all servers that require real-time and scheduled database scanning

Decide which servers belong together, and define the set of protection, update, and
notification methods that apply to them. For example, you can create and then apply
a policy that protects a mail server to other servers that act as mail servers.

Create unique policies to assign settings to specific Domino servers.

A unique policy assigns a default configuration to individual users, user groups, or
servers. For example, to set scheduled scanning that will run only on certain days of
the week, create a policy with a scheduled scan rule and then assign it to individual
or groups of database servers.
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How Policy-based Protection Works

Policy-based protection works when you do the following:

1. Create policies for ScanMail scan tasks, notifications, updates, and general options.
See Understanding Policies, Rules, and Filters on page 1-9.

2. Create server settings for each server in your environment. See Configuring the Server
Settings Menn Options on page 5-3.

3. Set synchronization schedule and enable policies to replicate to other servers in
your environment.

After all the policy documents and server profiles have been created, you will need
to include the ScanMail Configuration Database (smconf.nsf) in your
replication schedule for the servers in your environment. View the status of all
servers in the Summary view. See Viewing the Summary of All Servers.

Note: To replicate successfully between servers, add the target server to the database’s ACL
list and grant manager access. See Creating and Applying a New Access Control (ACL)
Entry on page 5-17.

Managing Policies

This section describes how to use the ScanMail Configuration database to manage
policies.

Creating Policies
Use the ScanMail Configuration database to create policies.
To create policies:

1. Open the ScanMail Configuration Database (See Accessing ScanMail Databases on
page 3-0).

2. From the left menu, click Configuration > Policies.
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3.
4.

T Create NewPoliy 1% Dl Poicy 3] Priolze Polkes

Policy Name |Applies To

gt ] L D

lest2 LocalDemainServers
Defauit g

FIGURE 4-1.  Policy list

From the working area, click Create New Policy.

Type the Policy Name.

@ cancel +[] Save & Close

T~ Use thess seftings as the default settings for all servers that da not have an explcit policy

Policy Name: Py
Priority: <cassigned automatically>
This policy applies to server/server groups: FaE

B Saliep

Mail Scan I Database Scan | Scheduled Scan | Scheduled Update | Notifications | Cluster Trusting

™ &pply the strictest rule to all recipients with conflicting rules 7

T Enable Trend Micio Antispam 7 Corfigur
I~ Enable web Reputation Corfigurs

™ Allows spam mails but move them to the recipient's Junk folder 2 Configure

Create New Rule | Remove Rule | | Drganize Rules |

Active |Priority  [Rule Name |source Destination Filter Enabled Exit Flag [When Valid

FIGURE 4-2. Creating a policy

Select from This policy applies to servet/server groups the server ot server
groups that should apply the policy.
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10.

11.

12.

Note: The server group type should be set to multi-purpose when using Domino
version R8.

Click Copy Settings to copy the scan, update, or notification rule from the list of
available policies.

Note: Copy Settings creates a policy that is the same as the source policy, with
exceptions such as the Policy Name and the servers or server groups that

apply.

Create a real-time mail scan rule (See Creating Real-time Mail Scan Rules on page 4-9).
Create a real-time database scan rule (See Creating Real-time Database Scan Rules on
page 4-14).

Create a scheduled database scan rule (See Creating Scheduled Database Scan Rules on
page 4-16).

Define how ScanMail delivers notifications (See Defining How ScanMail Delivers
Notifications on page 7-0).

Define cluster trusting (See Managing the Trusted Cluster Servers for a Policy on page
4-7).

Click Save & Close.

ScanMail adds the new policy in the Policies view.

Modifying Policies

Use the ScanMail Configuration database to modify policies.

To modify policies:

1.

2
3.
4

Open the ScanMail Configuration Database (see page 3-0).
On the left menu, click Configuration > Policies.
On the working area, double-click a policy.

Modify the Mail Scan (page 4-9), Database Scan (page 4-14), Scheduled Scan
(page 4-16), Scheduled Update (page 6-5), Notifications (page 7-6), or Cluster
Trusting (page 4-7) tab settings.
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5.

Click Save & Close.

Deleting Policies

Use the Policies view to delete a policy.

To delete a policy:

1.

Open ScanMail Configuration Database (See Acessing ScanMail Databases on page
3-6).

On the left menu, click Configuration > Policies. The Policies view appears.
Select the policy that you want to delete.

On the working area, click Delete Policy.

Note: The ScanMail default policy cannot be deleted.

Prioritize Policies

4-6

Use Prioritize Policies view to select the order of precedence for all policies (see Figure

4-1).

To prioritize policies:

1.

Open ScanMail Configuration Database (See Acwessing ScanMail Databases on page
3-6).

From the left menu, click Configuration > Policies. The Policies view appears.
From the working area, click Prioritize Polices. The Policy Organizer appears.

Select the policy for which you want to change priority; then, click Increase
Priority or Decrease Priority as appropriate.

Repeat as needed until all priorities are set.
Click Close.
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Managing the Trusted Cluster Servers for a Policy

Use the Cluster Trusting tab to view the cluster server(s) to which the selected policy
applies and select the trusted servers in a cluster group.

Note: The Default policy can never belong to a specific cluster group. Therefore, it cannot

be used in the Cluster Trusting tab.

To manage trusted cluster server(s) for a policy:

1.

2.

Create or modify a policy (See Creating Rules on page 4-9) or (See Modifying Policies on
page 4-5) for more information.

Click the Cluster Trusting tab.

@ Cancel 1] Save & Close

™ Use these settings as the default settings for all servers that da nat have an explicit policy

Policy Name: Py
Priority: <assigned automatically>
This policy applics to server/server groups: FamE

Copy Setlings

hail Scan | Database Scan | Scheduled Scan | Scheduled Update | Notifications | Cluster Trusting

This policy is applied 1o the following cluster servers. Trend Micro recommends trusting nodes belonging to the same cluster and
sharing the same palicy. By default, the servers listed under “In This Policy” are the nodes in the same cluster that share the same
policy.

Cluster Server Name In This Policy Not In This Policy

Cluster Trusting is not applicable. The servei(s] applying this policy does not belong to a cluster group. Click Update to check and resolve the grouping.

P Show change histary

FIGURE 4-3. The Cluster Trusting table lists the servers available in a
cluster group.

Do one of the following:

*  When the Cluster Trusting table is empty, click Update to resolve the cluster
server grouping and refresh the view.

*  When the Cluster Trusting table lists the applicable servers, select a server to
include in the trusted cluster group.
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4-8

Note: The Cluster Trusting table has two columns: In This Policy and Not In This
Policy. The servers listed in the In This Policy column are the ones that apply
the selected policy. Consider Figure 4-4.

B9 Back [ Edit

I Use these settings a the default ssttings for all servers that do nat have an explicit policy

Policy Hame: test
Priority: 1
This policy applies to server/server groups: ASD_S1/0ATESTOU/QATESTO/CN

Mail Scan | Database Scan | Scheduled Scan | Scheduled Update | Motifications | Cluster Trusting
This policy is applied to the following cluster servers. Trend Micro recommends tusting nodes belonging to the same cluster and

sharing the same policy. By default, the servers listed under “In This Policy” are the nodes in the same cluster that share the same
policy.

Cluster Server Name In This Policy Mot In This Policy

ASD_DOM1 ¥ CN=A5D_S1/0U=0ATESTOU/OD=QATESTO/C=CH [T CM=ASD_S2/0U=DATESTOW/O=QATESTO/C=CN
[¥ CH=ASD_S3/0U=DATESTOU/O=0ATESTO/C=CH

P Show change history

«| [ASD_51 -]

FIGURE 4-4. Selecting server to include in the trusted cluster group

In Figure 4-4, the cluster named ASD_DOMT has three servers: CN=ASD_S7,
CN=ASD_S52, and CN=A5D_53. The policy named #est is applied only to
CN=ASD_S1. In the Cluster Trusting table, the servers CN=A5D_S7 and
CN=ASD_S3 are selected. Therefore, CN=ASD_S7 will trust CN=AS5D_53 and
CN=AS5D_S52 will not be trusted.

Click Save & Close.
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Creating Rules

Create mail and database rules to define how ScanMail filters and scans messages and
databases in real time. Alternatively, create scheduled database scan rules to schedule
periodic scanning of Notes databases.

Note:  Always ensure that smdreal has started and that its status is Idle before you create

rules.

Tip: If a rule has too many conditions, it can become unpredictably complex. Trend Micro
recommends creating multiple simple rules rather than one or two complex rules per
policy.

Creating Real-time Mail Scan Rules

Real-time mail scan rules define how ScanMail scans and filters incoming and outgoing
messages.

To create a mail scan rule:

1. Create or modify a policy (See Creating Rules on page 4-9) or (See Modifying Policies on
page 4-5) for more information.

2. From the working area, click the Mail Scan tab.
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@) Cancel =[] Savet Close

I Use these settings as the defauit setings for al servers that do not have an explicit policy

Policy Name: Fa

<assigned automaticallys

is policy applies to server/server groups: Fam
Copy Setlings
Mail Scan | Database Scan | Scheduled Scan | Scheduled Update | Motificstions | Cluster Trusting

I [Ensble mai szan

I pply the stiictest rule to allrecipients with conflicting rules ?

™ Enable Trend Micro Antispam 7 Configure
I Enable Web Reputation Conligue:
I Allow spem mails but mave them ta the recipient's Jurk folder 2 Conligue
Create Now Ruls | Fiemove Aue | | Drganize Aules |
Active |Priority [Rule Name [Source Destination Filter Enabled Exit Flag [When Valid

FIGURE 4-5. The Mail Scan tab defines ScanMail real-time message
scanning.

Select Apply the strictest rule to all recipients with conflicting rules to
implement the strictest mail scan rule when multiple rules are triggered during mail
scanning, See Apply the Strictest Rule on page 4-12 for details.

If you have the Suite or Suite with Data Loss Prevention edition, select Enable
Trend Micro Anti-spam and click Configure to specify anti-spam settings (See
Configure Anti-Spam Filtering on page 4-20).

If you have the Suite or Suite with Data Loss Prevention edition, select Enable
Web reputation and click Configure to enable specify Web reputation settings.

Click Create New Rule.

On the New Mail Rule screen, select Stop processing succeeding rules if the
mail matches this rule (enable Exit Flag) to instruct ScanMail to stop
processing other rules and finalize the action on the message when it matches one
of the rules.

Tip: To improve performance when ScanMail scans messages, enable Stop
processing succeeding rules if the mail matches a rule in a mail scan rule.

On the General tab, specify the rule name.
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10.

Set general settings (See Configure General Mail Scan Rule Settings on page 4-13).
Click the Scan Options tab to set how ScanMail scans and filters messages:
*  Security Risk Scan (See Configuring Security Risk Scan on page 4-40)

*  APT Prevention Filter (See Configuring APT Prevention Filter on page 4-44)
*  Scan Restrictions (See Configuring Scan Restrictions on page 4-46)

*  Message Filter (See Configuring the Message Filter on page 4-47)

»  Attachment Filter (See Configuring the Attachment Filter on page 4-48)

*  Content Filter (See Create a New Content Filter on page 4-52)

*  Data Loss Prevention Filter (See Confignring Data I.oss Prevention Filter on page
4-59)

*  Script Filter (See Confignring Script Filter on page 4-61)

Tip:

When creating a rule, Trend Micro recommends that you save a copy of blocked
messages to the Quarantine Database rather than deleting them. Once you have verified
that the new rule is free of unintended consequences, modify and change the scan
action.

11.
12.
13.
14.
15.

Set the scan notification (See Setting the Scan Notifications on page 7-8).
Configure Redirect Options (See Configuring Redirect Options on page 4-62).
Insert disclaimers (See Inserting Disclaimers on page 4-63).

Set the rule schedule (See Setting the Rule Schedule on page 4-63).

Click Save & Close.
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Apply the Strictest Rule

The option Apply the strictest rule to all recipients with conflicting rules instructs
ScanMail to apply the strictest mail scan rule to all recipients with conflicting rules.

Consider the following example:

*  Mail scan rule A has the following settings:

General: | Include specified recipients = A11 of
Accounting

Scan Options > Attachment Fil- | Enable attachment filtering by size = 10MB
ter:
Action = Block mail

*  Mail scan rule B has the following settings:

General: | Include specified recipients =
user@domain.com

user@domain.com is a member of the All of
Accounting group.

Scan Options > Attachment Fil- | Enable attachment filtering by size = 5MB
ter:
Action = Block mail

When an incoming message with a 7-MB attachment addressed to A11 of
Accounting and user@domain. com arrives:

*  Allusersin the A1l of Accounting group will not receive the message if Apply
the strictest rule... is enabled.

e All users, excluding user@domain . com, will receive both the message and the
attachment if Apply the strictest rule... is disabled.

Disabling this option allows ScanMail to apply the strictest mail scan rule to a specific
user in a group.

Tip: Defining accurate and complete address groups ensures that ScanMail applies the
appropriate policies to individuals in those groups.
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Configure General Mail Scan Rule Settings

Use the Mail Scan General tab to set the included and excluded senders and recipient
for a mail scan rule.

To configure the general mail scan rule settings:

1. Click the General tab.

2. Under Rule Identifier, type a name for the rule.

Tip: Trend Micro recommends using a name that appropriately describes the rule
(for example, finance_confidential).

3. Specify the senders or recipients that will be the target of this rule. Choose from the
following:

*  Under the Senders section, choose the target senders:
i.  Select which senders to include:

* Click All senders to apply the rule to all senders belonging to the
servers specified.

* Click Specified senders to apply the rule to specific senders.

Do one of the following:

* Type or click [Zlto select the Notes user or group from the list (for
example, user@domain. com).

* Type parts of the user or group and use the wildcard characters * or ?
(for example, *@domain).

ii. Specify the senders to exclude.
*  Under the Recipients section, choose the target recipients:
i.  Select which recipient to include:

* Click All recipients to apply the rule to all recipients belonging to the
servers specified

* Click Specified recipients to apply the rule to specific recipients

Do one of the following:

*  Type ot click =l to select the Notes user or group from the list (for
example, user@domain.com)
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6.

* Type parts of the user or group and use the wildcard character * or ?
(for example, *@domain)

ii. Specify the recipients to exclude.

Note: If you specified both sender(s) and recipient(s), select the operator (see page
4-20) that ScanMail will use when processing this rule.

From the Action when Sender and Recipients Match section, select the action
when the sender and/or recipient match: Block or Deliver.

For the Deliver option, choose whether to Set to low priority or Hold mails to
be delivered at a time range.

Note: By default, Domino R8 servers route low priority messages between 12 AM and
6 AM.

From the Notification section, select Notify sender to send notification to the
message sendet.

a. Type a name in the Subject field.
b. Type a new message or click Add >> to add tags to the message field.
Click Save & Close.

Settings such as a rule name, priotity, sender and recipient inclusion/exclusion, schedule,
and Exit Flag settings, and the Scan Options enabled are available in the Mail Scan tab
view.

Creating Real-time Database Scan Rules

Real-time database scan rules define how ScanMail scans Notes databases.

To create a database scan rule:

1.

2.

4-14

Create or modify a policy (See Creating Rules on page 4-9) or (See Modifying Policies on
page 4-5) for more information.

On the working area, click the Database Scan tab.
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@ Carcel =+ Save & Close

I™ Use these seltings s the default seifings for all servers that do nat have an esplcit policy

Policy Name: T
Priority: <azrsighed autamatically>
This policy applies lo server/server groups: P =

Copy Seftings

hail Scan | Database Scan I Scheduled Scan | Scheduled Update | MNofifications | Cluster Trusting
I Enabe database soart

Create New Rule | | Aemove Rule | Organize Fules |

Active  |Priority  |Rule Name |Filter Enabled When Valid

FIGURE 4-6. Database Scan tab

Select Enable database scan to enable database scan functionality.
Click Create New Rule. The New Database Scan Rule screen appears.

From the Rule Identifier section, type a name for the new rule in the Name field.

Note: The Priority for the rule is assigned automatically. See Changing a Rule’s Priority
on page 4-19 for information about how to modify the priority settings.

Click the Databases to scan tab to set which database(s) to scan:
¢ All databases— ScanMail scans all databases stored on the Domino server.

*  Scan selected databases only— ScanMail scans specific database(s) based on
the directory and database list.

*  Exclude selected databases from scanning— ScanMail skips scanning of
specified database(s).

Use the Add, Remove, and Remove All buttons to manipulate the database(s)
in the list.

Click the Scan Options tab and set how ScanMail scans databases according to the
following:
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10.

Security Risk Scan (See Configuring Security Risk Scan on page 4-40)
Scan Restrictions (See Configuring Scan Restrictions on page 4-40)
Script Filter (See Configuring Script Filter on page 4-61)

Attachment Filter (See Configuring the Attachment Filter on page 4-48)

Set the scan Notification (See Sezzing the Scan Notifications on page 7-8).

Set the rule schedule (See Sezting the Rule Schedule on page 4-63).
Click Save & Close.

Tip: To configure ScanMail to perform a real-time scan whenever a database file is opened,

instead of only when it is modified, set SMDEnableOpenEvent=1 in
notes.ini.

Creating Scheduled Database Scan Rules
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Scheduled scan rules define how ScanMail scans Notes databases at a specific time.

To create a scheduled scan rule:

1.

Create or modify a policy (See Creating Rules on page 4-9) or (See Modifying Policies on

page 4-5) for more information.

On the working area, click the Scheduled Scan tab.

@ Carcel #L] Save & Closs

I Use these seftings as the default seftings for al servers that da not have an explicit palicy

Policy Name: "
Priority: <assigned autamatically
This policy applies to server/server groups: ra=

Copy Settings

Mail Scan | Database Scan | Scheduled Scan | Scheduled Update | Notifications | Cluster Trusting

I™ Enable scheduled scar

Create New Rule | Remove Rule | Oiganize Fules |

Active  |Priority  [Rule Name |Filter Enabled |[Sun [Mon |Tue |wed |Thu |[Fri

FIGURE 4-7. Scheduled Scan tab

Click Create New Rule.
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4.  On the New Scheduled Scan Rule document, specify the general settings in the
General tab:

a.

b.

Specify the rule name.

Select the scan condition:

Enable incremental scan— instructs ScanMail to scan only updated and
new documents since the last scan

Incremental scanning can save considerable server time and resources.
ScanMail scans only files that have been modified since the last complete
scan.

Scan all documents if the pattern file has been updated— instructs
ScanMail to scan all documents when ScanMail updates to a new pattern
file

Scan all documents if the scan engine has been updated— instructs
ScanMail to scan all documents when ScanMail updates to a new scan
engine

Type an integer that corresponds to the minimum number of days
before ScanMail should perform scanning. For example, if the minimum
number of days is 4, ScanMail will run a scheduled scan on the fourth day
after the last scan.

The minimum number of days setting applies to both pattern file and
scan engine update condition.

Note:  The conditions Scan all documents if the pattern file / scan engine

has been updated follow the incremental scan setting,

5. Click the Databases to scan tab to set which database(s) to scan:

All databases— ScanMail scans all databases on the Domino server

Specified databases— ScanMail performs or excludes from scanning specific

mail file(s) or database(s)

Use the Add, Remove, and Remove All buttons to manipulate the database(s)
in the list.

6. Click the Scan Options tab to set the following scan options:

Security Risk Scan (See Configuring Security Risk Scan on page 4-40)
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APT Prevention Filter (See Configuring APT Prevention Filter on page 4-44)
Scan Restrictions (See Configuring Scan Restrictions on page 4-40)
Attachment Filter (See Configuring the Attachment Filter on page 4-48)
Content Filter (See Create a New Content Filter on page 4-52)

Data Loss Prevention Filter (See Configuring Data 1.oss Prevention Filter on page
4-59)

Script Filter (See Configuring Script Filter on page 4-61)

Set the scan notification (See Set#ing the Scan Notifications on page 7-8).
Set the schedule.

a.

C.

Type the time in the Run at time field that corresponds to the time when the
schedule scan rule will be run. For example, 06 : 00 AM.

Note:  If the Run at time field is left blank, the scheduled scan rule will be
invalid.

Type how long the scan will run in the Duration of scan field. 0 (zero) will
instruct ScanMail to stop only when scanning is finished completely.

Type ot click =l to select the days of the week when the rule will be run.

Click Save & Close.

Note: Whenever creating a new rule, Trend Micro recommends saving a copy of

blocked email messages to the Quatrantine Database rather than deleting them.
Once you have verified that the new rule is free of unintended consequences,
modify and change the scan action.
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Organizing Rules

Use the Rule Organizer to organize mail scan, database scan, or scheduled scan rules.

¢-\‘| Close . TUp .7 Dovm o7 Emable Pule . Disakle Bule 4
E.
| | Active |Pliolit_v|RuIe MName |Soulce |Deslination |Enahled Filters |W'hen VYalid |
7 1 Default Mail Scan Al All Security Risk Scan Always
APT Prevention Filter
Database Scan
& 1 DEScan Security Risk Scan Always
Scheduled Update
# 1 Scheduled Update Blways ‘f

FIGURE 4-8. Click #Uur| or = paun to modify a rule’s priority.

Use the Activate Rule or Deactivate Rule button to enable or
disable a rule.

Trend Micro recommends the following guidelines when organizing rules:

Give your broadest rules, and those with the greatest likelihood of matching, the
highest priority.

ScanMail checks each message (and/or attachment) against the entire list of active
rules, from priority 1 to priority X. If Stop processing succeeding rules if the
mail matches this rule is enabled, further rule comparisons stop and the action
specified (typically quarantine) is enacted once a match occurs.

For example, if a rule with a 50% probability of matching occurs at the end of a list
of 12 active rules, each of the 11 rules before it would be checked before the match
occurs on rule 12. By moving such a rule to priority 1, the match would be found
immediately; the processing of the 11 rules would be saved.

Create and apply many narrowly focused rules rather than a few very broad rules.

Create one rule for each condition you want to check, or each blocking action you
want to take, rather than 2 or 3 rules with every option filled out.

Changing a Rule’s Priority

Use the Rule Organizer document to modify the order by which ScanMail applies mail,
database, scheduled scan, and scheduled update rules. The Rule Organizer also
provides a shortcut to enable or disable a rule.
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To change a rule's priority:

1. Under the Mail Scan, Database Scan, Scheduled Scan, or Scheduled Update
tab, click the Organize Rules button.

2. Change a rule's priority:
*  Click #Ur| to promote a rule

e (Click m to demote a rule
3. Click Close.

Rule Operators

The OR operator is always implied as the connector between senders and recipients list
within a rule.

The AND operator is implied within a given list. In other words, all items on the same
line, delimited with a comma, are connected. For example, the entry:

l@domain.com, 2@domain.com, 3@domain.com

means 1@domain.com AND 2@domain.com AND 3@domain.com.

Introducing ScanMail Filters

Filters are subsets of a scan rule, which actually define the scanning and filtering
behavior of ScanMail through the Scan Options.

Filter Execution Order

The Scan Options tabs allow you to create filters that make up the database and mail
scan rules.

General | Scan Options I Maotification Template | Fedirect Options | D\sclaimer' Scan Schedule |

Gecurity Fizgk Scan I APT Prevention Filter | Scan Restrictions | Message Filter | Attachment F\Iter' Cantent Filter | Data Loss Prevention Fi | ﬂ$

FIGURE 4-9. The Scan Options tabs
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Use the following table to define how ScanMail scans or filters messages, attachments,

and content (in the following order):

ORDER FILTER PROVIDES OPTIONS TO SET SPECIFIC SCANNING ACTION ON...
1 Message Filter Various message types
2 Attachment Filter Unwanted attachments
3a Scan Restrictions Compressed, encrypted, and other attachment types
Note: ScanMail applies the Scan Restrictions
settings when Virus Scan is enabled in
Security Risk Scan.
3b Security Risk
Scan attachments with document exploits
4 APT Prevention suspicious attachments
Filter
5 Content Filter Messages with unwanted content based on administra-
tor-defined explicit rules
6 Data Loss Preven- | Messages that violate custom data loss prevention rules (see
tion Filter Table 7-3 on page 1-11)
7 Script Filter Messages with stored form or rich text hot spot content
Note: When spam filtering is set, a mail scan rule executes the following filter order:
1. Spam filtering (Configure Anti-Spam Filtering on page 4-26) of incoming
messages based on Approved Senders and Blocked Senders (when
enabled) or the Trend Micro Anti-Spam engine.
Web Reputation (Configure Web Reputation on page 4-35).
General settings (Configure General Mail Scan Rule Settings on page 4-13).
4. Scan Options filter enabled.
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Spam Filtering (Suite Edition or Suite Edition with Data
Loss Prevention only)

The Trend Micro Anti-Spam engine (TMASE) provides spam filtering of incoming
messages. Incoming messages refer to those messages sent by SMTP protocol. Spam
filtering allows ScanMail to block unwanted messages based on the following

components:

ORDER COMPONENT SOURCE DESCRIPTION

1 Approved Senders | User-defined A list of people and/or organiza-
tions from whom messages will be
accepted.

Other messages take the Action
on unwanted messages.

2 Blocked Senders User-defined A list of people and/or organiza-
tions from whom messages will be
blocked.

Other messages will be accepted.

3 Rule files Trend Micro Consist of heuristic and URL signa-
ture files. The Trend Micro
Anti-Spam engine uses these files
to filter for spam messages when
there are no approved and blocked
senders defined.

Note: If there are no approved senders or blocked senders set, TMASE will use the Trend
Micro rule files.

TMASE provides three filter levels. The following table shows an example of when and
how TMASE tags messages as spam:

FILTER LEVEL/SENSITIVITY THRESHOLD LEVEL
High (Rigorous filtering) 4.0
Medium (Default filtering) 5.0
Low (Lenient filtering) 8.0
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where:
*  Filter level defines the TMASE sensitivity when filtering for spam
*  Threshold level defines the maximum allowable spam score

If the total spam score is equal or greater than the threshold level, then TMASE tags
a message as spam. Otherwise, if the total spam score is less than the threshold level,
ScanMail proceeds to the next filter execution order (see page 4-20).

Note: SMLD 5.0 and above has a dynamic threshold level, which changes according to
different spam rules.

For example:

SMTP Server: 1B.6.6.52 connected
SHMTP Server: Message BO5?D67D received
SMIP Serwver: 18.6.6.52 disconnected. 1 messagels]

A7/19-20084
E?/l?/ZBIQ
received
A7/19-2004
@7/19/2004
87,19 /20084
A7/19-260084
87/19-26004
received
07/19/2084
A7/19-2004
@7/19/2004
87,19 /20084

15 ZBB Spam triggered
ageBasrou7D delivered to userl/tmase
18.6.6.52 connected
essage BB59DYF2 received

Mes
SHMTP Server: 18.6.6.52 disconnected. 1 messagels]

15.288: Spam triggered

Router: Message BBS?D?FZ delivered to userl/tmase
SHTP Server: 18.6.6.52 connecte

SHMIP Server: M age BA592DC?? received

SMTP Server: 18.6.6.52 disconnected. 1 messagels]

3 726 passed(nut Spam>
age-Bogrover? delivered to userl/tmase
SHTP Server: 18.6.6.52 connected
SMTP Server: M age BO59DD56 received
SHMTP Server: 1 .6.52 disconnected. 1 messagels]

a?7-19/2084
A7/19-2004
07,19 /2084

WOIMMN R REEOD AR o

24.380: Spam triggered
Router: Message BA5?DD56 delivered to userl/tmase

FIGURE 4-10. Sample spam scores

In this example, the filter level is set to Medium. The highlighted items refer to the spam
scores. The first spam score, 15.20, is greater than the threshold level (that is, 5). This
instructs TMASE to tag the message as spam. On the other hand, the second spam
score, 3.720, is less than the threshold level. This prevents TMASE from tagging the
message as spam.

To configure the filter level or Approved and Blocked Senders lists, see page 4-26.
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Content Filtering (Suite Edition, or Suite Edition with Data
Loss Prevention only)

Content filters define how ScanMail filters message contents based on explicit rules
defined by administrators.

Content security can take many forms, including checking for leaked corporate secrets,
offensive or inappropriate language, or even questionable contact with competitor
corporations or hostile countries.

The Content Filter tab allows you to define general and advanced rules.

Create general content filter rules to:

*  Quickly create a rule (without first creating an Expression).

*  Tilter messages based on the text appearing in the Subject.

*  Filter messages based on the text appearing in the Body (all or some keywords).

*  Tilter messages based on file attachment name.

Create advanced content filter rules to:

*  Create complex filters, including one or more Expressions.

*  Create filters using multiple Expressions, linked via the OR operator.

*  Scan the message body only.

*  Scan attachment content only.

*  Focus your search on a particular message header field: Subject, To, CC, From.

*  Setup a match threshold for the occurrence of a particular attachment (for example,
do not block a message unless X matches of the specified attachment has occurred.
This is useful, for example, for mass mailing threats that tend to propagate widely
and may include attachments of a common name).

¢ Include additional values for . OCCUR.
¢ Include additional values for . NEAR.

Expressions

Expressions are words or phrases ScanMail uses to filter message content based on
headers and actual content.

When creating or modifying content filter expressions, refer to the help section at the
bottom of the New Expression workspace for details on how to use logical operators.
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Leave a space before and after each operand in the expression. Do not insert line breaks
or carriage returns within a single expression. Create two expressions, instead.

For example, to create an expression to distinguish between “apple” fruit and “apple”
computer, you may want to construct a rule such as the following:

.(. .OCCUR. apple .). .AND. . (. apple .NEAR. computer .). .OR.
. (. apple .NEAR. macintosh .). .AND. .(. .NOT. . (. .OCCUR. eat
D).

This rule triggers a match if:

*  The word Apple occurs two or more times in a document, and within 25 words in
either direction of the word computer

*  The word Macintosh occurs in a document
However, if the word eat also occurs in the document—a match is not triggered.

Trend Micro recommends keeping expressions simple and narrowly defined. Instead of
one complex rule as shown above, create two simpler expressions and attach each to a
mail scan rule.

Expression 1: . (. .OCCUR. apple .). .AND. . (. apple .NEAR.
computer .).

ExpressionZ: . (. apple .NEAR. macintosh .). .AND. . (. .NOT. . (.
.OCCUR. eat .). .).

When you configure multiple expressions to a mail scan rule, the OR operator is used
between them. To create expressions, see page 4-55.

Configuring the Scan and Filter Settings

Use the Scan Options tabs to configure scan restrictions and filter settings.

Note: The Anti-spam Filter, Web Reputation Filter, Data Loss Prevention Filter,
Content Filter, and End User Quarantine (EUQ) features are available only in the
SMID Suite. See SMID Activation Code on page 2-43 for details. In addition, the
ScanMail spam filtering only applies to mail scan rules.

*Data Loss Prevention is only available for Suite with Data Loss Prevention.
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Configure Anti-Spam Filtering

4-26

Use the Anti-spam Configuration screen to configure how the Trend Micro
Anti-Spam engine filters unsolicited or unwanted messages (see page 4-22). The
Anti-Spam Configuration screen provides options that define the heuristic detection
level or the Approved Senders and Blocked Senders lists, which ScanMail uses to filter
for unwanted messages.

To configure Anti-spam filtering:

1.  On the Mail Scan tab, select Enable Trend Micro Anti-spam, and then click
Configure. The Trend Micro Anti-spam Configuration Window appears.

Trend Micro Anti-spam Configuration [ x}

Spam Filter Sensitivity
© High: catches the rmost spare with a high level of false positives

@& iediumiDefauly; catches a high rate of spam with a moderate level of false positivesi
" Low: catches obvious spam with & lows level of false positives.

Action

Action on unwanted messages: rQuarantmEJﬂ
Email Stamp

[T Inserthe stamp as a subject prefix TISPaM]:

Exception

Scanbdail for 1Bk Domino trusts the approved senders and treats blocked senders as
sparm.

Tha Ani-spam Engine will nof scan email addresser az well 3z domain or sub-domair
rrames in e fsfz.

(For axampla: domain com, user@domain com, or @domain com)
Approved Senders | Blocked Sendears I

Add email addresses or domain names fo the Approved
Sendars fisi

™ Use approved senders (0}

Rernove |

FIGURE 4-11. Trend Micro Anti-spam Configuration screen
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On the Trend Micro Anti-spam Configuration window, select the anti-spam mail
filter level:

High— the most rigorous level of spam detection

ScanMail monitors all messages for suspicious files or text, but there is a greater
chance of false positives. False positives are email messages that ScanMail filters
as spam when they are actually legitimate messages.

Medium- the default setting

ScanMail monitors at a high level of spam detection with a moderate chance of
filtering false positives.

Low- the most lenient level of spam detection

ScanMail will only filter the most obvious and common spam messages, but
there is a very low chance that it will filter false positives.

In Action on Spam, select the action to take for unwanted messages: Pass,
Quarantine, or Block.

Select Insert the stamp as a subject prefix, and then type the stamp if you want
to add eye-catching notices or keywords in the subject header.

Enable Approved Senders and Blocked Senders, and then specify the senders for
these lists to help minimize false positives.

Select the Approved Senders check box

Type the email addresses/domains that you want ScanMail to exempt from
blocking and then click Add or click an address/domains from the list or click
an address/domains from the list and click Remove.

Select the Blocked Senders check box

Type the email addresses/domains that you want ScanMail to block and then
click Add or click an address/domain from the list and click Remove.

Note: Enabling the Approved Senders and Blocked Senders lists and customizing

the senders that belong to each list helps reduce false-positives. See Spam
Filtering (Suite Edition or Suite Edition with Data Loss Prevention only) on page
4-22 for details on how ScanMail applies the Trend Micro rules and user-defined
lists.
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Note: The approved sender, blocked sender, and approved URL lists are stored in the
same database (smlists.nsf). Each of the lists can be managed in the database.
See Managing the Filter Lists on page 5-15 for details on how to manage the lists.

6. Save the spam filter settings by clicking:

*  OKon the upper-right corner of the Anti-spam Configuration screen, and then
clicking Save & Close (IBM Notes console interface)

- Of -

*  Save (Web interface)
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Anti-spam filtering with EUQ enabled:

1.

From the Mail Scan tab, select Enable Trend Micro Anti-spam and click

Configure. The Trend Micro Anti-spam Configuration screen appears.

Trend Micro Anti-spam Configuration | x|
Spam Filter Sensitivity
€ High: catches the rost spam with a high level of false positives.

& MediumiDetault): catches a high rate of spam with a moderate level of false positives.

€ Low: catches obvious spamwith a low level of false positives.

Action

Action on unwanted messages " Quarantine ;=1

Email Stamp
[ Insertthe stamp as a subject prefix J‘[SF'A!\M]:J

Exception

Scanhdail for [BM Domino trusts the approved senders and treats blocked senders as
pam.

The Antspam Engine will nof scan emar addresses as well as domarn or sub-domain
namres i fhe st

(For example. domarn. com uzerBidomain.cam, or &domain com
Approved Senders | Blocked Senders |

Add email addreszes ar domain names ta the Approved
Senders list

[T Use approved senders(0)

| bad

Remave

FIGURE 4-12. Anti-spam Configuration Screen

Under the Action section, choose Quarantine as the action on unwanted
messages.

Click OK.
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4. Seclect Allow spam mails but move them to the receiver’s Junk folder.

End User Quarantine

The end-user quarantine (EUQ) feature enables you to choose whether to allow spam to
appear in your email account. This will allow you to view spam mails and decide whether
to keep, delete, or quarantine it. In SMLD 5.5, if you enable the EUQ feature, the feature
will apply to all users. In SMID 5.6, the feature has been redesigned to allow you to select
target usets/groups.

Mail Scan | Database Scan | Schedulsd Scan | Scheduled Updats | Motifications | Cluster Trusting |

¥ Enable mail scan

[T Apply the shictest rule to all recipisnts with conflicting wles ?

[~ Enable Trend Micro &nti-spam 2 Canfigure

[~ Enable Web Reputation Configure
™ llow spam mails but move them ta the recipient's Junk folder ? Configure |
Create Mew Rule I Remove Rule | Organize Rules |
Active ‘Flimily |Rule Name ‘Soulce Destination ‘Filtel Enabled ‘ Ewit Flag |W’hen Valid
& 1 Default Mail Scan All All Security Risk Scan Off Alwens

FIGURE 4-13. Enable End-User Quarantine

WARNING! IfEUQ is enabled and the mail template replication is also enabled on the
Domino server, the mail template will be replicated automatically
between all the servers. That is, the mail template will also be replicated
on the servers where SMID is not installed or using an older version of

SMID.
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To enable end user quarantine:

1. From the Mail Scan tab, select Allow spam mails but move them to the
recipients's Junk folder.

2. Click Configure. Select the All recipients or Selected users/groups option.

tail Scan I Database Scan | Scheduled Scan | Scheduled Update | MNotifications | Cluster Trusting |
¥ Enable mail scan

[~ Apply the strictest rule to all recipients with conflicting rules ?

¥ Enable Trend Micro Anti-spam 2 Configure |
™ Enable Web Reputation Configure |

V' Allow sparn mails but move them to the recipient's Jurk folder 2 Canfigure |

Trend Micro End User Quarantine

Move the spam mails to the Junk folder for: | 0K l fation Filter Enabled
Cancel
' Selected users/groups
" aE

FIGURE 4-14. Configuring End User Quarantine

3. Click Save & Close.
To deploy EUQ to a user’s mailbox:

1. On the Domino server console, deploy EUQ to the target mail template:

*  To deploy EUQ to the default mail template, run load smdeuqg
-install.
> load smdeug —install

[1698:80082-178C]1 B9-85-2813 11:47:11 PM SMDeuqg: Starting
[1698:8002-178C]1 B9-85-2013 11:47:28 PM SMDeuqg: Shutdouwn

[A808 :BAP2—-1B5C] B9-85-2813 11:48:21 PM Admin Process: Searching Administration
Regquests database

FIGURE 4-15. Deploying EUQ to the default mail template
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*  To deploy EUQ to a specified mail template, run load smdeuqg
-install ${mail template file path}.

> load smdeug —install mailB85.ntf
[BF38:0002-12681 A9-085-2013 11:58:12 PM SMDeuqg: Starting

[BF38:8802-12681 B9-85-2013 11:58:15 PM SMDeuqg: Shutdown

FIGURE 4-16. Deploying EUQ to a specified mail template

Note: The specified mail template must have been configured under the Domino Data
folder.

2. Run load design on the Domino server console. Or, you can accept the
defaults, and the change will take effect at 01:00 a.m.

> load design

[0B78:8082-0C3C] @9-05-2@13 11:56:46 PM Database Designer started

[BB7@: B0B2 C3C] 39/35/2313 1 46 PM  Updating ’'TrendMicro_ApprovedSenderRule
s’ into da .53 from template *Mail (RB.5>’

[OR7@: AAB2 IC3C] 39/85/2813 11 56 46 PM_ Updating ’TrendMicro_ApprovedSender_Con
féx)'nation _SubForm’ into database ’'Mail Journaling (8.5)' from template 'Mail (RS

[BB7@: BBBZ 3(:] 39/35/2813 11:56:46 PM Updating ’'TrendMicro_Manage _ApprovedSen|

iderList’ int ase ‘Mail Journaling <8.5>" from template ‘Mail (R8.5>’

[BR?7@: EEBZ—E(BC] 89/35/2313 11:56:46 PM Updating ’<%JunkMail)’ into datahase *M|

lail Journaling <8.5>' from template ’Mail <(RB.5>’

[BB?B BaB2 | EC3C] B89,85,2813 11:56:47 PM MUWarning: Cannot locate design template

‘plugincatalog_i4 1 .ntf’ used by 'Widget Catalog <8.5>'

[IBB?B #082-ac3c1 89/35/2313 11:56:47 PM Marning: Cannot locate design template

‘cpp freebusy web service’ used hy ’cppfbu:

[PR7@0:B082-AC3C]1 B9,85-2013 11:56:47 PH Warning: Cannot locate design template

"Lotus Note’ used by ’Lotus Hotes-Domino Smart Upgrade Tracking Reports — automal

tio

[BB7@:8002-8C3C1 39/35/2313 11:56:47 PH Updat1ng 'TrendchPo _ApprovedSenderRule|

s’ into database ‘admin’ from template ’‘Mail (R8.

[BR7@: BAB2-AC3C 1 89/35/2313 1 47 PH llpdatlng 'Trend"lcru _ApprovedSender_Con|

f irmation_SubForm’ int admin’ from template ’Mail (R8.5>’

[BB'?E 7EC3C] 39/85/2313 1 47 PH Updating ’'TrendMicro_Manage_ApprovedSen

de v * admin n_template 'Mail (RB.5)>’

[BB?B BBBZ IC3C] 39/35/2313 11: 47 PH Updating ’'<5JunkMail)’ into datahase ’a

idmin’ from template ‘Mail (RS

[EH'?E BAB2-AC3C1 89/35/2313 1 56 47 PH llpdatlng Trend"lcru _ApprovedSenderRule|
into database ’autorcpt’ from template *Mail (RS

[AB78:8882-AC3C] B9-85-28013 11:56:47 PH Updating 'Trendﬂlcro prrouedSendar Con|
f irmation_SubForm’ into database 'autorcpt’ from template "Mail <(R8.
3(:] 39/35/2813 1 47 PH Updating ’'TrendMicro_Manage ﬂpprouedSen
int se autnrcpt’ from template 'Mail (R8.5>"
[BR78 EBZ—EC3C] 89/35/2313 1 47 PM  Updating ’<{$JunkMail)’ into datahase ’al
utorcpt’ from tenplate *Mail (RB.5>’

FIGURE 4-17. Load Design screen

Note: After EUQ is deployed, check the uset’s mailbox. The Junk folder should contain
two menu items: Manage Junk Mail Senders List and Manage Approved
Mail Sender List. All users will have the two menu items in their mailboxes
regardless of whether you select All recipients or Selected users/groups.
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Note: If the mail template does not contain a Junk folder, spam mails will be moved to
the user's Inbox folder.

| soein Bomain [ L Senntait Soarienantion 3¢ adain = fusd 30

I = T
IEZ'L !::1' | | @ paden m| Busage Tuk Bail Senders List . Bussge dppeored Buil Sender Lit |58 = ) = Were=
e ‘A
- Sander - Sabiec +

2 Inbox
¥ Deafes
& St
F* Fallow p
S All Depuments
T Teash
& Chat Hustsay
@ & Views
@ & Foldars
& B Archive

@ & Tools

FIGURE 4-18. Manage Mail Screen

To add a sender to the approved mail sender list:

1. From the junk folder, right-click a mail message, and select Add sender to
approved mail sender list.

| consin Bomain | L3 scaataid Eontiwantion ] e dmin - duk %

£ Mail~ il Belate ALl Munage Fesk Buil Sunders Line . Bunage doprowed Bail Sendar List (@ » ) = Beras &
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I:ﬁ Trbaz - ciwnz provcribe yeor sedication sslise!plaankicsdy wa vz ol akich 3 damaterr
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& Sent s
P Fallow Up
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B Trash
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FIGURE 4-19. Add Sender to Approved List

2. Choose from the following:
*  Add mail address only
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Add mail address domain

Approved Mail Address B

Would you like to add Peter.HaidiLeveld. con> to yowr Approved Mail Sender List?
€ dd mail sdiress only
© Add mail sddress domsin

FIGURE 4-20. Add Mail Address or Mail Address Domain

Note: To remove the mail address from the approved mail address list, click Manage
Approved Mail Sender List on the menu bar.

To disable end user quarantine:

1. On the Domino server console, disable EUQ for the target mail template:
*  To disable EUQ for the default mail template, run load smdeug
-uninstall.

> load smdeug —uninstall
[BE1C:8BA2-A51C]1 B9-85-20813 11:55:89 PM SMDeuqg: Starting

[BE1C:B8B82-851C1 B9-85-20813 11:55:18 PM SMDeuqg: Shutdown
ke

FIGURE 4-21. Disabling EUQ for the default mail template

*  To disable EUQ for a specified mail template, run load smdeuqg
-uninstall ${mail template file path}.

> load smdeuwg —uninstall mail85.ntf
[1848:0002-0998]1 B9-085-2013 11:55:57 PM SMDeuqg: Starting

[1848:8002-89981 B9-85-2813 11:55:57 PM SMDeuqg: Shutdouwn
’d

FIGURE 4-22. Disabling EUQ for a specified mail template

2. Run load design on the Domino server console. Or, you can accept the
defaults, and the change will take effect at 01:00 a.m.
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3.  On the Mail Scan tab, deselect the Allow spam mails but move them to the
recipients's Junk folder check box.

Configure Web Reputation

Use the Web Reputation Configuration screen to configure how the Trend Micro
URL filtering engine protects against dangerous URLSs in email according to their Web
reputation rating,

Local and Global Smart Protection

This version of SMID provides two options for determining the reputation and safety of
URLs; these options are: the Global Smart Protection Network, and the Local Smart
Protection Server. The Global Smart Protection Network sends requests to the Trend
Micro Smart Protection Network to examine the reputation of URLs. The Local Smart
Protection Server sends these requests to your local smart protection server. The Local
Smart Protection Server will provide more privacy and improve the processing speed.
Protection is automatically updated and strengthened as more products, services and
users access the network, creating a real-time neighborhood watch protection service for
those who use it. The smart scan solution uses the Smart Protection Network for
in-the-cloud protection.
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To configure Web reputation:

1.  On the Mail Scan tab, select Enable Web reputation, and then click Configure.

The Trend Micro Web Reputation window appeats.

Ganoral| Approved URL List | Mofification Template | =

Scan Services Cancel

IMPORTANT: Using Trend Micro Smart Protection Network requires an Internet connection and will send your
URL ta the Trend Micra Smart Pratection Netwarkta exaraine the URL s reputation.

& Trend Micro Smart Protection Network
€ Local Smart Protection Server
Canfigure local Smart Pratection Server in the Server Settings > Local Smart Scan Sources tab.

Security Level

€ High: Blocks a areater number of Web threats butincreases the risk af false positives.
& Medium: Blocks mostWeb threats while keeping the false positive count low.
© Low: Blocks fewer Web threats but reduces the risk of false positives.

Select the type of messages that will be scanned

@ Bath SMTP and IBM Nates mails
€ 8MTP mails only

Select the message part(s) that will be scanned

' Mail Body
I Mail Attachment

Action

Action on umwanted messages. * Guarantine Ji=1

I Stamp subject prefi< ¥ [Unsafe URLL

Ifyou belisve a URL is misclassified. use the follawing link to notity Trend Micro
http iiglobal sitesstety trendmicro. corm

Notification

I Administratar(s)

[Scanhail detected malicious URL [36URL%] at %
IMAILPART? and took this astion: %ACTION%.

Add >3

IMAILPART?% and took this astian: %ACTION%.

Add >>
‘ | >|‘|

FIGURE 4-23. Trend Micro Web Reputation Configuration screen

[ScanMail detected malicious URL [%URL?] at % ‘

2. From the Trend Micro Web Reputation Configuration window, select the Scan
Services method you would like to use on the General tab:

¢ Trend Micro Smart Protection Network

¢ Local Smart Protection Server

4-36



Configuring Scan Tasks

Note:  If you select Local Smart Protection Server, you can also select Do not
allow Smart Protection Server to make external queries to Smart
Protection Network.

This feature only works if you are using Smart Protection Server 2.1 or
older.

Note:  You must also configure Smart Protection Server to stop sending external
queries to Smart Protection Network. Refer to the Smart Protection Server
documentation for the procedure.

From the Trend Micro Web Reputation Configuration window, select the
Security Level on the General tab:

*  High- Blocks a greater number of Web threats, but increases the risk of false
positives.

ScanMail monitors all messages for suspicious URLs, but there is a greater
chance of false positives. False positives are email messages that ScanMail filters
as containing dangerous URLs when they are actually legitimate.

*  Medium- Blocks most Web threats while keeping the false positive count low.

ScanMail monitors at a high level of detection with a moderate chance of
filtering false positives.

*  Low- Blocks fewer Web threats, but reduces the risk of false positives.

ScanMail will only filter the most obvious and common Web threats and there
is a very low chance that it will filter false positives.

Select the type of messages that will be scanned:
*  Both SMTP and IBM Notes mails

*  SMTP mails only

Select the message part(s) that will be scanned:
*  Mail Body

*  Mail Attachment

In the Action section, select the Action on unwanted messages: Pass,
Quarantine, or Block.
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10.
11.

Note: If you have selected Mail Attachment in the Select the message part(s) that
will be scanned section, and Block in the Action section, then you can also
select Delete the attachment if only the attachment contains unwanted
URL:s to delete only the attachment with the unwanted URL, and pass the email
to the recipient. However, if you have selected Mail Body in the Select the
message part(s) that will be scanned section, and Block in the Action
section, then it will block the whole message if the mail body contains an
unwanted URL.

Select Stamp subject prefix, and then type a stamp label to add eye-catching
notices or keywords in the subject header.

Note: If you believe a URL is misclassified, use the following link to notify Trend
Micro:
http://global.sitesafety.trendmicro.com

In the Notification section, select the notification options to apply when an URL
is identified by the Web Reputation filter.

On the Approved URL List tab, select Enable approved URL list, and then
Add, Import, Export, or Remove URLs to the list to help minimize false positives
by doing the following:

e Type a URL in the Add field and click Add.

*  Click Import to import a list of URLs from a text file (*.txt), and click Add.
*  Click Export to export a list of URLs to a text file (*.txt).

*  To remove a single URL, select the URL and click Remove.

e  To remove All URLs, click Remove All.

On the Notification Template tab, configure the notification template.

After you complete all settings, click OK to save and exit.

Note: The approved URL list can be managed in the smlists.nsf database. See
Managing the Filter Lists on page 5-15 for details on how to manage the list in
the database.
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Optimizing Web Reputation

You can optimize the performance of Web Reputation scanning by configuring your

settings accordingly. Consider implementing the following to optimize your version of
Web Reputation:

Add your company’s internal URL to the Approved URL List. This allows
ScanMail to bypass messages containing internal URLs, which will reduce network
bandwidth usage and improve performance.

Use a Smart Protection Server to reduce network bandwidth usage. Web reputation
services sends URL queries to the external Smart Protection Network or to the local
Smart Protection Server. Networks can suffer a performance impact with a slow
Internet connection when querying the Smart Protection Network. Configure a
Smart Protection Server using the management console and change the Web
Reputation source by clicking Server Settings > Local Smart Scan Source.

To optimize Smart Protection Server performance, consider a dedicated Smart
Protection Server for ScanMail. If your Smart Protection Server is providing
services to both ScanMail and OfficeScan, for example, server performance could
suffer.

Troubleshooting Web Reputation Performance Issues

If Web Reputation is performing slowly, try the following to test your Web Reputation
settings:

Verify that the network connection is stable.

ScanMail monitors its connection status to the Smart Protection Network and the
Smart Protection Server that provides Web Reputation services. Enable the alert
Send notification when Web reputation service becomes:

Unavailable /Available so that you will receive notifications whenever ScanMail is
unable to connect to the Web reputation source. If you frequently receive this alert,
it is an indication that your network connection may have stability issues.
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Configuring Security Risk Scan

Use the Security Risk Scan tab to define how ScanMail scans documents for viruses
and other malware.

o Back () Cancel #0] Save & Close
¥ Enatle mail scan e
[~ Stop processing succeeding miles if the mail matches this rule [enatble Exit Flag)
General I Secan Options I MNotification Template I Fedirect Options I Dlsclalmerl Scan Schedule |
Security Risk Scan I APT Prevention Filter I Scan Restrictions I Message Filter I Attachment Filter I Content Filter
¥ Enable Vius Scan

Scan Mode Setlings

W Enable Advanced Thieat Scan Engine 7

Files to Scan
Select which files to scar:
& 4l [recommended)
= Selected files
Exclude these true fils types: T aE
Exclude files by name or extension: raE
Advanced Options

Additional fles to scan:

¥ Compressed files
[ Clean compressed fles
¥ Embedded objects

¥ Macros in Microsoft Office files J‘smpJﬂ
Thiz zetting will apply to all Microzaft Office files containing macros. even if they are not malicious.
& Al

£ Equalto and below heuristic level
|2 - Default filkering 'I
IntelliTrap
¥ Enable IrteliTrap 7
Action

1 Use Activetction]|nteligent actions based on the vins pattem file)
% Specified actions:

Action on cleanable wirus: " Clean =]
Action on uncleansble virus: " Quarantine =]

Action on other rmalware:

I Massmailing virus " Delete =)

™ Jdaka rraaram FFelate e

FIGURE 4-24. Scan Options > Security Risk Scan screen
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To configure security risk scan options:

1.  Under Scan Options click the Security Risk Scan tab.

2.  Under Scan Mode Settings section of the Security Risk Scan tab, click Enable
Advance Threat Scan Engine.

Note:

Advanced Threat Scan Engine checks files for less conventional threats,
including document exploits. However, it may detect some files that are actually
safe. Therefore, further observation and analysis is required in a virtual
environment, which is provided by Deep Discovery Advisor. Refer to the topic
Enbanced APT Prevention on page 1-vi for the details about Deep Discovery
Advisor and Configuring Deep Discovery Advisor Settings on page 5-13 for the
configuration procedure.

3. Under the Files to Scan section, configure the security risk scan options as follows:

a.

Select which files to scan from the following options:

All (recommended) scans all documents except file types, names, or
specified extensions.

To define exclusions by true file type, type the file name or extension in the

Exclude files by true file type field or click =l to select from the
available list. You can also specify exclusions according to file name or
extension, type the file name or extension in the Exclude files by file

name or extension field or click |1 to select from the available list.
Selected files scans documents based on file names or extension names.

A default list of file extension names is presented. To define new file
names or extensions to scan, type the file name or extension in the Scan

files by file name or extension field or click =1 to select from the list.

4. Under the Advanced Options section, configure the settings according to the
following:

Compressed files scans compressed files.

ScanMail contains a default list of compressed file types to scan. You can select
the number of layers of compression to scan via the Scan Restrictions tab.
When you select Clean compressed files, ScanMail extracts compressed files
for scanning, which can consume a large amount of disk space.
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Note:  Refer to the Trend Micro Knowledge Base for the list of compressed file
types that the ScanMail can support.

*  Embedded objects scans OLE.
ScanMail can scan embedded objects in IBM Notes mails.

*  Macros in Microsoft Office files uses heuristic scanning to detect macro
viruses/malware in Microsoft Office files (for example, * . doc and
*.x1ls).

Heuristic scanning is an evaluative method of using pattern recognition and
rules-based technologies to detect malicious macros.
After you select Macros in Microsoft Office files, choose from the following:

*  All takes actions against all macros detected.

Note:  This setting will apply to all Microsoft Office files containing macros, even
if they are not malicious.

*  Equal to and below heuristic level takes action against macros detected
with the specified or a lower heuristic level.

When you select Equal to and below heuristic level, you also need to
choose a heuristic level.

Note:  Before choosing a heuristic level, read the following information:

¢ Level 1 uses the most specific criteria, but detects the least macros.

. Level 4 detects the most macros, but uses the least specific criteria, and
may falsely identify safe macros as harboring malicious macros.

. Trend Micro recommends level 2. This level provides a high detection
level and a fast scanning speed. It uses only the necessary rules to
detect macro virus/malware strings and has a low level of false
identification.

5. In the IntelliTrap section, you can enable or disable scanning by IntelliTrap.
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Note: Virus writers often attempt to circumvent virus filtering by using real-time

compression algorithms. IntelliTrap helps reduce the risk of such viruses
entering your network by blocking email attachments with real-time compressed
executable files and pairing them with other malware characteristics.

6. Under the Action section, set the scan action on infected files according to the
following:

Use ActiveAction (intelligent actions based on the virus pattern file)
identifies malware types and uses the Trend Micro pattern file to automatically
recommend scan or filter actions based on how each type infects a computer
system or environment. Quarantine is the default action for items that are
uncleanable.

When you select ActiveAction, you will also need to choose an action to
perform on uncleanable Microsoft Office files. Microsoft Office files can
contain macros that cannot be stripped, which means that these files will be
scanned as uncleanable. The action that you select for Action on uncleanable
virus will be applied to Microsoft Office files only; the actions defined in the
pattern file will be applied to all other file types.

Specified actions allows you to select the action ScanMail takes according to
the malware type.

Note: If the Clean compressed files action is disabled, ScanMail applies the action for

a detected malware to the entire compressed file that contains the malware. If the
Clean compressed files action is enabled, ScanMail applies the action only to
the specific file harboring the malware.

If there is no threat and specific action enabled under Action on other
malware, ScanMail applies the Action on cleanable virus or Action on
uncleanable virus for all detected threats. To customize the Action on other
malware, enable the threat and then select the corresponding action.

For example, when Mass-mailing virus is enabled and the Delete action is
selected, ScanMail will automatically delete a detected mass-mailing virus.

7. Under the Notification section, select the notification options for when malware is

detected, uncleanable, or a scan action was applied on infected file(s).
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8. Under the Email Stamp section, select and enter the appropriate options.
9. Click Save & Close.

nfiguring APT Prevention Filter

Use the APT Prevention Filter tab to configure the ScanMail actions for suspicious
files for advanced persistent targeted attacks and latest or unknown security threats.

Note:  You MUST configure and start the Deep Discovery Advisor before configuring APT
Prevention Filter. See Configuring Deep Discovery Advisor Settings on page 5-13 and See
Starting Deep Discovery Advisor Agent on page 4-45 for the procedures.

To configure APT Prevention Filter options:

1.  Under Scan Options click the APT Prevention Filter tab.

2. Seclect Send messages to Deep Discovery Advisor for analysis.

Note: The Deep Discovery Advisor uses simulators to identify potentially harmful
behaviors shown by suspicious files. It can identify files used in advanced
persistent targeted attacks and latest or unknown security threats.

3. Inthe Scan Settings section of the APT Prevention Filter tab, configure the APT
prevention filter options as follows:

*  Select which messages to scan from the following options:
* Incoming messages only (recommended)
* Incoming and outgoing messages
*  Select which attachments to scan from the following options:

*  Detected by Advanced Threat Scan engine (recommended)

Note:  To use Detected by Advanced Threat Scan engine option, you must
enable Advanced Threat Scan Engine in Security Risk Scan tab. See
Configuring Security Risk Scan on page 4-40 for the procedure.
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*  Files with specified types—ScanMail can open, organize, and scan the
contents of more than 200 file formats—including Notes database
formats, the wide variety of file types that may be attached therein.
Selecting Files with specified types allows you to:

* Click Edit to modify the file type groups in ScanMail File Types
database.

*  Specify which file types to scan: Archives, Executables and
applications, Pictures, Audio/Video, Flash files, Documents,
Others.

* Type new file types or click =1 to select types for True file type(s).

Note:  Be aware that modifying the file type groups in APT Prevention Filter
will also update the file type groups information in Attachment Filter.

4. In the Security Level section, select the security level for SMID to apply actions
from the following options:

* High: Apply action on all messages exhibiting any suspicious behavior

*  Medium: Apply action on messages with a moderate to high probability
of being malicious

*  Low: Apply action only on messages with a high probability of being
malicious

5. In Action section, select the filtering action: Pass, Quarantine, Block, or Delete
attachment.

6. In the Notification section, select the notification options for when a suspicious
file is identified by the APT prevention filter.

In the Email Stamp section, define the email stamp settings for notification emails.

Click Save & Close.

Starting Deep Discovery Advisor Agent

To start Deep Discovery Advisor Agent manually

*  Type and run the following command on the Domino console:
load smddtas
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To start Deep Discovery Advisor Agent automatically with Domino server

1. Using a text editor, open the notes. ini of the Domino server where SMID is
installed, and then add the following item in the ServerTasks:

SMDdtas

2. Save and close notes.ini.

Configuring Scan Restrictions
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Use the Scan Restrictions tab to configure the ScanMail actions for compressed files

and files with special or unknown behavior.

To configure scan restrictions:

1. Under Scan Options, click the Scan Restrictions tab.

2. Select the scan action for compressed file, special, or unknown file behavior:

Exceed maximum extracted file size—restricts ScanMail to scan compressed
files that matches the Maximum extracted file size setting

Specify the Maximum extracted file size in kilobytes (KB).

Exceed maximum compression level-restricts ScanMail to scan compressed
files that match the Maximum compression level setting.

Select the limit of compression layers to scan by choosing the Maximum
compression layer. For example, if you want ScanMail to scan only files that
have been compressed and then recompressed (compression layer is equals 2),
set the Maximum compression layer to 3.

Note:  ScanMail can scan up to 20-layers of compression.

Password-protected files—restricts ScanMail to scan files that are
password-protected.

Unknown reason(s) why attachments could not be scanned-allows
ScanMail to perform a scan action for unscannable files automatically.

3. In the Notification section, select the notification options for when a file matches
the attachment filters.

In the Email Stamp section, define the safe email stamp settings.
Click Save & Close.
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Configuring the Message Filter

Use the Message Filter tab to define how ScanMail treats messages.

To configure message filter options:

1.
2.
3.

Under Scan Options, click the Message Filter tab.

Select the Enable message filter check box.

In the Action section, define the scan actions for encrypted messages that meet any

of the following conditions:

Exceed message size limit— allows ScanMail to bypass scanning and
automatically perform the specified action for messages matching the specified
limit.

Set the size limit in bytes (B), kilobytes (KB), or megabytes (MB).

Encrypted message within domain— allows ScanMail to bypass scanning
and automatically perform the specified action for encrypted messages whose
sender and recipients are within the same domain.

Encrypted incoming message— allows ScanMail to bypass scanning and
automatically perform the specified action for encrypted incoming messages
Encrypted outgoing message— allows ScanMail to bypass scanning and
automatically perform the specified action for encrypted outgoing messages.
Partial message— allows ScanMail to bypass scanning and automatically

perform the specified action for incomplete messages.

Message with character sets— allows ScanMail to bypass scanning and
automatically perform the specified action for messages with the specific
character sets.

In the Notification section, select the notification options for when a file matches
the notification filters.

In the Email Stamp section, define the safe email stamp settings.
Click Save & Close.
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Configuring the Attachment Filter
Use the Attachment Filter tab to define how ScanMail filters message attachments.

Trend Micro recommends blocking the following attachments on the ScanMail server:

TABLE 4-8. Recommended file extensions to block
EXTENSION DESCRIPTION
.386 Windows Enhanced Mode Driver or Swap File
.ACM Audio Compression Manager Driver (Windows) and Windows
System File
.ASP Active Server Page
.AVB Inoculan Anti-Virus virus infected file
.BAT Batch Processing
.BIN Binary File
.CLA Java Class File (usually *.CLASS but can be shortened)
.CLASS Java Class File
.CMD 0S/2, Windows NT Command File, DOS CP/M Command File,
dBase Il Program File
.CNV MS Word Data Conversion File
.COM Executable File
.Cs* Corel Script
.DLL Dynamic Link Library
.DRV Device Driver
.EXE Executable File
.GMS Corel Global Macro Storage
JHLP Windows Help File
LHTA Hypertext Application (runs applications from HTML files)
.HTM Hypertext Markup Language
.HTML
LHTT Hypertext Template
.INF Information or Setup File
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TABLE 4-8. Recommended file extensions to block
EXTENSION DESCRIPTION
.INI Initialization/Configuration file
.Js* JavaScript Source Code
.Js
.JSE
.LNK Linker File, Windows Shortcut File
.MHT* Microsoft MHTML Document (Archived Web Page)
.MPD Mini Port Driver
.0CX Object Linking and Embedding (OLE) Control Extension
.OV* Program Overlay File (.OVL)
.PIF Windows Program Information File
.SCR Screen Saver Script
.SHS Shell Scrap Object File
.SYS System Device Driver
.TLB Remote Automation Truelib Files
.TSP Windows Telephony Service Provider
.VBS Visual Basic Script
.VBE Visual Basic Script Encrypted
. VXD Virtual Device Driver
.WBT WinBatch Script
.WIZ Wizard File
.WSH Windows Script Host Settings File

To configure attachment filter options:

1.
2.
3.

Click Scan Options > Attachment Filter tab.

Select Enable attachment filter.

In the Filter Attachment by File Size section, select Enable attachment

filtering by size to filter attachments according to file size.
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Note: You can specify the file size per attachment or the total file size of all
attachments in a message. Set the size limit in bytes (B), kilobytes (KB), or
megabytes (MB). Select Single attachment file size or Sum of all attachments
(collective total file size of all attachments).

Select the filtering Action for Filter Attachment by File Size by choosing one of
the following: Pass, Quarantine, Delete attachment, Block mail, Redirect mail
for approval, or Send at a time range.

Note: When selecting Send at a time range, choose the Days of week and Time to
send.

In the Filter Attachment by File Type section, select the Enable attachment
filtering by file type check box.

ScanMail can open, organize, and scan the contents of more than 200 file
formats—including Notes database formats, the wide vatiety of file types that may
be attached therein.

a. Specify which file type to scan: All file types, Specified, or All except
specified.

Selecting Specified or All except specified allows you to:
*  Edit the ScanMail File Types database.

*  Type new entries or click Tl to select types according to true file type,
true file type groups, or extension name.

Note:  Be aware that Domino sometimes stores the attachment’s file name within
the body text of messages. A body text search will find the specified word
within a file name.

b. Select the filtering action: Pass, Quarantine, Delete attachment, Block
mail, or Redirect mail for approval.

c. Select Enable attachment filtering within compressed files to instruct
ScanMail to filter compressed files. By default, this option is disabled to
optimize server performance.
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In the Exception section Allowed attachments field, type the attachment file
name that will be excluded from filtering. You may use the wildcard characters (¥)
or (?) to specify multiple file names or extension names. Separate multiple entries
with semicolons (3).

The file names or extension names specified in the Allowed attachments field
overrides the attachment filtering criteria.

In the Notification section, select the notification options for when a file matches
the attachment filters.

In the Email Stamp section, define the safe email stamp settings.
Click Save & Close.

Configuring Content Filter

Content filters define how ScanMail filters message contents based on explicit rules

defined by administrators.

Content security can take many forms, including checking for leaked corporate secrets,

offensive or inappropriate language, or even questionable contact with competitor

corporations or hostile countries.

Note:  Scanning support for Microsoft Office and Adobe Portable Document Format

The Content Filter tab allows you to define general and advanced rules (see page 4-24
for details).

To configure content filter options:

1.
2.

Under Scan Options, click the Content Filter tab.
Select the Enable mail scan rule check box.

*  Seclect the Stop processing succeeding rules if the mail matches this rule
(enable Exit Flag) check box to stop processing other rules after a match.

Select the Enable content filter check box.

In the Content Filter section, select Create New Content Filter (page 4-52) or
Add Existing Content Filter (page 4-54).

In the Action section, select the Action on mails with unwanted content to
specify the scan action.
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6. In Notification section, select the appropriate notification and filtering options for
messages.

Insert a filter description in the notification to include additional instructions or
descriptions.

For example: Contact the Domino Administrator for more details.

7. Click Save & Close.

Create a New Content Filter

Use the Content Filter tab to create a new content filter.

To create a new content filter:

1. From the Content Filter tab, click Create New Content Filter.
2. In the Filter Name field, type a name for the content filter.

3. From the Select the message part(s) that will be compared against the
available expressions section, select the part of the message, (Subject, From, To,
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CC, Mail body, Attachment content, and Attachment file name) that ScanMail will
compare against the expressions (see Expressions starting on page 4-24 for details).

Filter Name ‘ ‘

Select the message partfs) that will be compared against the available expressions:

I Subiect [~ From I~ To rcc
I~ Mal body

I~ Attachment content

I™ Anachment file name:

™ &l select message partfs)] have to match

Select the expressions) used to filter message content:
Content fiter matches i the rumber of expressians in the message exceeds threshold: 7 1.,

Additional value for DCCUR ME
Additional value for NEAR, R-E)

Cicte New Exprassion | Add Expression | Riemove Evpressian | Remave Al |

|case Sensitive |Last Modified

This content filter is used by:

) Show change history

FIGURE 4-25. Creating a new content filter

Select All selected message part(s) have to match to instruct ScanMail to return
a match only when all selected parts match the content filter expression.

From the Select the expression(s) used to filter message content section, create
or add expressions that ScanMail will use for content filtering. See Creare New
Expressions on page 4-55 or Add New Expressions Based on Existing Expressions on page

4-56 for more information.

*  Type an integer in the Content filter matches if the number of expressions
in the message exceeds threshold field to instruct ScanMail to perform the
action on unwanted content if the number of expressions in a message exceeds

the specified value.

*  Specify a new integer in the Additional value for .OCCUR. ficld to instruct
ScanMail to perform the action on unwanted content when the total number of

expressions in a message is equal to the specified value
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*  Specify a new integer in the Additional value for INEAR. field to instruct
ScanMail to perform the action on unwanted content when the number of
words between expressions in a message exceeds to the specified value

Note:  ScanMail applies the logical operator AND if . OCCUR. and .NEAR. is
used in an expression.

6. Click Save & Close.

Remove Content Filter(s)

Use Remove Content Filter to remove all or a specific content filter.
To remove content filter(s):

1. Click the filter to be removed.

2. Click Remove Content Filter.

3. 'To remove all content filters, click Remove All.

ScanMail removes the content filter and instructs the real-time mail scan task of the
changes.

Add New Content Filters Based on Existing Filters

You can create content filters that define what portions of the message to scan, and use
them as elements for other content filters. For example, create a content filter for
scanning the Subject header, another for Attachments, and another to include all parts
of the mail; then, use these filters as building blocks for your content filter.

To add a new content filter:

1. From the content filter workspace, click Add Expression.

2. From the Add Expressions window, click the expressions you want to add. You can
select multiple expressions.

3. Click OK

Note: Too many expressions in a content filter can cause it to become unpredictably
complex. Trend Micro recommends including one or two expressions per content
filter.
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Create New Expressions

Create a new expression for each word, phrase, or concept you want to filter.
Alternatively, you can include multiple search criteria into a single compound expression.

Tip: Having too many conditions in a content filter often causes it to become unpredictably
complex. Trend Micro recommends creating one or two expressions pet content filter.

To create new expressions:

1. From the content filter rule workspace, click Create New Expression. The New
Expression screen appears.

2. Type the expression (that is, word or phrase) you want to filter, connected by logical
operators in the Definition section Expression field. Refer to the help section at
the bottom of the New Expression screen for details on how to use logical
operators.

Note: This version of SMID enables you to use Regular Expressions in your content
filtering. For example, if you want to filter a specific Social Security Number or
Bank Card, you can use .REG. and type:

For SSN
.REG. (00[1-9]|0[1-9] [0-9]|[1-6][0-9][0-9]|7[0-3][0-3]|7[56][0-9]1]|77[0
-21) [l:space:1 |\ [\\[\|]-12\d{2} [[:space:]|\.[\\[\]]-12\d{4}

For Visa, MC, Discovet, Switch/Solo, and JCB
.REG. (6011 |5[1-5]\d{2}]4\d{3}|67\d{2}) ([:space:1|\.|\\|\|]|-)2\d{4} ([:
space:]1 |\.|\\|\]|-)2?2\da{4} ([:space:]|\.|\\|\]]-)?\d{4}

3. Select Enable or Disable case sensitive matching,
4. Click Save & Close.

Tip: Before enabling a new expression in a Mail Scan rule, always test it first to be sute there
are no unexpected consequences and choose to Quarantine rather than Delete.
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Add New Expressions Based on Existing Expressions

Adding new expressions to a content filter based on existing expressions allows you to
re-use these items as a template.

To add new expressions:

1. From the Content Filter tab, select one of the existing content filters; then, click
Add Existing Content Filter.
2. In the Add Content Filter window, select the content filters you want to use. You

can select multiple expressions.
3. Click OK.

Tip: Too many content filters in a mail scan rule can causes it to become unpredictably
complex. Trend Micro recommends including one or two content filters per mail scan
rule.

Data Loss Prevention

This version of ScanMail enables you to use data loss prevention filtering to detect
sensitive data in Mail Content. Compliance Patterns are best used with structured
content, like Social Security Numbers (SSN), credit card numbers (CCN) and telephone
numbers.

For example, credit card numbers are typically presented in 16-digit format,
“XXXX-XXXX-XXXX-XxxX, making them good candidates for pattern-based detection.

Note:  Scanning support for Microsoft Office and Adobe PDFE. Database scans only the mail
database.

Data Loss Prevention enables you to manage DLP templates and Data Identifier.
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Data Loss Prevention Template Management

You can add, delete, copy, import, export and view data loss prevention templates from:
Configuration > Data Loss Prevention > DLP Templates. You can create a custom
template using expressions and keywords. This template may include multiple
expressions and keywords.

To add a custom template:

1. Click Configuration > Data Loss Prevention > DLP Templates.
Click Add.

Type a Name and Description.

Under Matching Condition, choose a Data Identifier: Expression, or Keyword.

A

Select existing, Import, or Add a new Keyword or Expression and click >> to
add it to the Matching Condition window.

6. Click Add to Template Definition.
7. Click Save & Close.

To delete a DLP template:

1. Click Configuration > Data Loss Prevention > DLP Templates.

2. Select a custom template and click Delete.

To copy a DLP template:

1. Click Configuration > Data Loss Prevention > DLP Templates.
2. Select one or more templates and click Copy.

To import a DLP template:

1. Click Configuration > Data Loss Prevention > DLP Templates.
2. Click Import and select a template in .dat format.

To export a DLP template:

1. Click Configuration > Data Loss Prevention > DLP Templates.
2. Click Export.

To view a DLP template:

1. Click Configuration > Data Loss Prevention > DLP Templates.

2. Double-click the template you want to view.
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Note:  You can only modify custom DLP templates. The pre-defined templates cannot
be modified.

Data Identifiers
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You can add, delete, copy, import, export and view keywords and expressions from:
Configuration > Data Loss Prevention > Data Identifiers.

To add a keyword:

A S o M

10.

Click Configuration > Data Loss Prevention > Data Identifiers.
Click Add and choose Keyword.

Type a Name and Description.

Select the appropriate Conditions.

Under the Sub Keyword section, type a Name and Description.
Select Case Sensitive as required.

Click Add.

Repeat to add additional sub-keywords. You can click import to bring in additional
sub-keywords.

Select a keyword(s) and click Remove or Remove All to remove sub-keywords.
Click Save & Close.

To add an expression:

el A S o M

Click Configuration > Data Loss Prevention > Data Identifiers.
Click Add and choose Expression.

Type a Name and Description.

Select the appropriate Type.

Type the Expression and choose whether Case Sensitive.

Type the Expression for Display and Examples.

Choose the appropriate Validation.

Click Save & Close.
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To copy a keyword or expression:

1. Click Configuration > Data Loss Prevention > Data Identifiers.
2. Select one ot more Keyword(s)/Expression(s).

3. Click copy.

To import a keyword or expression:

1. Click Configuration > Data Loss Prevention > Data Identifiers.
2. Click Import and select the .dat file.

To export a keyword or expression:

1. Click Configuration > Data Loss Prevention > Data Identifiers.
2. Click Export.

Note:  All keywords and expressions are combined during export.

To set View By parameters for keyword(s) or expression(s):

1. Click Configuration > Data Loss Prevention > Data Identifiers.

2. Click Viewed By and choose the appropriate option: Identifiers, Expression, or
Keyword.

To view a DLP template:

1. Click Configuration > Data Loss Prevention > Data Identifiers.

2. Select one Keyword or Expression and double-click it to open.

Note:  You can only modify custom DLP templates. The pre-defined templates cannot
be modified.

Configuring Data Loss Prevention Filter
This section describes the steps required to configure Data Loss Prevention Filter.
To configure data loss prevention filter options:

1. Under Scan Options, click the Data Loss Prevention Filter tab.

2. Select the Enable data loss prevention filter check box.
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In the Data Loss Prevention Filter section choose from the following options:

*  Create DLP Filter...

* Add Existing DLP Filter...

*  Remove Filter...

*  Remove All..

To create a DLP filter...

a. Under Data Loss Prevention Filter, click Create DLP Filter. The DLP filter
screen appears.

b. In the Filter Name field, type a new name for your filter.

c. Select the checkboxes that contain the parts of the email you want to check:
Subject, From, To, CC, Mail body, Attachment content, Attachment file
name.

d. Under Select Data Loss Prevention template, select a template from the
existing list and click >> to add it to the right window: Match any selected
data loss prevention template. Repeat the procedure to add more templates.
e Click Add to create your own DLP filter with a group of templates.

*  Click Import to import your own DLP template in .dat format.

In the Exception section, type the name of the file(s) you want to exclude from the
DLP filter.

In the Action section, select the Action on mails with unwanted content to
specify the scan action.

In Notification section, select the appropriate notification and filtering options for
messages.

Insert a filter description in the notification to include additional instructions or
descriptions.

For example: Contact the Domino Administrator for more details.

Click Save & Close.
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Configuring Script Filter
Use the Script Filter tab to define how ScanMail filters IBM Notes scripts.

To configure script filter options:

1.
2.
3.

Click Scan Options > Script Filter tab.
Select the Enable script filter check box.

From the String List section, type the stored form and rich text hotspot scripts to

filter as follows:

*  @Function strings may contain any valid IBM Notes function in Formula
language. For example: prompt

*  @Command strings may contain any valid IBM Notes formatted command
in Formula language. For example: [Execute] or

[FileDatabaseDelete]

*  Script strings may contain any valid LotusScript command from your
operating system. For example: shell, getobject, kill, rmdir, or
activate

*  @URLOPEN URLSs can open any valid URLOPEN command in Formula
language.

From the Action section, select the Action on items as appropriate.

Click |1 to set the filter action for Stored form hotspots and events and the
action for Rich text hotspots.

Note: The Auto-clean action for rich text hotspots instructs ScanMail to delete the
code segment that contains the malicious string. Consequently, the whole
document containing the hotspot will be quarantined completely to allow
document restoration of false-positive detections. If the Replace hotspot with
pop-up message is sclected, rich text hotspots will be replaced with a pop-up
message.

In the Notification section, select the notification options for when a file matches
the notification filters.

In the Email Stamp section, define the safe email stamp settings.
Click Save & Close.
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Configuring Redirect Options

4-62

Use the Redirect Option tab to set where ScanMail will redirect email messages for
approval. The designated approver decides whether a message is fit for delivery.

To configure redirect options:

1. Under a mail scan rule, click the Redirect Options tab.

2. User the Administrator section, click =1 to specify the approver’s email address in
the Redirect original message to field.

Note: Even if an account has administrator privileges, it will not be able to access the
ScanMail functions if that account is not included in the ScanMail databases
accesses and roles.

Ensure the account specified has the appropriate ScanMail database access. See
Defining Access and Roles to ScanMail Databases on page 3-4 to learn more about
defining ScanMail database access.

Tip: Trend Micro recommends ensuring the availability of the designated approver.
Set another email address where ScanMail can redirect email messages if the
designated approver will be unavailable.

In addition, you may want to designate at least two accounts that will approve
redirected messages. In the absence of one approver, the other designated
account can still attend to the redirected messages. This prevents messages from
getting lost or being forgotten.

3. Under the Notification section, type the notification subject when an approver
rejects or approves a message.

4. Click Save & Close.
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Inserting Disclaimers

Use the Disclaimer tab to insert disclaimers for a mail scan notification and define the
actual disclaimer message.

Note: ScanMail can insert disclaimers to an Internet mail on Domino. However, when there
are identical disclaimer names, ScanMail uses and inserts only the first disclaimer.

To insert disclaimers:
1. Under a mail scan rule, click the Disclaimer tab.
2. Select Enable disclaimer.

3. Set the disclaimer position.

Note: When ScanMail inserts filter notifications in a message, disclaimers that should
be positioned At the beginning of the message body are placed after the filter
notification. In addition, ScanMail inserts subject disclaimers after the original
message subject.

4. 'Type a name for the disclaimer in the Disclaimer name field.

Note: ScanMail will insert disclaimers with the same disclaimer names only once.

5. Type the appropriate naming information in the Subject disclaimer and Message
body disclaimer fields.

6. Click Save & Close.

Setting the Rule Schedule
Use the Scan Schedule tab to set the schedule of a mail or database scan rule.
To set the schedule:

1. Under a scan rule, click the Scan Schedule tab.
2. Specify the rule schedule:
*  Always— ScanMail applies the rule 24x7.
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*  Specified— ScanMail applies the rule during or except the specified day, time,
and time zone.

3. Click Save & Close.

Running Manual Scan

Ru
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Any database on the local Domino server, or remote clients with drives or directories
mapped to the local server, can be scanned for viruses.

There are two ways to run a manual scan:
*  Use the Domino server console

*  Use the Configuration Database

See the next sections for details on how to invoke a manual scan.

nning Manual Scan Using the Domino Server Console

You can scan Notes databases manually from a Domino server console or use the
ScanMail interface.

Any Notes databases on a local or mounted hard drive, including network drives, can be
included in a manual or scheduled scan.
To scan databases from the Domino server console:
Type and enter the following:
load SMDdbs -manual {directory name and database.nsf}
where {directory name and database.nsf} represents the database or

directory you want to scan.

ScanMail searches specified databases or respective directories under the Directory
section of notes. ini and follows the manual scan settings available in the
Configuration database.

Tip: Separate multiple databases with semicolons. For example:
load SMDdbs -manual
database.nsf;database2.nsf;database3.nsf;folder/database4
.nsf
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Running Manual Scan Using the Configuration Database

Use the Configuration database to invoke manual database scanning,

To run Scan Now:

AN o e

Open the ScanMail Configuration Database.

From the left menu, click Actions > Manual Scan.

On the working area, click Edit.

Click the General tab.

Under the Condition section, select Enable incremental scan.

Under the Duration section, specify the number of minutes that corresponds to the
duration of the scan.

Note: If the scan duration is set to zero (0), the manual scan task will stop once it
finishes scanning all databases.

Click the Databases to scan tab to set which database(s) to scan according to the
following:

e All databases— ScanMail scans all databases stored on the <Domino Datas>
directory, including databases found in its sub-directories.

* Specified databases— ScanMail scans specific database(s) based on the
directory and database list.

Select Include sub-directories to include folders under directories specified.

*  Exclude selected databases from scanning— ScanMail skips scanning of
specified database(s)

Use the Add, Remove, and Remove All buttons to manipulate the database(s)
in the list.

Click the Scan Options tab to configure the options as required.

Define the notification template.
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10. Click Scan Now.

[ Edit ] Close 7 Scan Now

General I Databases to scan I Scan Options | Notification Template

™ Enable Web Reputation Ferlire

Note:
Only mail documents will be scanned by the Web Reputation.

Condition
Incremental scan will only scan updated and new documents since the last scan.

™ Enable incremental scan

Duration

Duration of scan (0 means urtil finished): 0 minutes

»  Show change history

FIGURE 4-26. The ID used to run Scan Now must have the appropriate
access right to submit server console command.

11. Click Save & Close to save the manual scan settings.

Stopping the Manual Scan Manually
When you want to stop manual database scanning before it automatically finishes, issue
the following command to gracefully terminate the scan task at the Domino server

console:
tell SMDdbs quit

Scanning will stop after the current document has been scanned.
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Chapter 5

Performing Administrative Tasks

The Summary, Server Settings, CMAgent Settings and Administration options are
found in the Configuration Database. These options allow you to determine the
ScanMail server information, and configure functions to optimize the ScanMail database
manageability and performance.

This chapter includes the following topics:

o Viewing the Summary of All Servers on page 5-2

e Configuring the Server Settings Menu Options on page 5-3

*  Configuring CM Agent Settings on page 5-12

*  Configuring Deep Discovery Advisor Settings on page 5-13

*  Managing the Filter Lists on page 5-15

*  Configuring the Administration Menn Options on page 5-16
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Viewing the Summary of All Servers
The Configuration Database provides a summary of the scan task status, and the
ScanMail and operating system information.

To view the summary of all servers:

1. Open the ScanMail Configuration Database (see Accessing ScanMail Databases on
page 3-0).

2. From the left menu, click Summary.

2, Display Summary of All Servers

R
Server Status - SMD55/Dominod (local server)
Policy applied Default
Reaktime scan has been running since: 05/20/2013 02:17 PM
Status last updated 05/20/2013 02:17 PM
Product Information
Product license: Sjune with Data Protection Activated
Product version: 5.6, Buid 1001
Scan engine version 97431031
Advanced Threat Scan Engine version 973.1022
Virus pattem version 9.467.00
Virus pattem version in update database: £.821.00
‘Spyware pattem version: 1.337.00
Inteli Trap pattem version: 0.167.00
Intell Trap Exception pattem version 0.811.00
Content fiter engine version 7.1.0.1051
Anti-spam engine version 681017
Anti-spam patiem version (Master) 19284
Arti-spam pattem version (ncremertal) 19284.004
URL filtefing engine version: 351047
Data loss prevertion fiter. 7.1.0.1051
Real-time Scan Status
Mail scan status: Enabled
Database scan status Disabled
Smart Protection Stalus
Web reputation Disabled
Scan service source: None
Operating System Information
Platform: Windows 64bts

FIGURE 5-1. The Status view displays the status of the current server

3. Do any of the following:

*  Click Display Summary of All Servers to display a summary of all available
servers.

*  Press F9 to refresh the displayed information.
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Tip:

If Control Manager exists in your environment, you can also use the management
console > Product Status tab to view the ScanMail status.

Configuring the Server Settings Menu Options

Use Server Settings in the Configuration Database to define the following settings for a

Domino server or groups of Domino servers:

Directory used for detaching temporary files for scanning

Memoty size used for scanning

Proxy server settings for component download and product activation
Local Smart Scan sources used to configure Web Reputation

Type of ScanMail event and if they will be displayed through the Domino server
console

Notification to inform administrator(s) if a ScanMail task has ended abnormally

Default character set used when ScanMail cannot detect the character set used for
disclaimers

Other miscellaneous settings, such as multi-threaded scanning, trusted antivirus
servers, warning image, and message routing

Creating a Server Setting Rule

Use the ScanMail Configuration Database Server Settings menu to create a server

settings rule.

Tip: Create server setting rules per server or groups of servers.

To create a server settings rule:

1.

Open the ScanMail Configuration Database (see Acessing ScanMail Databases on
page 3-0).
On the left menu, click Configuration > Server Settings.

From the working area, click Create Server Settings.

5-3



Trend Micro™ ScanMail™ for IBM Domino™ Administrator's Guide

10.
11.

12.
13.

Specify which Server or Server Groups should apply the server settings rule.

Set directories used for scanning (see Set a Scanning Directory on page 5-5).

Set the memory size used for scanning (see Sez the Memory Size for Scanning on page
5-5).

Configure the proxy server settings that ScanMail will use for component download
and product activation (see Configure the Proxy Server Settings on page 5-6).

Configure the Local Smart Scan Sources (see Configure Local Smart Scan Sonrces on
page 5-7)

Select the event that will trigger ScanMail to display notification via the Domino
server console (see Monitor Server Events on page 5-9).

Enable server task monitoring (see Enable Server Task Monitoring on page 5-9).

Specify the default character set that ScanMail should use when it cannot detect the
character set of a message (see Specify the Default Character Set on page 5-10).

Configure miscellaneous settings (see Configure Miscellaneous Settings on page 5-10).
Click Save & Close.

Modifying a Server Settings Rule

Use the ScanMail Configuration Database Server Settings menu to modify a server

settings rule.

To modify a server settings rule:

1.

A

Open the ScanMail Configuration Database (see Acessing ScanMail Databases on
page 3-6).

From the left menu, click Configuration > Server Settings.

From the working area, double-click a server settings rule document or click Edit.
Modify settings.

Click Save & Close.

Configuring a Server Settings Rule

Use the Temporary Directory, Scan Memory, Proxy Settings, Local Smart Scan
Sources, Event Log, Task Monitoring, Regional Option, and Misc tabs to set the
properties of a Server Setting rule.
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Set a Scanning Directory

Use the Temporary Directory tab to set the directories that ScanMail should use when
detaching temporary files for scanning.

To set a temporary directory:

1.

Create or modify a server settings rule (see Creating a Server Setting Rule on page 5-3)
or (Modifying a Server Settings Rule on page 5-4).

From the working area, click the Temporary Directory tab.
Type the directories related to the Domino Data directory.
Click Save & Close.

Set the Memory Size for Scanning

Use the Scan Memory tab to set the size of memory, which ScanMail tasks allocate to

scan files in memory.

Use the following guidelines as a starting point to determine the appropriate memory

for memory-based scanning:

Dedicate the amount of memory that is adequate for most messages and document
attachments in your environment.

If you find that 90% of attachments in your organization are below 2-MB, you can
allocate only 2-MB to each memory-based scanning task. Do not use the average
message size for this sizing as you will not get optimal results.

If your organization is limiting the maximum attachment size, you can use this value.
Compressed files must be decompressed before scanning.

Dedicate an appropriate amount of memory for the decompressed files, not the
compressed attachments.

Consider the total amount of memory that will be used by all ScanMail tasks on the
Domino server.

For example, if you are running three SMDreal tasks with 5-MB dedicated memory,
ScanMail is using 15-MB of memory. At the time of scheduled scans (SMDdbs), you
must also add this memory to the total amount.

Check the size and utilization of memory on the Domino server (refer to the
Domino documentation for more information on how to determine memory
utilization.
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In memory starved environments, the negative impact of dedicating memory for
ScanMail will be far greater than the performance improvement of memory-based
scanning,

For most organizations, the default value of 5-MB for each ScanMail task is suitable.

To set scan memory size:

1.

Create or modify a server settings rule (see Creating a Server Setting Rule on page 5-3)
or (Modifying a Server Settings Rule on page 5-4).

From the working area, click the Scan Memory tab.

For each scan type, type an integer that corresponds to the memory size in
megabytes (MB).

Click Save & Close.

Configure the Proxy Server Settings

Use the Proxy Settings tab to configure the proxy server used for Web Reputation, CM
Agent, component download and product activation.

Note:  You can specify another proxy server for CM Agent or component download in the

scheduled update or manual update document. See Defining the Proxy Server Settings
Jfor Component Download on page 6-11.

To configure the proxy server settings:

1.

e AT A o

Create or modify a server settings rule (see Creating a Server Setting Rule on page 5-3)
ot (Modifying a Server Settings Rule on page 5-4).

From the working area, click the Proxy Settings tab.

Select Use a proxy server.

Select the proxy server Protocol, (for example, HTTP, Socks4, Socks5, or HTTPS).
Type the proxy server Address or host name.

Type the proxy server Port number.

Type a User name and Password used for proxy authentication.

Click Save & Close.
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Configure Local Smart Scan Sources

Use the Local Smart Scan Sources tab to configure local the smart scan source used for
Web Reputation.

To add local smart protection server filter options:

1.
2.
3.

4.

Click Server Settings to open the server settings options.
Click the Local Smart Scan Sources tab.
Click Add and choose from the following options:

*  Type the local Web Reputation server name or IP address in the Server name
or address field.

*  Type the server port in the Web Reputation Service Port field (default port is
5274).

Click Save & Close.

To edit local smart protection server options:

1.
2.
3.

4.

Click Server Settings to open the server settings options.
Click the Local Smart Scan Sources tab.
Double-click one of the available servers in the Smart Protection Server List.

*  Modify the local Web Reputation server name or IP address in the Server
name or address ficld.

*  Modify the server port in the Web Reputation Service Port field (default port
is 5274).

Click Save & Close.

To delete local smart protection server options:

1.
2.
3.
4.

Click Server Settings to open the server settings options.
Click the Local Smart Scan Sources tab.

Click Delete, select the sever, and click OK.

Click Save & Close.

To change local Web reputation server priority options:

1.
2.
3.

Click Server Settings to open the server settings options.
Click the Local Smart Scan Sources tab.

Select the server priority you want to change and click Move To Top.
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5-8

4.

Click Save & Close.

To configure notification mail:

1.

2.
3.
4

5.
6.

Click Server Settings to open the server settings options.
Click the Local Smart Scan Sources tab.
Type or choose the name of the admin user from the To field.

Select from the following to Send notification when Web reputation service
becomes:

*  Unavailable

*  Available

Use the default Subject or customize it as required.
Click Save & Close.

To configure proxy settings:

1.
2.
3.

Click Server Settings to open the server settings options.

Click the Local Smart Scan Sources tab.

Select from the following:

* Do not use proxy server

*  Use proxy server of server setting

*  Use following proxy server setting

If you chose: Use following proxy server setting:

*  Select the proxy server Protocol (HT'TP, Socks4, or Socks5).

*  Type the proxy server Address or Host name, and Port used.

*  Type the User name and Password for proxy authentication as required.

Click Save & Close.

Note: Local Web reputation does not support proxy server with HTTPS protocol.
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Monitor Server Events

Use the Event Log tab to monitor events and display or write them to the Domino

server console according to the following:

Virus found— provides information when ScanMail detects viruses and other
malware types.

New settings applied— provides information when ScanMail applies new settings
to its databases.

New components downloaded- provides information when ScanMail finishes
downloading antivirus or content security components.

New components applied— provides information when ScanMail finishes
applying/deploying components.

To monitor server events:

1.

Create or modify a server settings rule (see Creating a Server Setting Rule on page 5-3)
or (Modifying a Server Settings Rule on page 5-4).
From the working area, click the Event Log tab.

Select which Event(s) ScanMail should monitor and whether logs will be displayed
on the Domino server console.

Click Save & Close.

Enable Server Task Monitoring

Use the Task Monitoring tab to define whether ScanMail should send a notification to
administrator(s) if a task ended abnormally.

To enable server task monitoring:

1.

Create or modify a server settings rule (see Creating a Server Setting Rule on page 5-3)
ot (Modifying a Server Settings Rule on page 5-4).

From the working area, click the Task Monitoring tab.

Select Send a notification message to the administrator if a task ended
abnormally.

In the Administrator field, type or click =l t6 determine the administrator(s) you
wish to receive notification.

In the Subject and Body fields, type the appropriate information regarding the
notification message.
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6.

Click Save & Close.

Specify the Default Character Set

Use the Regional Option tab to specify the default character set that ScanMail should
use when it cannot detect the character set for disclaimers.

To insert disclaimers, see Inserting Disclaimers on page 4-63.

To specify the default character set:

1.

Create or modify a server settings rule (see Creating a Server Setting Rule on page 5-3)
ot (Modifying a Server Settings Rule on page 5-4).

On the working area, click the Regional Option tab.
Select the appropriate Default character set from the list.
Click Save & Close.

Configure Miscellaneous Settings

5-10

Use the Misc tab to configure multi-threaded scanning, trusted antivirus server(s),

warning image, and mail routing settings.

To configure miscellaneous settings:

1.

Create or modify a server settings rule (see Creating a Server Setting Rule on page 5-3)
or (Modifying a Server Settings Rule on page 5-4).
From the working area, click the Misc tab.

Under the Multi-threaded scanning group, type the integer that corresponds to
the used for mail and database scanning according to the following:

*  Number of threads for real-time mail scanning
*  Number of threads for real-time database scanning

*  Number of threads for on-demand database scanning

Tip: Set the value per scan to be between 1 and 20, inclusive. The sum of both the
real-time mail and real-time database scanning threads cannot exceed 20.

Trend Micro recommends five (5) threads per scan.

Under the Trusted Antivirus Servers group:
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*  SMTP setrvers: type the IP address(es) or server name(s) of SMPT servers

*  Domino servers: type the server name(s) or click =1 and choose from the
menu.

Note:  Verify that trusted servers have antivirus and content security protection to
prevent viruses and other malware from spreading to other Domino servers.

WARNING! A warning bitmap will NOT appear when an attachment is removed.

Under the Mail Routing group, select Do not deliver mails when the mail scan
task is not running to disable mail routing when the ScanMail real-time task is not
running;

Tip: Trend Micro recommends enabling this option. See the following Warning and
Note information:

WARNING! The ScanMail Setup enables this option by default. If the ScanMail
tasks failed to load or SMDreal was unintentionally unloaded, the
Domino server will continue to deliver messages. Messages that are
not scanned may contain viruses and other threats, which can lead to
outbreaks.

Note: When Do not deliver mails when the mail scan task is not running is
disabled and SMDreal is not yet loaded, the Domino router delivers messages
that are not yet scanned. This can lead to vitrus and other threat outbreaks.

Under the Exclude tasks group, type the Domino tasks names excluded from
real-time database scan. For example: compact; fixup; updall;
update

Tip: Use this option to help improve scanning performance.
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7. Click Save & Close.

Configuring CM Agent Settings

5-12

The communication between SMID and Control Manager uses a new protocol as SMID
no longer supports the Trend Micro Management Infrastructure (TMI) protocol used by
previous versions of SMID and Control Manager. The Control Manager Agent can be
registered after completing the SMID installation. The following describes how to
configure the CMAgent settings:

Note: CMAgent is automatically installed during the installation process.

To create or modify CM Agent Settings:

1. From the left menu, select Configuration > CM Agent Settings.
2. From the working area, click Create CMAgent Settings.

Note: To modify an existing setting, double-click the setting and click Edit on the
Control Manager settings screen.

3. Type the server name in the Applied to field, or click =] to choose.

Under the Control Manager Settings group, select Register ScanMail for IBM
Domino to Control Manager Server.

5. Under the Control Manager Server group, type the Server Address and Port
number in the appropriate fields.

6. Under the Web server authentication group, type the User name and Password
if used.

7. If a proxy server is used, under the Proxy Settings group, select Use a proxy
server to connect to the Control Manager server and choose from the following
options:

a. Use proxy server of server settings to use the proxy server configured for
Server Settings.

b. Use another proxy server to choose a proxy server different from that
configured for Server Settings as follows:
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*  Select the proxy server Protocol, (for example, HT'TP, Socks4, Socks5, or
HTTPS).

*  Type the proxy server Address or host name.
*  Type the proxy server Port number.

*  Type a User name and Password used for proxy authentication.
8. Click Save & Close.

@ Carcel #[]] Save & Close

Applied to: *[all Serverg]

Control Manager Settings

I Register Scantail for IEM Domina to Contral Manager Server

Control Manager Server

Server Address: |

For example. server.domain.com or 1231212123
Poit: 4432

W Connecting use HTTPS

WEB server authentication

Uzer name: | |

Passward: | |

Prozy Settings

[ Use a prowy server to connect to the Control Manager server

P Show change history

FIGURE 5-2. Control Manager settings screen

Configuring Deep Discovery Advisor Settings

The communication between SMID and Deep Discovery Advisor uses standard
HTTPS protocol with an API Key for authorization. This section describes how to
configure the Deep Discovery Advisor Settings in SMID.

To configure Deep Discovery Advisor:

1.  Open the ScanMail Configuration Database (see Accessing ScanMail Databases on
page 3-6).
2. From the left menu, click Configuration > Deep Discovery Advisor Settings.
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From the working area, click Create Deep Discovery Advisor.

Note: To modify an existing setting, double-click the setting and click Edit on the
Deep Discovery Advisor setting screen.

Type the server name in the Applied to field, or click =] to choose.
Select Register ScanMail for IBM Domino to Deep Discovery Advisor.

In the Deep Discovery Advisor section, type the Server Address, Port number
and API Key in the appropriate fields.

Note: If you do not have the Deep Discovery Advisor API Key, then contact your
Deep Discovery Advisor administrator to obtain the API Key.

In the Notification section, select from the following to Send notification when
Deep Discovery Advisor becomes:

*  Unavailable
*  Available
Use the default Subject or customize it as required.

If you want to use a proxy server, then under the Proxy Settings section select Use
a proxy server to connect to the Deep Discovery Advisor and then select from
the following options:

*  Use proxy server of server setting
*  Use another proxy server

If you chose: Use another proxy server, then:

*  Select the proxy server Protocol (HT'TP, Socks4, or Socks5, HT'TPS)

*  Type the proxy server Address or host name, and Port used.

*  Type the User name and Password for proxy authentication as required.
Click Save & Close.
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Managing the Filter Lists

ScanMail for IBM Domino (SMID) 5.6 uses the Filter Lists Database (smlists.nsf) to
store the filter lists, including the anti-spam approved and blocked sender lists and the
Web Reputation approved URL list. This section describes how to manage the filter lists
in the database.

To manage the filter lists:

1. Open the ScanMail Configuration Database (see Accessing ScanMail Databases on
page 3-0).
From the left menu, click Filter Lists Database to open the Filter Lists Database.

Click Web Reputation Approved URLs, Anti-spam Blocked Senders, or
Anti-spam Approved Senders.

~ TREND MICRO"ScanMail™

[T Add J.%Delete ¢4} Impart ¢ﬁ} Export

Wweb Reputaton dpproved LIRL: URLsz
Anti-spam Blocked Senders
Anti-zparm Approved Senders

FIGURE 5-3. Managing Web Reputation URLs

4. Do any of the following:
*  Click Add to add approved URLs.
*  Click Delete to delete approved URLs.
e Click Import to import approved URLs.
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*  Click Export to export approved URLs.

Note: If you click Anti-spam Blocked Senders or Anti-spam Approved Senders,
only the Add and Delete buttons are available.

Configuring the Administration Menu Options

Use the Configuration Database Administration menu to define additional ScanMail
database properties such as creating the license profile or applying a new ACL entry.

Applying the Notes Database Properties to ScanMail
Databases

The Administration > ScanMail Databases option provides shortcuts to database
properties.

Use the Configuration database to set and apply the following properties to ScanMail
databases:
*  Show in the Open Database Dialog

Enable/Disable this option to include/exclude ScanMail database in the list of
databases displayed in the Open Database dialog.

*  List in Database Catalog

Enable/Disable this option to include/exclude ScanMail databases in the Notes
Database Catalog Search.

*  Web access: Require SSL connection

Notes R8 and above supports Secure Sockets Layer (SSL) version 2.0 and above for
secure communication. Instead of using the Database Properties dialog, use the
Configuration database to enable this option to use SSL to access ScanMail
databases through the Web.

*  Replication

Select this option to enable ScanMail database replication to other servers.
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To set and apply Notes database properties to ScanMail databases:

1.

Open the ScanMail Configuration Database (see Acessing ScanMail Databases on
page 3-0).
From the left menu, click Administration > ScanMail Databases.

From the working area, type or click =1 to select Domino server(s).

Select whether to Enable, Disable, or Do not change the property for each
ScanMail database.

Click Save, and then click Apply Settings.

Note: The settings in the Configuration database overwrite the last saved settings.

Creating and Applying a New Access Control (ACL) Entry

Use the Configuration database to create and apply access control for ScanMail

databases on Domino server(s).

To create and apply a new ACL entry:

1.

Open the ScanMail Configuration database (see Accessing ScanMail Databases on page
3-6).
From the left menu, click Administration > Access Control.

From the working area, click Create New Entry.

Type or click =] to specify the ACL entry to a Domino server or groups of
Domino servers.

Select a User type from the list.
Select a ScanMail database and set the permission(s).

Click Advanced to select the access level from the list and enable read or write
public documents.

Click Save & Close; then, click Apply Settings to ACL.
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Allowing Tasks to be Viewed through the Domino
Administrator

Use the Configuration database to enable ScanMail tasks to be viewed through the
Domino Administrator.

To allow tasks to be viewed through the Domino Administrator:

1.  Open the ScanMail Configuration database (see Accessing ScanMail Databases on page
3-6).
From the left menu, click Administration > Domino Administrator.

From the working area, click Copy to domadmin.nsf.

Creating a License Profile

Use the Configuration database to create a license profile to activate a full version of
ScanMail or renew its maintenance.

To create a license profile:

1. Open the ScanMail Configuration database (see Accessing ScanMail Databases on page
3-6).

Click Administration > Product License.

From the working area, click Create License Profile.

Type or copy the SMID Activation Code on page 2-43 in the field provided.

Click Save & Close.

A O

Deleting a License Profile

Use the Configuration database to delete the license profile of an old or expired
ScanMail version.

Note: To convert a trial version to a full version, create a new license profile first before
deleting the old profile. See Convert to a Full Version on page 2-44.

5-18



Performing Administrative Tasks

To delete a license profile:

1.

2.
3.
4.

Open the ScanMail Configuration database (see Accessing ScanMail Databases on page
3-6).

Click Administration > Product License.

From the working area, select the license profile to be removed.

Click Delete License Profile.

A message displays confirming the profile deletion. Click OK to go back to the License
Profile view.

Tip: When a profile has been accidentally deleted, restore it by creating a new profile using

the Activation Code of the deleted profile.
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Chapter 6

Updating Components

ScanMail allows you to update antivirus and content security components automatically

or manually.

This chapter includes the following topics:

Understanding the Antivirus and Content Security Components on page 6-2
Updating Components on page 6-3

Confignring Update Settings on page 6-8

Loading Components Manually on page 6-11
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Understanding the Antivirus and Content
Security Components

The following ScanMail antivirus and content security components are listed according

to the frequency of recommended update:

Virus pattern file detects and cleans malicious file infections.

If a particularly damaging malware is discovered “in the wild," or actively circulating,
Trend Micro releases a new pattern file as soon as a detection routine for the threat
is available (usually within a few hours).

As virus authors and malicious content writers release new viruses to the public,
Trend Micro collects their telltale sighatures and incorporates the information into
the virus pattern file. Because new and virulent viruses are discovered every day,
Trend Micro frequently makes available new versions of the virus pattern, often 2-3
times a week depending on the need and threat-risk.

Spyware pattern detects hidden programs that secretly collect confidential
information.

IntelliTrap pattern detects viruses that attempt to circumvent virus filtering by
using real-time compression algorithms. IntelliTrap helps reduce the risk of such
viruses entering your network by blocking email attachments with real-time

compressed executable files and pairing them with other malware characteristics.

IntelliTrap exception pattern detects added exceptions to the IntelliTrap pattern.

Virus scan engine detects all virus and malwatre known to be “in the wild," or
actively circulating.

Anti-spam engine detects unsolicited commercial or bulk email messages (UCEs,
UBE's).

Anti-spam pattern detects unwanted content based on an updatable file containing
spam definitions.

The 32/64-bit, multi-threaded scan engine checks files in real-time using the process
called pattern matching. The virus scan engine also employs a number of heuristic
scanning technologies that even allows it to detect new viruses, not yet seen in the
wild. In addition to viruses, the scan engine protects against mass mailing worms,
macro and polymorphic viruses, Trojans, and Distributed Denial of Service (DDoS)
attacks.

URL filtering engine detects dangerous or unwanted URLs contained in email.
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The scan engine includes an automatic clean-up routine for old virus pattern files, to
help manage disk space. It also features incremental pattern updates to help manage
bandwidth.

The Advanced Threat Scan Engine detects files for less conventional threats,
including document exploits.

The ScanMail application refers to product specific components (for example,
Service Pack releases).

Tip:

Trend Micro recommends updating the antivirus and content security components to
remain protected against the latest virus and malware threats.

However, only registered users are eligible for components update. For more
information, see Registering and Activating SMID on page 2-42.

Updating Components

There are two ways to update the ScanMail components:

Manually

Automatically

Updating Components Manually

Use Update Now in the Configuration Database to run a manual update.

To update components manually:

1.

AR S

Open the ScanMail Configuration Database (see Accessing ScanMail Databases on
page 3-0).

From the left menu, click Actions > Manual Update.

From the working area, click Edit.

Under the Update Components group, select which component(s) to update.

Under the Options group, select the appropriate options for Component update,
and Download components for platforms.

Click the Source tab.
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10.
11.

12.
13.

Under the Update Source group, select the appropriate options.
Click the Proxy Settings tab.

Under the Proxy Settings group, configure the proxy server settings for
component download.

Click the Notifications tab.

Under the Notify administrator group, define the notification settings as
appropriate.

Click Save to save the manual update settings.

Click Update Now.

@ cancel *+[] save (2 Update Now

Components I Source | Proxy Settings | Notifications

Update Components

¥ Virus scan engine

¥ Virus pattem file

¥ Advanced Threat Scan Engine

¥ Spyware pattem

¥ InteliTrap pattem

¥ IntelliTrap exception pattem

[V Arti-spam engine

V¥ Arti-spam pattem

¥ URL fitering engine

™ ScanMail Application

Options:

Component update " Download only
& Download and apply

Download components for platforms ¥ Windows 32bits [ Linux 64bits
I Windows 64btss ™ Solaris
[ AlX 32bits ™ 05/390
T AiX 64bits [T Linuse z5enies 32bits
[T As/400 I™ zLinux Bdbits
™ Linux 32bits

p  Show change history

FIGURE 6-1.  Click Update Now to download the latest antivirus and
content security components.



Updating Components

Updating Components Automatically Using Scheduled
Update Rules

Create scheduled update rules to update components automatically. Scheduled update

rules define how ScanMail downloads the latest components at a specific time.

To update components automatically:

1.

Create or modify a policy (see Creating Policies on page 4-3) or (Modifying Policies on
page 4-5).

Click Configuration > Policies > Edit/Create New Policy > Scheduled
Update tab.

Select Enable scheduled update.

Set which components to deploy automatically (see Deploy Specific Components
Automatically on page 6-7).

Click Create New Rule.

On the New Scheduled Update Rule document, specify the general settings on
the General tab:

*  Under the Rule Identifier group, specify the scheduled update name in the
Name field.

*  Under the Apply To group, select All server(s) of the parent policy or select
Specified server, and click =l to choose server(s) from the list.

Click the Components tab.
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6-6

8.

10.

11.

12.

13.
14.

Under the Update Components group, select which components to update.
@ cancel *0] Save & Close |- -| Schedule Replication
[ Enable scheduled update e
General | Components I Source I Proxy Settings | Notifications | Update Schedule
Update Components
[V Virus scan engine
[¥! Virus pattem file
¥ Advanced Threat Scan Engine
¥ Spyware pattem
¥ Inteli Trap pattem
IV Inteli Trap exception pattem
[V Anti-spam engine
[ Anti-spam pattem
[¥ URL fitering engine
™7 SeanMail Application
Options:
Retain pattem file history: ©3  pattem files
Retain scan engine history: 2. scan engines
Component update ' Download only
& Download and apply
Download companents for platforms ¥ Windows 32bitss I Linux 84bits
[ Windows 64bits I Selaris
™ AlX 32bits ™ 05/390
I AIX 8dbits I™ Linux zSeries 32bits
[ Asz400 I zLinux 64bits
™ Linux 32bits
FIGURE 6-2. Creating a scheduled update rule > defining the
components to update
Click the Source tab.
Under the Update Source group, select the appropriate options. (see Sefing the

Update Source on page 6-9).
Click the Proxy Settings tab.

Under the Proxy Settings group, configure the proxy server settings for
component download. (see Defining the Proxy Server Settings for Component Download on
page 6-11).

Click the Notifications tab.

Under the Notify administrator group, define the notification settings as
appropriate (see Setting the Update Notifications on page 7-8).

Note:  ScanMail sends scheduled update rule notifications to the email address(es) set in
the policy Notifications tab.
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15.

16.

17.

Click the Update Schedule tab to set the Run at times, Repeat interval of, and
Days of the week when the scheduled update should occur.

Click Schedule Replication in the work area to launch the Notes Address Book
and configure the schedule replication (refer to the Setting options on the Replicator
topic in the Notes Help).

Click Save & Close. ScanMail updates components based on the schedule.

Deploy Specific Components Automatically

Depending on the Update Source and download options, ScanMail can deploy all the

latest available components automatically. To instruct ScanMail to deploy only specific

components, select Enable component deployment and set components to deploy.
ScanMail downloads and deploys the latest components as follows:

1.

ScanMail checks for and downloads the latest components from the Update
Source.

If updated components are available, ScanMail downloads these components to the
Update Database.

ScanMail deploys the latest components from the Update Database to the servers
specified in the Apply To General setting.

To deploy specific components automatically:

1.

Create or modify a policy (see Creating Policies on page 4-3) or (Modifying Policies on
page 4-5).

Click Configuration > Policies > Edit/Create New Policy > Scheduled
Update tab.

Select Enable component deployment, and then click Configure.

From the Component Deployment Configuration window, under the Deploy
Components group, select which component(s) you want to deploy automatically.

Under the Options group, type values in the Retain pattern file history: ["'x"
pattern files] and Retain scan engine history: ["'x" scan engines] fields to
indicate the number of pattern files and scan engines ScanMail will save.
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Note: Because virus pattern and scan engine files can take up disk space, Trend Micro
recommends keeping three (3) previous pattern file and two (2) previous scan
engine versions on hand (in addition to the cutrrent version). As subsequent
pattern file or scan engine updates occur, the oldest component is deleted for
each new one added.

Click OK to close the window.
Click Save & Close to apply the deployment settings.

Configuring Update Settings

Update settings include the configuration of:
*  Components to update
*  Update source

*  Proxy server for component download

Selecting Components to Update

Use the Components tab to select which components to update.
To select components to download:

1. From the schedule update rule or manual update document, click the Components
tab to set which components to download (see Automatically on page 6-3) or
(Manually on page 6-3).

Under the Update Components group, select the components to download.
Under the Options group, type values in the Retain pattern file history ["x"
pattern files] and Retain scan engine history [''x" scan engines] fields to
indicate the number of files ScanMail will save.
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5.
6.

Note:

Because pattern files and scan engine can take up disk space, Trend Micro
recommends keeping three (3) previous pattern file and two (2) previous scan
engine versions on hand (in addition to the cutrrent version). As subsequent
pattern file or scan engine updates occur, the oldest component is deleted for
each new one added.

Under Component update, select how ScanMail applies the program update:
Download only or Download and apply.

Tip:

Use care when applying these options alternately. If you use the Download only
option, and then run an update, the latest component will be downloaded to the
Update Database. If you then decided to change the setting to Download and
apply, ScanMail will not download any components because the ones in the
Update Database are already the latest. This prevents ScanMail from applying
the latest components to the servers in the Apply To General setting. In this
case, use Replicated database as the Update Source to download and apply
the latest components to other servers.

Select the appropriate options from Download components for platforms.
Click Save and Close.

Setting the Update Source

Use the Source tab to set which components to download.

To set the update source:

1.

From the scheduled update rule or manual update document, click the Source tab

to select one of the following update sources (see Awutomatically on page 6-3) or
(Manually on page 6-3):

*  Replicated database— ScanMail servers automatically replicate (pull) the new
pattern files from the central ScanMail server.

In this model, a hub ScanMail server downloads the new updates and then all

spoke ScanMail servers automatically pull the updates from the hub server.

Even if Download only is set, ScanMail will still deploy (that is, apply)
components to the spoke servets.
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2.

Note:  IBM Domino does not replicate the Update Database automatically. Create
a connection document in the Domino directory and specify the direction
of the replication and the central server, which will download the
components from the ActiveUpdate server.

ActiveUpdate server— ScanMail servers automatically download the latest
component from the Trend Micro ActiveUpdate server.

Note: By default, ScanMail implements digital signature checking whenever it
downloads components from the Trend Micro ActiveUpdate server. The
signature files (* . s19) ensures secure component download from the
Trend Micro ActiveUpdate server.

Using the ActiveUpdate server is the simplest way to update components. In a
multi-server environment, you can configure every ScanMail server to
independently poll for component updates using ActiveUpdate, or designate a
single ScanMail server to act as a hub server for downloading updates and then
have your spoke ScanMail servers pull in the update using replication.

Tip: See Update Issues starting on page 11-3 to troubleshoot update issues.

Other Internet source— ScanMail servers can download the pattern file and
scan engine from another non-Trend Micro Web site (for example, your local
Intranet Web site)

Type the URL or UNC path of your own "ActiveUpdate" server in the
Address field.

Note:  The UNC source only applies to ScanMail for IBM Domino for Windows.
Updating from another source requires having the corresponding signature
files (* . sig) saved in the location where the latest components are
located. Otherwise, the absence of the * . sig file will lead to an
unsuccessful update.

Click Save & Close.
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Defining the Proxy Server Settings for Component
Download

Use the Proxy Settings tab if the ScanMail server needs a proxy server to access the
Internet.

To define proxy server settings:

1.

From the schedule update rule or manual update document, click the Proxy
Settings tab.

Under the Proxy Settings group, select Use Proxy if connecting to the Internet
requires a proxy server.

Select whether to Use proxy server of Server Settings or Use another proxy
servet.

If using another proxy server, select the proxy server Protocol, and:
a. Specify the proxy server Address or Host name, and Port used.
b. Type the User name and Password used for proxy authentication.

Click Save & Close.

Loading Components Manually

If for some reason a Domino server is not able to update the ScanMail components via

the Web or replicate from other servers due to network restrictions or network

configuration errors (for example, intermittent network connection), use the Update

Database to load components manually.

Note: Trend Micro recommends trying the automatic methods before attempting to load a

component manually. If the automatic methods fail, first open the ScanMail
configuration database and go to Actions > Manual Update > Source and verify
you have selected Replicated database as the manual update source.

To load the latest virus pattern file:

1.

Locate the latest virus pattern file and number from the activeupdate
server.ini fileat:
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A A A

Open the file, and locate the latest zip file name for the virus pattern: for example:
vsapi945.zip.
Combine the appropriate path and filename information to the following URL

according to the latest pattern file; for example:

http://smid56-p.activeupdate.trendmicro.com/activeupdate/pat
tern/vsapi945.zip

Open the ScanMail Update Database (see Accessing ScanMail Databases on page 3-6
or Accessing other ScanMail Databases through the Configuration Database on page 3-10).

On the left menu, click Virus Pattern File.

On the working area, click Edit.

Modify the Pattern version.

Attach the latest version pattern file to the Pattern file field.
Click Save & Close.

Load SMDupd at the Domino server console:

load SMDupd -realtime

Note: When manually loading a Controlled Pattern Release (CPR), the Status Summary
screen may not reflect the latest pattern file version. As a workaround, unload
SMDreal, load the CPR, and then reload SMDreal.

WARNING! Unloading SMDreal leaves the Domino environment temporarily
unprotected.

To load the latest spyware patterns:

1.

Locate the latest spyware pattern file name and number from the activeupdate
server.ini file at:

Open the file, and locate the latest zip file name for the spyware pattern: for
example: ssaptn.zip.

Combine the appropriate path and filename information to the following URL
according to the latest pattern file; for example:


http://smid56-p.activeupdate.trendmicro.com/activeupdate/pattern/vsapi945.zip
http://smid56-p.activeupdate.trendmicro.com/activeupdate/server.ini

Updating Components

or Accessing other ScanMail Databases through the Configuration Database on page 3-10).

On the left menu, click Spyware Pattern.

On the working area, click Edit.

Modify the Spyware Pattern version.

Attach the latest spyware pattern file to the Spyware pattern field.
Click Save & Close.

Load SMDupd at the Domino servet console:

load SMDupd -realtime

To load the latest anti-spam pattern:

1.

o

2 e N

Locate the latest anti-spam pattern version number from the activeupdate
server.ini fileat:

Open the file, and locate the latest zip file name for the anti-spam pattern: for
example: 1as9899.zip.

Combine the appropriate path and filename information to the following URL
according to the latest pattern file; for example:

Download, save, and extract the content(s) of the zip file to a temporary directory.

Open the ScanMail Update Database (see Accessing ScanMail Databases on page 3-6
or Accessing other ScanMail Databases through the Configuration Database on page 3-10).

On the left menu, click Anti-spam Pattern.

On the working area, click Edit.

Attach the latest version to the Anti-spam pattern field.
Update the Anti-spam pattern version.

Click Save & Close.

Load SMDupd at the Domino server console:

load SMDupd -realtime
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To load the latest anti-spam engine:

1.

10.
11.
12.

Locate the latest anti-spam engine version number from the activeupdate
server.ini file at:

Open the file, and locate the latest zip file name for the anti-spam engine: for
example: tmaseng.zip.

Combine the appropriate path and filename information to the following URL
according to the latest pattern file; for example:

Download, save, and extract the content(s) of tmaseng. zip to a temporary
directory.

Open the ScanMail Update Database (see Accessing ScanMail Databases on page 3-6
ot Accessing other ScanMail Databases through the Configuration Database on page 3-10).

On the left menu, click Anti-spam Engine.

On the working area, double-click the corresponding platform for the anti-spam
engine.

On the Spam Engine Database document, click Edit.

Attach the latest version to the Anti-spam engine field.

Update the Anti-spam engine version.

Click Save & Close.

Load SMDupd at the Domino server console:

load SMDupd -realtime

To load the latest Intellitrap pattern file:

1.

Locate the latest IntelliTrap pattern version number from the activeupdate
server.ini fileat:

Open the file, and locate the latest zip file name for IntelliTrap: for example:
tmblack. zip.

Combine the appropriate path and filename information to the following URL
according to the latest pattern file; for example:

http://smid56-p.activeupdate.trendmicro.com/activeupdate/pattern/tmblack.zi


http://smid56-p.activeupdate.trendmicro.com/activeupdate/server.ini
http://smid56-p.activeupdate.trendmicro.com/activeupdate/server.ini
http://smid56-p.activeupdate.trendmicro.com/activeupdate/antispam/tmaseng.zip
http://smid56-p.activeupdate.trendmicro.com/activeupdate/pattern/tmblack.zip

Updating Components

o

$ @ a

Save and extract the content(s) of the zip file to a temporary directory.

Open the ScanMail Update Database (see Accessing ScanMail Databases on page 3-6
or Accessing other ScanMail Databases through the Configuration Database on page 3-10).

On the left menu, click IntelliTrap Pattern.

On the working area, click Edit.

Attach the latest version to the IntelliTrap pattern ficld.
Update the IntelliTrap pattern number.

Click Save & Close.

Load SMDupd at the Domino server console:

load SMDupd -realtime

To load the latest Intellitrap exception pattern file:

1.

o

2 e N

Locate the latest IntelliTrap exception pattern version number from the
activeupdate server. ini file at:

Open the file, and locate the latest zip file name for IntelliTrap: for example:
tmwhite.zip.

Combine the appropriate path and filename information to the following URL
according to the latest pattern file; for example:

Save and extract the content(s) of the zip file to a temporary directory.

Open the ScanMail Update Database (see Accessing ScanMail Databases on page 3-6
or Accessing other ScanMail Databases through the Configuration Database on page 3-10).

On the left menu, click IntelliTrap Exception.

On the working area, click Edit.

Attach the latest version to the IntelliTrap Exception pattern field.
Update the IntelliTrap Exception pattern number.

Click Save & Close.

Load SMDupd at the Domino server console:

load SMDupd -realtime
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To load the latest scan engine:

1.
2.

Download the latest scan engine from www . trendmicro. com.

Check the Domino server console to determine if there is no scheduled scan
running;

Extract the engine under the Domino directory (for example, ¢ : \IBM\Domino).

Open the ScanMail Update Database (see Accessing ScanMail Databases on page 3-6
or Accessing other ScanMail Databases through the Configuration Database on page 3-10).

On the left menu, click Virus Scan Engine.

On the working area, double-click the corresponding platform for the scan engine.
On the Scan Engine document, click Edit.

Update the Scan engine version.

Attach the latest version to the scan engine field at the bottom of the screen.
Click Save & Close.

Load SMDupd at the Domino server console:

load SMDupd -realtime

To load the ScanMail database templates:

1.

2.

Using Windows Explorer, navigate to the Domino directory where you installed
ScanMail.

Overwrite the old ScanMail database templates with the latest versions.

Note: If the Anti-spam Engine, Scan Engine, or Application document becomes cotrrupted,

delete and then replace the corrupted document by using Add Anti-spam Engine,
Add Scan Engine, or Add Application, respectively.
Contact Trend Micro Support for details.
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Chapter 7

Sending ScanMail for IBM Domino
Notifications

When ScanMail detects a virus or other threat infection in a mail, attachment, or
document, ScanMail can automatically alert, by email or IBM Instant Messaging and
Web Conferencing, the persons you designate. For example, the Domino administrator
or other individuals who need to know when infected files are found, the sender, and/or
the recipient(s).

This chapter includes the following topics:

*  Understanding ScanMail Notifications on page 7-2

*  Using Email Stamps (Safe Stamps) on page 7-5

o Setting ScanMail Notifications on page 7-6
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Understanding ScanMail Notifications

Whenever ScanMail discovers a malware in a message or database, it can automatically
notify whomever you specify: a Domino administrator, an internal or external sender, an
internal or external recipient, a database owner, or other Internet mail addresses or

members of the Address book.

Note: Use the notification of external senders with caution as it may contribute to the
problem of spam.

SMID has the following notification categories:

*  Scan notifications are sent whenever a message or database triggers a mail scan,
database scan, or scheduled scan rule.

*  Update notifications are sent whenever ScanMail performs scheduled update or you
run manual update.

*  Web Reputation server status notification

ScanMail sends a separate notification to an administrator, sendet, or recipient
(recipient's notification is merged to the original message if Domino can send the
original message to the recipient).

The notification message can include event-specific information based on tags you set.
For example, a scan notification can include the malware name, action ScanMail took,
and name of the infected file.
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Customizing Notifications

ScanMail uses two types of notification tags:

Filter-based tags atre available in Scan Options tabs.

Use the following tags to customize filter notifications:

SCcAN OPTIONS TAGSs RETURNS WHAT
Security Risk %FILE% File name of the infected file
Scan %DETECTION% Name of the malware detected
%ACTION% Scan action

APT Prevention %FILE% File name of the infected file

Filter %DETECTION% Name of the malware detected
%ACTION% Scan action

Scan Restrictions | %FILE% File name of the infected file
%CAUSE% Matching scan restriction option
%ACTION% Scan action

Message Filter %CAUSE% Matching message filter option
%ACTION% Filter action

Attachment Filter %FILE% File name of the infected attachment
%CAUSE% Matching attachment filter option
%ACTION% Filter action

Content Filter

%CONTENT_FILTER _
NAME%

Matching content filter

%MAILPART % Message part that matches the con-
tent filter: Header, message body, or
attachment

%ACTION% Filter action

Script Filter

%FORM_PART%

Message part that matches the script
filter

%KEYWORDS%

Matching keyword(s)

Data Loss Preven-
tion Filter

%DLP_FILTER_NAME
%

Matching data loss prevention filter

%MAILPART % Message part that matches the con-
tent filter: Header, message body, or
attachment

%ACTION% Filter action
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Rule-based tags are used by ScanMail rules.

Use the following tags to customize the notification template used by mail, database,

or scheduled scans, and scheduled update rules.

TAGS RETURNS WHAT
%DATABASE% Database name
%version% Pattern/Engine version
%SERVER% Domino/ScanMail server
%SENDER% Sender of the message that matched a scan rule
%RECIPIENTS% Recipient(s) of the message that matched a scan rule
%SUBJECT% Subject header of the message that matched a scan rule

%SEND_TIME%

Time (in hh:mm format) when the message was sent

%FINAL_ACTION%

Final scan/Filter action taken

%MATCHING_FILTER%

Matching filter

%SCAN_TIME%

Time (in hh:mm format) when ScanMail scanned a mes-
sage

%PRODUCTVERION% ScanMail for IBM Domino version
%PATTERNVERSION% Virus pattern file version
%SCANENGINEVERSION% | Scan engine version
%RULENAME% Rule name

%RULENUMBER% Rule priority

%ADMIN_FILTER_INFORMA
TION%

Consolidates selected filter-based tags () for notifications
sent to administrators

%OWNER_FILTER_INFORM
ATION%

Consolidates selected filter-based tags for notifications
sent to database owners

%INTERNAL_FILTER_INFO
RMATION%

Consolidates selected filter-based tags for notifications
sent to senders or recipients belonging to the Domino
address book

%EXTERNAL_FILTER_INFO
RMATION%

Consolidates selected filter-based tags for notifications
sent to senders or recipients not belonging to the Domino
address book

%0S%

Platform (for example, Windows)

%COMPONENT%

Antivirus or content security component
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Note: A Notification Template consolidates the specified filter-based tags and then

uses the policy notification settings to deliver notification (see Defining How

ScanMail Delivers Notifications on page 7-6). Do not insert characters such as <<

and >> in the Notification Template as these characters will result in a parsing

error and the content contained within these characters will not display in the

notification.

Using Email Stamps (Safe Stamps)

Aside from ScanMail notifications, defining email stamps is another way to immediately

notify users of any ScanMail action.

Email stamps ate appended in the Subject header as regular texts. You can customize the

subject header of a message, for example:

[ScanMail Stamp] ScanMail found this email to be virus-free.

Depending on the Scan Options tab available in a scan or update rule, you can define

email stamps as part of the message subject or body:

ScAN OPTIONS TAB

AVAILABLE EMAIL STAMP

Security Risk Scan

You can:
*  Insert warning to the original mail if
a security risk is detected

*  Insert message to the original mail if
mail is malware-free

Insert email stamps at the end of the subject
header or message body.

APT Prevention Filter

You can Insert the stamp as a subject prefix.

Scan Restrictions

You can Insert the stamp as a subject prefix.

Message Filter

You can Insert the stamp as a subject suffix.

Attachment Filter

You can Insert the stamp as a subject suffix.
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ScAN OPTIONS TAB AVAILABLE EMAIL STAMP

Script Filter Insert email stamps at the end of the subject
header or at the beginning of the message body.

You can also replace hotspots with email stamps
as hotspots.

Check the following links to define safe stamps for applicable filters:

Spam filter stamp, see page 4-27

Web Reputation stamp, see page 4-27
Security Risk Scan stamp, see page 4-44
APT Prevention Filter stamp, see page 4-45
Scan Restrictions stamp, see page 4-46
Message Filter stamp, see page 4-47
Attachment Filter stamp, see page 4-51
Script Filter stamp, see page 4-61

Setting ScanMail Notifications

Configure ScanMail to send notifications whenever it detects threats or unwanted

contents, or when it updates antivirus or content security components to the latest

version.

Refer to the next sections for details on how to set ScanMail notifications.

Defining How ScanMail Delivers Notifications

ScanMail can send notification through email or IBM Instant Messaging and Web
Conferencing. Use the Notifications tab to define the medium that ScanMail uses to
deliver notifications. ScanMail can also send the notifications to the Windows Event

7-6

Logs.

To define how ScanMail delivers notifications:

1.

2.

Create or modify a policy (see Creating Policies on page 4-3) or (Modifying Policies on
page 4-5).

From the working area, click the Notifications tab.



Sending ScanMail for IBM Domino Notifications

3. Double-click the document or click Edit to configure the following settings:

a.  Under the Settings group, click =l or type the address in the Return address
field.

b. Type the Sametime setver DNS/IP address to instruct ScanMail to send
notification to an IBM Instant Messaging and Web Conferencing account.

c. Type the Sametime sender user name for the account.
d. Type the Sametime sender password for the account.

e. Under the Administrator group, select Set recipients for each filter to send
notifications to various email and IBM Instant Messaging and Web
Conferencing recipient(s) when a message matches a filter setting. Otherwise,
ScanMail will only send notifications to the Administrator's email address(es)
and IBM Instant Messaging and Web Conferencing account(s).

4. Click Save & Close.

Configuring ScanMail for Windows Event Logs

You can configure ScanMail to write the notifications to the Application category in the
Windows Event Logs.

To configure ScanMail to deliver the notifications to Windows Event Logs:

*  Open the Domino console, and type the following command:
set config SMDWriteOSEventLog=1

Note: If you modify the notes. ini file using a text editor, you must restart the Domino
server for the changes to take effect.
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Setting the Scan Notifications

Use the Notification Template tab to define the contents of ScanMail notifications.
Define notification templates for each rule.

To set the scan notifications:
1. From a mail, database, or scheduled scan rule, click the Notification Template tab.

2. Click Add >> to include tags for the Administrator, Internal sender and
recipient(s), and External sender and recipient(s) notifications.

Note:  ScanMail sends administrator notifications to email address(es) set in the policy
Notifications tab (see Defining How ScanMail Delivers Notifications on page 7-6).

ScanMail allocates “n/a” as values for the antivirus and content security vatiables
in some scan notifications. When a component has an “n/a” value, this means
that the filter did not use such component during a database or message
scanning. For example, the Attachment Filter neither uses the scan engine nor
virus pattern file when filtering messages. Therefore, when a message matches an
Attachment Filter setting and you have set a scan notification with
%PATTERNVERSION%, “n/a” becomes the value for this variable.

3. Click Save & Close.

Setting the Update Notifications

Use the Notifications tab to instruct ScanMail to send a notification whenever it
updates a component.

To set the update notifications:

1.  From the schedule update rule or manual update document, click the Notification
tab (see Updating Components Automatically Using Scheduted Update Rules on page 6-5 or
Updating Components Manually on page 6-3).

2. Type or click = to select the recipient(s) of the update notification in the
Administrator field.

3. Select the component(s) that when updated, will trigger ScanMail to send the
update notification:
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*  Select the antivirus or content security component(s) (see Understanding the
Antivirus and Content Security Components on page 6-2).

*  Seclect Update has been unsuccessful to trigger ScanMail to send a

notification when it cannot update the component selected.

Type the Number of attempts that ScanMail will try to download the
component. ScanMail will send a notification if it has exceeded the number of
attempts.

Note:  ScanMail allots 120 seconds duration per attempt.

4. Type the message content in the Subject field for the update notification.
5. Click Save & Close.
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Chapter 8

Using the Log and Quarantine
Databases

This chapter covers viewing and deleting ScanMail virus and quarantine logs, and
provides information on generating virus statistics.

Topics included are:

*  Using the Log Database on page 8-2

*  Using the Quarantine Database on page 8-13

*  Understanding Deep Discovery Advisor Quarantine Database on page 8-19
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Using the Log Database

ScanMail keeps a log of all its activities and writes them to the Log Database
(smvlog.nsf).

Logs represent a valuable source of system information. Examine all (or selected) log
entries to learn what type of malware ScanMail detected in messages, shared databases,

and replication transactions.

Depending on the volume of traffic a server handles and the number of malware it
encounters, the Log Database may grow quite large. Delete logs manually or schedule
ScanMail to delete logs automatically.

You can view Mail Scan Logs and Database Scan Logs by selecting from the ScanMail
Log Database left menu.

—
«> TREND MICRO™ScanMail™ Close || Hel = -
Mail Sean Logs Log Database
Database Scan Logs
Log Query Logs

Lo MEReED Seantdal for IBM Dormino keeps a running log of llts activities: New logs are created daiy and represent a valuable source of system
Statistics information.

vvw

Statistics

Stafistics provides Witus Charting, Server Chaiting, Distabase: Charting and User Charting. Each of these charts shows the " Top Ten™
numbe; of incidents referenced by vinss, sender of database.

Winus Log Statistics provides you wih reports of scanning activity over time. It lngs activities such as makware, enciypted, and script
bomb scanning. as wel as content fikering.

FIGURE 8-1. ScanMail Log Database main screen

An aggregate view of ScanMail activity is available in the Statistics screen.
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Note:

In a multi-server environment, you may prefer to have a single, central server that

consolidates logs from all the ScanMail servers. Trend Micto recommends setting up

pull-only replications from the peripheral servers to the central Domino server.

Accessing Trend Micro Threat Connect Portal

Threat Connect is a cloud based service powered by Trend Micro global intelligence

network, designed to enrich Trend customers with relevant and actionable intelligence.

In this version, you can access the Trend Micro Threat Connect portal by clicking

Detail link in the virus log to get the latest information about the threat. By associating

the threat with Trend Micro global threat intelligence, you will be able to take proper

actions relevant to the attack profile.

@ Close

Rule number:
Rule description:
Matching policy:

Date scanned:
Virus:

File:

Motes UNID:
Sender:
Recipient:
Filter:
Engine:
Action:
Scanner:
Server:

FIGURE 8-2. SMID Virus Log

1
Default bMail Szan
Default

05730020132 14:42:09
ExPL_ARTIEF.C Detajl
23244857 docl-
BFE10CA141713670D48257B7BO024ABEC
jun Sjuni@=ing.com>

zdh=in <zdhxin@gmail.com>
Security Rizk Scan Filter
Advanced Threat Scan Engine
Block

StADreal

CH=zmid/O=srmid

8-3



Trend Micro™ ScanMail™ for IBM Domino™ Administrator's Guide

%, IREND. Threat Connect @

Threat Connect is your source for relevant and threat L i obiects in your network through correlated threat data from the Trend Micro
global intelligence network

Query origin ScanMail For IBM Domino

Query objects @ EXPL_ARTIEF.C (Detection name) Show details

Threat Web z

Threat Web displays relationships between objects in your detection and global threats analyzed by Trend Micro in a controlled envirenment

Show connections 1o EXPL_ARTIEF.C

EXPL_ARTIEF.C
Malware

Taiwan, China, Brazil
A Technology, Communication and
Media

A Trojan horse program is a mahware that is not capable of
automatically spreading 1o other systems
EXPL_ARTIEF.C
~ lly downloaded from the Intemet and

ARTIEF

s
typically carry payloads or other m us actions
range from 1 dly annoying to the iireparably
Iso modify system seftings to
ly start. Restoring affected systems may require
ures other than scanning with an anfivirus program.
[ Export connection list

Relevant Threat Information

‘Gain more insight from the following reports, which are displayed according 1o their relevance to your query objects. | Add fiter =Y
1 EXPL_ARTIEF.C View report
Detection name: EXPL_ARTIEF.C N
Size 108400 bytes Distribution
View report L

FIGURE 8-3. Virus details on the Threat Connect portal

Managing ScanMail Logs

The ScanMail Log Database provides options that allow you to set the number of days
to keep virus logs, schedule regular log maintenance, manually delete virus and
quarantine logs, or set up a log replication connection to replicate your virus logs to a
hub server.

Use the ScanMail Log Database to access and view ScanMail logs.
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Searching for Logs

Use the Log database to search for logs by configurable search conditions.
To configure a log search task:

1. Do one of the following to open the Log database:
*  From the ScanMail Configuration left menu, click Log Database.
* Open smvlog.nsf.

2. Choose Log Query > Search.

I MNotification I

Search Status

Status: MNone

Condition Setting

Field Dperator Value

Action vl containg 2dd
Fiemove |

Preview

[Action] COMTAINS
Add ta Condition List

Condition List

The relationship between the listed conditions is "AND"

Femove |
Remove all |

FIGURE 8-4. Setting Search conditions

3. On the Search Condition tab page, set the search conditions:
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*  Search Status section: shows the status of a search task, including None, Task
running, and Task finished.

*  Condition Setting section: adds conditions to the condition list.

To add a condition, select a field option, type a value, click Add to add the
value, and then click Add to Condition List.

¢ Condition List section: lists the conditions set for the current search.

To remove a condition, select the condition from the condition list and click
Remove. To remove all existing conditions, click Remove All

4. On the Notification tab page, enable mail notification.

a. Select the Notify the administrator when the search is completed check
box.

b. Select recipients for the notification mail.
c. Type the subject and content for the notification mail.

Search Condiion | Notification

Notification

[~ Matify the administrator when the search is completed

Recipiants: F =
Subject: T SMID Log Search Completed.
Motification content; ol can view the search results by navigating bo Log Guerny

» Search » Check Results,

FIGURE 8-5. Enabling mail notification

To search for logs:

1. On the action bar, click Search.

2. Click Refresh to check whether the search is completed.

3. When the search is completed, click Check Results to view search results.

To clear the results, click Clear Results.
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Note: The log search function allows you to run only one search task at a time. That is, if a

task is running, another task cannot start. When you start a second task, the search

results for the previous task will be removed automatically.

Enabling/Disabling Log Deletion

Use the Log database to enable or disable log deletion. When a log is enabled for
deletion, ScanMail can delete it automatically.

To delete logs automatically:

1. Do one of the following to open the Log database:
*  From the ScanMail Configuration left menu, click Log Database.
* Open smvlog.nsf.

2. Select which logs you want to enable or disable for deletion.

3. Click Enable Log Deletion or Disable Log Deletion.

FIGURE 8-6. Enabling/disabling log deletion from the Log database

TREND MICRO™ScanMail™
/™) Enabls Log Deletion ™| Disabls Log Delstion
Mail Scan Lags Sender | Date Time Filename Action [ [ Recipier
Database Sean Logs ~ autoserver]32/smid 47

P Log Guerr ¥ admin/smid 47

P Log Maintenanes T4/127201 BEEILE el doc. Tusrarin P

P Statistics 0412/2013 133147 tesling doc. doc: Quarantine autorcpl@smid
04/12/2013 1331:47 testing da. doc: Quarartine autorept@smid
0412/2013 13:31:47 tesling doc. doc Quarantine autorcpl@smid
04/12/2013 1331:47 testing dac. doc: Quarantine autorept@smid
04112/2013 13:31:47 tesling doc. doc Quarantine autorcpl@smid
04/12/2013 1331:47 testing dac. doc: Quarantine autorept@smid
04112/2013 13:31:47 tesling doc. doc Quarantine autorcpl@smid
04/12/2013 1331:47 testing dac. doc: Quarartine autorept@smid
0412/2013 1331:47 testing doc. doc Quarantine autorcpi@smid
0412/2013 133147 tesling dor. do: Quarartine autorcpt@smid
0412/2013 1331:47 testing doc. doc Quarantine autorcpi@smid
0412/2013 133147 tesling dor. do: Quarartine autorcpt@smid
0412/2013 133147 testing do doc: Quarantine autorcpi@smid
041272013 133147 tesling doc. doc Quarartine autorcpli@smid
0412/2013 133147 testing do doc: Quarantine autorcpi@smid
041272013 133147 tesling doc. doc Quarartine autorcpli@smid
0412/2013 13:31:47 testing doc.doc: Quarantine autorcpi@smid
041272013 1331:47 tesling doc. doc Quarartine autorcpl@smid
0412/2013 13:31:47 testing doc.doc: Quarantine autorcpi@smid
041272013 1331:47 tesling doc. doc Quarartine autorcpl@smid
0412/2013 13:31:47 testing doc.doc: Quarantine autorcpi@smid
041272013 133147 tesling doc. doc Quarartine autorcpl@smid
04/12/2013 13:31:47 testing doc.doc: Quarantine autorcpt@smid
04/12/2013 133147 tesling doc. doc Quarartine autorcpl@smid
04/12/2013 13:31:47 testing doc.doc: Quarantine autorcpt@smid
04/12/2013 133147 tesling doc. doc Quarartine autorcpl@smid
04/12/2013 1231:47 testing dos.doc: Quarantine autorept@smid
0412/2013 133147 tesling doc. doc Quarartine autorcpl@smid
04/12/2013 1231:47 testing dos.doc: Quarantine autorept@smid
0412/2013 133147 tesling doc. doc Quarartine autorcpl@smid
04/12/2013 1331:47 testing da. doc: Quarantine autorept@smid
0412/2013 133147 tesling doc. doc: Quarantine autorcpl@smid
04/12/2013 1331:47 testing da. doc: Quarantine autorept@smid
0412/2013 133147 tesling doc. doc: Quarantine autorcpl@smid
04/12/2013 133147 testing da. doc: Quarantine autorept@smid
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Note: Before enabling the deletion of a number of logs, Trend Micro recommends reviewing
them to verify that they are expendable.

Deleting Virus Logs Automatically

Use the Log database to schedule ScanMail to delete virus logs older than the specified
number of days automatically. This is especially useful if a Domino server handles a large
amount of traffic.

Note: ScanMail automatically deletes logs enabled for deletion.

To delete virus logs automatically:

1. Do one of the following to open the Log Database:
*  From the ScanMail Configuration left menu, click Log Database.
* Open smvlog.nsf

2. From the left menu of the Log database, click Log Maintenance > Deletion
Settings. The Automatic / Manual Deletion Settings scteen appears (Figute 8-7).

——
TREND MICRO™ScanMail™ Cigse | 120

@ Cancel  +] Save & Close

Mail Scan Logs
Database Scan Logs
b Log Query
¥ Log Maintenance
Deletion Settings Delete log files:
Deletion Records )
b Statistics I Dslete log files after " 10 4 days

Automatic Deletion Settings

Keep " 10, deletion records

Manual Deletion

Delete Now

€ Delete all log files
' Delete selected log files

Browse.

FIGURE 8-7. Automatic / Manual Deletion settings

3. On the Automatic Deletion Settings section, select Delete log files after.
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4. Type the number of days that corresponds to the age of logs that ScanMail will
save.

5. Type the Number of deletion records that corresponds to the number of deletion
records that ScanMail will keep.

6. Click Save & Close.

Deleting Virus Logs Manually

Use the Log database to delete virus logs manually.
To delete virus logs manually:

1. Do one of the following to open the Log database:
*  From the ScanMail Configuration left menu, click Log Database.
* Open smvlog.nsf.

2. From the left menu of the Log database, click Log Maintenance > Deletion
Settings. The Automatic / Manual Deletion Settings scteen appeats (see Figure
8-7).

3.  On the Manual Deletion section, do one of the following;:

*  Seclect Delete all virus log files to delete all existing logs available on the Log
database.

*  Sclect Delete selected virus log files to delete selected logs.
i.  Click Browse to launch the Log Files window.
ii. Select which logs to delete.
iii. Click OK.
4. Click Delete Now.

Note: ScanMail only deletes virus logs that are enabled for deletion.

Viewing Statistics and Charting

The Statistics option enables you to generate a numerical summary of the email and
database virus logs on the server. It includes the aggregate number of malware cleaned,
deleted, quarantined, and passed. It also includes options to generate statistics regarding
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the results of security risk scanning, APT prevention filtering, message filtering,
attachment filtering, content filtering, script filtering, spam filtering, Web reputation,
data loss prevention filtering, outbreak prevention filtering, and redirected messages.

Generating, Viewing, and Exporting Statistics

Use the Log database to generate and view log statistics.

To generate, view, and export log statistics:

1. Do one of the following to open the Log database:

*  From the ScanMail Configuration left menu, click Log Database.
* Open smvlog.nsf.

From the left menu of the Log database, click Statistics > Log Report.
From the working area, select all statistics or a specific statistic to view.
Select which tables to show from Show table(s):

« Al

*  Security Risk Scan

*  APT Prevention Filter

*  Message Filter

* Attachment Filter

*  Content Filter

*  Data Loss Prevention Filter

*  Script Filter

*  Spam Filter

*  Web Reputation

*  Outbreak Prevention Filter

*  Redirected Messages

Select the Server(s) where the logs you want are located.

Select a Range; All, Today, Last 7 days, Last 30 days, or Specific date.

Click Calculate to begin compiling a summary report for the logs you selected.

® 3w

From the working area, click Export to export the raw data to a * . csv file.
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Note: Use an electronic spreadsheet application (for example, Microsoft Excel™) to
open *.csv files.

Using Microsoft Excel™ to View *.csv Exported Logs

Microsoft Excel displays the exported ScanMail logs in a more useful form.

To use Excel to view *.csv ScanMail exported logs:

1.

2.
3.
4

Open Microsoft Excel.
Open the exported *.csv.
Highlight the first column of data by clicking the column header.

From the main menu, choose Data > Text to columns... and follow the Wizard
that appears.

¢ Select Delimited and then click Next.

e  (lear the Tab checkbox. Choose Comma, and then for the Text Qualifier,
choose None.

*  Without making any changes in the last Wizard screen, click Finish.

Save the document as an Excel file (* . x1s) so you do not need to import and
reformat again.

Generating and Viewing Charts

The Statistics > Top 10 option allows you to generate any of the following charts in a

column layout:

Detection Chart— provides the top 10 viruses detected.

Server Chart— provides information of the top 10 servers where most infections
are detected.

User Chart— provides information of the top 10 users who sent the most viruses
via email.

Database Chart— provides information of the top 10 infected databases.

To generate and view log statistics:

1.

Do one of the following to open the L.og Database:
*  From the ScanMail Configuration left menu, click Log Database.
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¢ Open smvlog.nsf
From the Log Database left menu, click Statistics > Top 10.

From the working area, select the chart type to generate and view.

Select a date, either All or a Date Range.
Click Generate Chart.
The screen displays a column-type chart with the top ten values corresponding to

the selected chart’s total percentage count. If there are no logs in the Log database,
no data will be available in a column type chart.

[SLI NI ST N

90.0

20.0

70.0

60.0 W ME_TEST_WIRUS

0.0 W TROJ_SUBTG2ADPR

’ M EICAR_TEST_FILE

40.0 M JOKE_TEST_YIRUS
W JOKE_WOW

30.0 B TRCJ_TEST_WIRUS
W YBS_TEST_VIRUS

0.0 W DDOS_TOMOD.A

o 1 B

¥irus Number Percent

ME_TEST_WIRUS g1 35,03%

TROI_SUBTGZ4.DPR 30 14,08%

EICAR_TEST_FILE 26 12,21%

JOKE_TEST_VIRUS 17 7,98%

JORKE_W oW 17 7,958%

TROI_TEST_VIRUS 17 7,958%

FIGURE 8-8. A sample Detection Chart
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Using the Quarantine Database

The ScanMail Quarantine database (smquar .nsf) stores copies of messages
quarantined for content, malware, or spam violations.

Depending on the volume of traffic a server handles and the amount of malware
ScanMail encounters, the Quarantine database may grow quite large. If malware is
detected, ScanMail will quarantine infected emails and attachments, which are stored as a
new document in the smquar.nsf database.

“~ TREND MICRO"ScanMail™

¥ Mail Scan Quarantine Database
By Date
By Sender All the ScanMail for IBM Domine seanning tasks use the Quarantine Database (smquar nsf) for storing infected messages
51 By Rocipients and The Qi Data base items ‘toinfected, blocked,
By Filter and encrypted attachments, as well as blocked emails.
¥ Database Scan
By Date
TiBy Database
T By Filter Trend Micro recommends that you Delete or Resend quarantined items as soon as they are reviewed. When you resend
¥ Maintenance an email, ScanMail for IBM Domino scans the email using the latest scan engine and pattern. It is possible that previously
Deletion Settings uncleanable email or attachments can be cleaned

T Deletion Records

FIGURE 8-9. Quarantine Database main screen

Configure ScanMail to delete quarantined items every "x" days automatically (see Deleting
Quarantined Items Auntomatically starting on page 8-17). Alternatively, you can manually
delete quarantined items from the Quarantine database (see Deleting Quarantined Items

Manually starting on page 8-18).

Viewing Quarantined Messages, Documents and
Attachments

Use the ScanMail Quarantine database to access and view quarantined items.
To view quarantined attachments for Mail Scan:

1. Do one of the following to open the Quarantine database:
*  TFrom the Configuration database left menu, click Quarantine Database.

* Open smgquar.nsf.
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2.

From the left menu, select Mail Scan for the items you want to view according to

the following criteria:

* By Date: displays according to the date, all messages that ScanMail
quarantined.

* By Sender: displays according to the sender, all messages that ScanMail
quarantined.

* By Recipient: displays according to the recipient, all messages that ScanMail

quarantined.

* By Filter: displays according to the filter, all messages that ScanMail
quarantined.

To view quarantined attachments for Database Scan:

1.

Do one of the following to open the Quarantine database:
*  From the Configuration database left menu, click Quarantine Database.
* Open smquar.nsf.

From the left menu, select Database Scan for the items you want to view
according to the following criteria:

* By Date: displays according to the date, all messages that ScanMail
quarantined.

* By Database: displays according to the database, all messages that ScanMail

quarantined.

* By Filter: displays according to the filter, all messages that ScanMail
quarantined.

Resending Quarantined Messages

8-14

Qunarantined messages refer to messages quarantined by ScanMail Real-time Mail scan task.

ScanMail can resend quarantined messages.

To resend quarantined messages:

1.

Do one of the following to open the Quarantine database:
*  From the Configuration database left menu, click Quarantine Database.
* Open smquar.nsf.

From the Quarantine Database left menu, select Mail Scan > By Date, By
Sender, By Recipient, or By Filter.
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Select the quarantined Mail Scan message(s) you want to resend.

From the working area, click Enable Resend.

The icon B represents a message enabled for resending. If the icon ¥ is missing,
it indicates the item is disabled for resending;

Click Resend to resend a message.

Restoring Quarantined Documents

Qunarantined documents refer to documents quarantined by the ScanMail Real-time, Manual,

or Scheduled database scan task. ScanMail can restore quarantined documents.

WARNING! Use care when restoring documents. Documents containing malicious

threats may be restored and then opened, which can cause a virus out-
break.

To restore quarantined documents:

1.

Do one of the following to open the Quarantine database:

*  From the Configuration database left menu, click Quarantine Database.

* Open smquar.nsf.

From the Quarantine Database left menu, select Mail Scan or Database Scan.
*  For Mail Scan, select By Date, By Sender, or By Filter.

*  For Database Scan, select By Date, By Database, or By Filter.

From the working area, select a quarantined document; click Enable Resend, and
then click Resend.

Enabling/Disabling Quarantined Item Deletion

Use the Quarantine database to enable or disable quarantined item deletion. When an

item is enabled for deletion, ScanMail can delete it automatically.

To delete quarantined items automatically:

1.

Do one of the following to open the Quarantine Database:

*  From the Configuration database left menu, click Quarantine Database.
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* Open smquar.nsf.

2. Select the quarantined item you want to enable or disable for deletion.

3. Click Enable Deletion or Disable Deletion.

T By Filter

S—
“~ TREND MICRO"ScanMail™ Close IFeP =1 fwieEwn
| eraeeton 7 batieDeieten ) [ P —
= et gean Time To Gount Subjoct
By Date ¥ Security Risk Scan filter
By Sandar Security Risk Soan fil
TlByRecipients duninsrnld
= 0122013 03,0517 Pt
& Fiter
e et 041122013 0310347 Ph 2 I
Pl 0411202013 03,0317 M caminmid@emid st
TlByDatabase

~ Maintenance
Delotion Eetings
T Deletion Re cords.

FIGURE 8-10. Enabling/Disabling quarantined item for deletion

Note: Before enabling deletion, Trend Micro recommends reviewing documents to make

sure they are indeed expendable.
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Deleting Quarantined Items Automatically

Use the Quarantine database to schedule ScanMail to delete quarantine items older than
the specified number of days automatically. This feature is especially useful if a Domino
server handles a large amount of traffic (see Figure 8-11).

< TREND MICRO"ScanMail™ Close 170 R )
@ Cancel +[] Save & Close
b Mail Sean
b Database Scan
[Eldainen=ncs] Automatic Deletion
Deletion Seftings
TR Reas I™ Enable automatic deletion
I~ Delete quarantined mail older than
dayls)
I™ Delste quarantined database documents older than 30
dayls)
Keep number of deletion records "0,
Manual Deletion
€ Delete all quarantine docurnents
& Delete selected quarantine documents
Browse
Delete Now

FIGURE 8-11. Automatic and Manual deletion screen

Note: ScanMail automatically deletes quarantine items enabled for deletion.

To automatically delete quarantined items from Mail Scan and Database Scan:

1. Do one of the following to open the Quarantine database:
*  From the Configuration database left menu, click Quarantine Database.
* Open smquar.nsf.

2. From the Quarantine Database left menu, click Maintenance > Deletion
Settings.

3. Select Enable automatic deletion; then, choose from the following:

*  Select Delete quarantined mail older than, and type the number of days that
ScanMail will keep mail before it is deleted.

*  Sclect Delete quarantined database documents older than, and type the
number of days that ScanMail will keep database documents before they are

deleted.
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In the Keep number of deletion records ficld, type then number of deletion
records (0-100) that ScanMail will keep in the Deletion Records folder.

Note: Deleted Mail Scan and Database Scans are kept in the Deletion Records folder
according to the number of deletion records set to keep in Maintenance >
Deletion Settings > Keep number of deletion records.

Click Save & Close.

Deleting Quarantined Items Manually
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Use the Quarantine Database to delete quarantine items manually.

To delete quarantined items manually:

1.

Do one of the following to open the Quarantine database:
*  From the Configuration database left menu, click Quarantine Database.
* Open smquar.nsf.

From the Quarantine Database left menu, click Maintenance > Deletion
Settings.

From the working area, do one of the following:

*  Sclect Delete all quarantine documents to delete existing logs available in the
Quarantine database.

*  Seclect Delete selected quarantine documents to delete selected logs.
i.  Click Browse to launch the Log Files window.
ii. Select which quarantine items ScanMail will delete.
iii. Click OK.

Click Delete Now.

Note: ScanMail only deletes quarantine items enabled for deletion.
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Understanding Deep Discovery Advisor
Quarantine Database

ScanMail for IBM Domino Advance Persistent Threat (APT) Prevention scanning tasks
use the SMID Deep Discovery Advisor Quarantine Database (smddtas .nsf) for
temporarily storing messages with suspicious attachments. Meanwhile, the APT
Prevention Filter uploads the suspicious attachments to the Deep Discovery Advisor for
analysis, and then takes the preconfigured action on messages or attachments according
to the analysis results.

Note: Trend Micro recommends that you do not manually delete the messages in this
temporary quarantine database as this may cause the loss of data.

Viewing Quarantined Messages

Use the Deep Discovery Advisor Quarantine database to access and view quarantined
items.

To view quarantined attachments for Mail Scan or Database Scan:

1.  Open ScanMail Deep Discovery Advisor Quarantine Database (smddtas .nsf)
in smd folder.

2. From the left menu, select Mail Scan or Database Scan to view temporarily
quarantined messages.

3. Double-click a record to view its details.
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Chapter 9

Using ScanMail for IBM Domino with
Trend Micro Control Manager

Trend Micro Control Manager™ is a centralized system that unites Trend Micro

antivirus products and services into a cohesive virus security and content management
solution.

This chapter discusses the following topics:

*  Introducing Control Manager on page 9-2

*  Introducing the Control Manager Management Communication Protocol on page 9-3
*  Introducing Outbreak Prevention Services on page 9-4

e Using Control Manager to Administer ScanMail on page 9-5
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Introducing Control Manager

Trend Micro Control Manager is a central management console that manages Trend
Micro and third-party antivirus and content security products and services at the
gateway, mail server, file server, and corporate desktop levels. The Control Manager
Web-based management console provides a single monitoring point for antivirus and
content security products and services throughout the network.

Control Manager is available in Standard and Enterprise editions to better satisfy the
needs of different enterprises.

e The Standard edition provides powerful management and configuration features
that allow you to manage your corporate antivirus and content security.

*  The Enterprise edition is for large enterprises and xSPs. This edition adds a variety
of advanced features to the Standard edition—such as cascading console support
and reporting functions.

Key Features

Key features of Control Manager include:

*  Centralized management, which allows administrators to configure, monitor, and
maintain Trend Micro software installed on the network from a single
console—regardless of location or platform

*  Flexible and scalable configuration, which simplifies the administration of a
corporate virus and content security policy.

* A hierarchical structure for job delegation so administrators can determine access
control—different users can be assigned separate access to individual branches of
the hierarchy.

*  Outbreak Prevention Services that provides proactive attack protection service and
blocks malicious code by file name or specific file details while new pattern files are
being developed that can detect and clean the new threat.

*  Vulnerability Assessment, a service that assesses network security risk and scans for
system vulnerabilities that are associated with known virus and malware attacks and
recommends actions to take to eliminate the vulnerabilities.
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*  Agent-free Damage Cleanup Services (DCS), a comprehensive cleaning service that
offers infection assessment and system repair for malicious remnants, such as
Worms and Trojans. The service provides system administrators an easy approach
for system cleaning without the use of any software locally installed on the client
machines.

Using ScanMail with Control Manager

Control Manager is a useful tool for organizations with multiple Domino servers or for
organizations using other Trend Micro products in addition to ScanMail. The main
advantages of using Control Manager with ScanMail for IBM Domino are:

*  Centralized virus logging

*  Powerful reporting and analysis options

*  Faster response to virus outbreak prevention using Outbreak Prevention Services
*  Centralized license management console

*  Centralized distribution of components

Introducing the Control Manager Management
Communication Protocol

The communication between SMID and the Control Manager uses a new protocol
called the Trend Micro Control Manager Management Communication Protocol (MCP).
SMID no longer supports the Trend Micro Management Infrastructure (TMI) protocol
used by previous versions of SMID and the Control Manager.

The Control Manager Agent can be registered after installing SMID. SMID supports
Web console redirection from the Control Manager. Access the SMID product console
directly from the Control Manager product console using a separate user name and
password for the SMID product console.
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Introducing Outbreak Prevention Services

Note: ScanMail does not apply Outbreak Prevention Services if the real-time scan is not
enabled.

The Outbreak Prevention phase is the critical period when managed products have
identified a virus outbreak and a pattern file is not yet available. During this crucial time,
system administrators must endure a chaotic, time-consuming process of
communication—often to global and decentralized groups within their organizations.

Outbreak Prevention Services delivers notification of new threats and continuous and
comprehensive updates on system status as an attack progresses. The timely delivery of
detailed virus data coupled with predefined, threat-specific action and scanning policies
delivered immediately after a new threat identification allows enterprises to quickly
contain viruses and prevent them from spreading.

Additionally, by centrally deploying and managing policy recommendations, Outbreak
Prevention Services helps eliminate the potential for miscommunication, applies
policies, and deploys information regarding attacks as they are occurring;

By providing automatic or manual download and deployment of policies via Trend
Micro Control Manager, Outbreak Prevention Services import knowledge to critical
access points on the network directly from experts at TrendLabs, Trend Micro’s global
security research and support network.

This subscription-based service requires minimal up-front investment and provides
enterprise-wide coordination and outbreak management via Trend Micro products,
which reside across critical points on the network including the Internet gateway, mail
server, file server, caching server, client, remote and broadband user, and third-party
enterprise firewalls.
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Using Control Manager to Administer ScanMail

Access the Control Manager management console to configure the ScanMail managed
product from any computer on the network.

Accessing the Control Manager Management Console

There are two ways to access the management console:
*  Locally on the Control Manager server

*  Remotely using any compatible browser
To access the management console locally from the Control Manager server:

1. Click Start > Programs > Trend Micro Control Manager > Trend Micro
Control Manager.

2. Provide the Username and Password in the fields provided.
3. Click Enter.

To access the console remotely:
1. Type the following at your browser's address field to open the sign in page:
For TMCM 5.0-https://{host name}/webapp/login.aspx

where {host name} is the Control Manager server’s fully qualified
domain name (FQDN), IP address, or server name.

For TMCM 5.5-https://{host name}/WebApp/index.html
For TMCM 6.0-https://{host name}/webapp/login.aspx

Type the Username and Password in the fields provided.
Click Enter.

Managing ScanMail from the Control Manager
Management Console

The Control Manager management console is a Web-based console that lets you use a
compatible Web browser to administer the Control Manager network from any machine.
For the list of compatible browsers, refer to the Control Manager Getting Started Guide
or online help.
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The Control Manager agent for ScanMail accepts commands from the Control Manager
server and instructs ScanMail to perform them. For example, when you select Tasks >
Deploy engine on the Control Manager management console, the Control Manager
agent instructs ScanMail for IBM Domino to deploy the latest scan engine.

To manage ScanMail from the management console:

1. Access the Control Manager management console (see Accessing the Control Manager
Management Console on page 9-5).

2.  From the main menu, click Products.
3. Under Product Directory, expand the SMID folder to perform the following:
To check ScanMail status:

1. From the working area, click Status, to update the currently displayed status.

The Product Status screen displays the Product Information, Component Status,
Operating System Information, Agent Environment Information, and
Product License Information.

To configure ScanMail:

1. From the working area, click Configuration.

2. Choose ScanMail from the product list that appears. The ScanMail Configuration
Database Web console appeats.

Note: If necessary, type the Username and Password to access the Configuration
database. Contact your administrator for the password set for ScanMail.

3. Configure ScanMail as you would from a Notes Client interface.
To deploy anti-spam pattern, scan engine, license profiles, or pattern files:
1. From the working area, click Tasks.
2. Select one of the following tasks from the list:
*  Deploy Anti-spam patterns
*  Deploy Engines
*  Deploy license profiles
*  Deploy pattern files/cleanup templates

3. Select the appropriate options and click Deploy Now.
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4. Click OK.

To view security and data loss prevention logs:
1. From the working area, click Logs.

2. Select the type of logs you want to view:

*  Security Threat Information include all virus log incidents, content security
violations, spam violation log, and viruses found in email and databases.

*  Data Loss Prevention Information includes data loss prevention incidents
found in real-time email and in databases where emails are stored.

i.  Provide the search parameters (for example, Severity, Incident) after
selecting the type of logs you want to view.

ii. Click Query to begin query.
iii. Click Export Logs into CSV to export the on-screen data to a comma
separated values file.

*  Export logs into CSV format
To export logs into CSV format:
1. Click Export to CSV.
File Download dialog-box pops up.
2. Click Save.
3. On the Save As screen, specify the location where you want to keep the file.
4. Click Save.

Use an electronic spreadsheet application (for example, Microsoft Excel™) to open
*.CSV files.

Viewing an Active Outbreak Prevention Policy

Note: ScanMail does not apply Outbreak Prevention Services if the real-time scan is not
enabled.

There are two methods to view an active Outbreak Prevention Policy:
*  Through the Configuration database

a. Open the ScanMail Configuration database.
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b. On the left menu, click Configuration > Outbreak Prevention.

Details of the active Outbreak Prevention Policy should display on the working area.

Through the Control Manager management console (TMCM 5.5) > Services page.
For TMCM 6.0: Management > Outbreak > Prevention Services

a. Access the Control Manager management console (see page 9-5).
b. Click Services on the main menu.
c. From the left menu under Services, click Outbreak Prevention.

This page automatically refreshes to ensure that the top threat and status
information is current.



Chapter 10

Removing SMID

This chapter provides information on how to remove ScanMail components from a
Domino environment.

This chapter includes the following topics:
*  Removing ScanMail Automatically on page 10-2
*  Removing a Single or Shared ScanMail Installation Manually on page 10-9
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Removing ScanMail
ScanMail can be removed either automatically or manually on all platforms on which it is
installed.
*  You can use a wizard to uninstall ScanMail.
*  Although an automatic uninstall is recommended, you can remove ScanMail
manually.
Before removing ScanMail:

1. Disable End User Quarantine (EUQ). Otherwise, the changes applied to the mail
database template file may not be rolled back during uninstallation on the Windows
64-bit operating system.

2. Shut down the Domino server.

Removing ScanMail Automatically

The following uninstall procedure applies depending on the operating system hosting
ScanMail.

Running a Wizard-based Uninstallation

The wizard-based ScanMail uninstallation uses steps that guide you with the
uninstallation process.
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Removing SMID 5.6 for Windows

To run an automatic ScanMail uninstallation using a graphical desktop
environment:

1. Click Start > Programs > Trend Micro ScanMail for IBM Domino >
Uninstall ScanMail for IBM Domino 5.6. The uninstallation progress screen

appears.

; Installnywhere is preparing to install...

Cancel

[C) 1997-2008 Acresso Software Inc. and/or InstallShield Co. Inc,

FIGURE 10-1. Uninstallation progress screen

2. After the uninstallation progress screen completes, the Welcome to Trend Micro
ScanMail for IBM Domino Uninstaller screen appears. Click Next; the wizard
proceed to Choose Domino Server step.

Welcome

Welcome to Trend Micro
ScanMail for IBM Domino 5.6
Setup

Setup will install Scankdail for IBM Domino on your
SEIVEN(S).

Trend Micro recammends that you exit all Windows
programs before running this Setup program

Click Next= to continue or Cancel to exit.

YWARNING: This program is protected by copyright 1aws
and international treaties

Previous

FIGURE 10-2. Welcome Screen

10-3



Trend Micro™ ScanMail™ for IBM Domino™ Administrator's Guide

3.  On the Choose Domino Server step, select the server(s) from which to remove
ScanMail and click Uninstall.

Werify the Doming program and Domina Data directaries For each notes.ini
to continue the ScanMail uninstallation, To select what SMID product do
wou want ko uninstall,

Uninstall ScanMail Databas,.,  Domino Binary Dir,..
[w] SMID v5.6 C:\Program FilesiIB... C:\Program Files\IB...

Frevious Uninstall

FIGURE 10-3. Select server from which to uninstall SMID

4. After you execute the uninstall process, the Uninstalling progress screen displays.

Uninstalling uninstallation

Uninstalling... Removing product binary files

FIGURE 10-4. Uninstalling ScanMail for IBM Domino
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5.  When the Uninstalling process finishes, the Uninstall Complete screen appears.
Click Done. See Figure 10-5.

Install Complete

All selected iterns were successfully uninstalled

Previous

FIGURE 10-5. Uninstallation complete

Note:  On the Windows platform, you may also remove ScanMail by selecting
ScanMail for Domino from the Windows Start > Control Panel >
Add/Remove Programs.
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Removing SMID 5.6 for Linux
To remove SMID 5.6, perform the following steps:

1.  Open Terminal, and navigate to the uninstall folder under SMID installation
path (for example, /opt /trend/SMID/uninstall).

2. Run the uninstallation file (uninstaller) using command ./uninstaller.

[0l

FIGURE 10-6. Running the uninstallation file

The SMID uninstall Welcome screen appears.

£ 10.204.131,222 - PuTTY =]

ENTER to continue :

FIGURE 10-7. Welcome screen
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3.

4.

Press Enter. The Select Domino Server screen appears.

04.131.222 - PuTTY

d Doming
nMail uni

FIGURE 10-8. Select Domino Server screen showing installed Domino
server(s)

On the screen shown in Figure 10-8, the list of all Domino servers installed is
displayed. Select or deselect the domino server(s) you want to remove or keep.

To select or deselect the Domino server:

a. Type the corresponding number. For example, if you want to select the server
named as susellsp2_1/domino9 from the list shown on the screen in Figure
10-8, type 2.

b. Press Enter.

Type O (zero) to accept current settings and start the uninstallation of selected
Domino server(s).
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5. Press Enter. The Summary screen appears, showing the list of selected Domino

servet(s) to be uninstalled.

4.131.222 - PuTTY

6 from the lowing D

[defaulc 0] : ]

FIGURE 10-9. Summary screen

6. Type Y or y and press Enter. The uninstallation begins.
After the uninstallation process completes, Uninstallation Completed

message appears on the screen.

4 10.204.131.222 - PuTTY II=1 B3

ed from the following Domino

FIGURE 10-10. Uninstallation Completed
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Removing a Single or Shared ScanMail Installation
Manually

If you are unable to remove ScanMail automatically, you can manually remove ScanMail.
However, Trend Micro recommends trying the automatic methods before attempting to
manually remove the product.

If the server has multiple installations of ScanMail and you want to manually uninstall all
these instances, the procedure is similar to manually removing ScanMail on a single
installation.

The installation information and file paths for each instance are all recorded in
smdsys.ini (for Windows) or smdsysV3. ini (for Linux), which will also have
multiple instances of [SMDConfx].

Removing a Single or Shared ScanMail Installation on
Windows

To manually remove a single or shared ScanMail installation:

Tip: Refer to Table C-1 on page C-2 in Appendix C, Program File and Folder Lists for the list
of ScanMail files and folder structures.

1.  On the server where ScanMail is installed, search for smdsys.ini, and then use
a text editor to open it. Keep the file open for reference when performing the
succeeding steps.

Parameters that will be referred to in the succeeding steps include:
¢ DomSvr{X}DominoBinPath

*  DomSvr{X}DataPath

*  DomSvr{X}NotesIniPath

*  ProductPath
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Note:

DomSvr {X} represents the ScanMail instance where {X} is the number
corresponding to the ScanMail installation.

If the target server has only a single ScanMail installation, DomSvr {X} is
DomSvr0. For multiple ScanMail installation, DomSvr {X} increments by 1.
DomSvrO0 is the first instance, DOmSvr1l is the second instance, and so forth.
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Here is a sample of smdsys.ini for a Windows server that has multiple instances of
ScanMail:
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If the SMID instance is removed from all the partition servers that share the
Domino binary, then navigate to the directory specified in
DomSvr{X}DominoBinPath, and then search for and delete the
corresponding ScanMail files:

+ DominoBinPath ScanMail files on a Windows server (see Table C-1 on
page C-2).

Navigate to the directory specified in DomSvr {X}DataPath, and then delete

the ScanMail installation and temporary folders (see Table C-1 on page C-2).

Using a text editor, open the notes. ini specified in
DomSvr{X}NotesIniPath, and then perform the following:

a. Look for the ServerTasks section, and then delete the following items:
e SMDemf

e SMDreal
*  SMDsch

e SMDmon
e SMDcm

b. Look for the EXTMGR_ ADDINS section, and then delete the item SMDext.

c. Look for the ScanMailInstallPath section, and then delete the whole
line (including the file path).
Save and close notes. ini.

Delete smd. ini. This file is located in the path specified in
DomSvr{X}DominoBinPath.

If the SMID instance is removed from all the partition servers that share the SMID
binary, delete the folder specified in ProductPath. This folder contains other
ScanMalil files, including the virus pattern and scan engine files for VSAPI and
Trend Micro Anti-Spam.

Navigate to the folder where the ScanMail installation logs are located (see Locating
Installation and Uninstallation Logs on page 11-2) and delete the log files.

For ScanMail installed on a Windows server, complete the following tasks:
a. Open the Registry, and then delete the uninstall key:

HKEY LOCAL_ MACHINE\SOFTWARE\Microsoft\Windows\CurrentVer
sion\Uninstall\ScanMail for Domino
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b. Delete the Trend Micro ScanMail for IBM Domino folder from
C:\Documents and Settings\All Users\Start
Menu\Programs. This action removes the ScanMail program folder from
the Start menu.

c. Close the registry editor
10. Delete and modify the information of partition server which installs the specified
SMID instance in smdsys.ini.
* DomSvrISMDCount
*  DomSvrISMDSecs

*  DomSvrX (delete the related information of the partition server of ScanMail
instance)

If the SMID instance is removed from all the partition servers that share the SMID
binary, delete the SMDConfx instance in smdsys. ini.

If all SMID instances are removed from the target server, delete smdsys. ini.

11. Restart the Domino server.

Removing a Single or Shared ScanMail Installation on Linux

Tip: Refer to Table C-2 on page C-3 in Appendix C, Program File and Folder Lists for the list
of ScanMail files and folder structures.

1.  On the server where ScanMail is installed, search for smdsysV3.ini, and then
use a text editor to open it. Keep the file open for reference when performing the
succeeding steps.

Parameters that will be referred to in the succeeding steps include:
*  DomSvr{X}
*  ProductPath

Note: DomSvr{X} represents the ScanMail instance where {X} is the number
corresponding to the ScanMail installation.
If the target server has only a single ScanMail installation, DomSvr {X} is DomSvrO0.
For multiple ScanMail installation, DomSvr {X} increments by 1. DomSvroO is the
first instance, DomSvr1 is the second instance, and so forth.
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Here is a sample of smdsysV3. ini for a Linux server that has multiple instances
of ScanMail:

2. If the SMID instance is removed from all the partition servers that share the
Domino binary, then navigate to the Domino Binary directory, and then search for
and delete the corresponding ScanMail files:

*  ScanMail files in the Domino Program directory (1bmpow) on a Linux server
(see Table C-2 on page C-3).

3. Navigate to the Domino Data directory, and then delete the SMID installation and
temporary folders.
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Using a text editor, open the notes. ini specified in DomSvr {X}, and then
perform the following:

a. Look for the ServerTasks section, and then delete the following items:
*  SMDemf

e SMDreal
e SMDsch

e SMDmon
e SMDcm

b. Look for the EXTMGR ADDINS section, and then delete the item SMDext.

c. Look for the ScanMailInstallPath section, and then delete the whole
line (including the file path).
Save and close notes. ini.

If the SMID instance is removed from all the partition servers that share the SMID
binary, delete the folder specified in ProductPath. This folder contains other
ScanMail files, including the virus pattern and scan engine files for VSAPI and
Trend Micro Anti-Spam.

Navigate to the folder where the ScanMail installation logs are located (see Locating
Installation and Uninstallation 1ogs on page 11-2) and delete the log files.

Delete and modify the information of partition server which installs the specified
SMID instance in smdsysV3.1ini.

e DomSvrISMDCount
e DomSvrISMDSecs

*  DomSvrX (delete the related information of the partition server of ScanMail

instance)

If the SMID instance is removed from all the partition servers that share the SMID
binary, delete the SMDConfx instance in smdsysV3.ini.

If all SMID instances are removed from the target server, delete smdsysV3.ini.

Restart the Domino server.
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Chapter 11

Troubleshooting

This chapter describes how to troubleshoot problems that may occur with ScanMail for
IBM Domino.

This chapter discusses the following topics:

*  Locating Installation and Uninstallation 1.ogs on page 11-2

*  Held Mail Issues on page 11-2

*  Update Issues on page 11-3

o Schednled Scan/ Update Issne on page 11-4

*  Reovering a Corrupt ScanMail Database on page 11-4

*  Using the Database Templates to Recreate ScanMail Databases on page 11-5
*  Deep Discovery Advisor Agent Issue on page 11-6

*  Debugging ScanMail Tasks on page 11-6

*  Understanding ScanMail Error Messages on page 11-8
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Locating Installation and Uninstallation Logs

The following are the ScanMail installation and uninstallation logs:

TABLE 11-9. Installation and uninstallation logs

PLATFORM LOCATION AND FILE NAME DESCRIPTION

Windows $windir%\temp\smdins.log ScanMail installation log

$windir%\temp\smdunins.log | ScanMail uninstallation log

Linux /var/log/smdins.log ScanMail installation log

/var/log/smdunins.log ScanMail uninstallation log

Held Mail Issues

This section provides information on how to handle various held mail issues.

General Held Message Issues

To help quickly resolve held mail issues, determine and collect the following
information:

*  Mail.box(es)

*  ScanMail Temporary Files (check Configuration Database > Server Settings
screen for the exact path of the temporary directory)

*  SMDreal debug files
*  Number of SMDreal tasks running

Scanning for and Releasing Held Mail in the System
Mailbox

In some circumstances, such as when SMDreal is manually halted, some unscannable
email messages may be held in the system mailbox, mail . box. If this occurs, manually
scan the system mailbox and release the held messages.
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To scan the system mailbox and release the held email messages:

1.
2.

Load the SMDreal server task and verify its status is idle.

Go to Actions > Manual Scan > Databases to scan and add mail . box to the
list.

Click Scan Now or load smddbs on the Domino console. All messages in the
system mailbox will be scanned and all held messages will be released.

Note: A manual scan of the system mailbox will uses the rules set in the currently active

Mail Scan policy.

Update Issues

If you configured the update source to download antivirus and content security

components from the update source, and updated components cannot be downloaded.
See Setting the Update Sonrce on page 6-9 and Understanding the Antivirus and Content Security
Components on page 6-2.

Perform the following steps to help troubleshoot the cause of the issue:

If Other Internet source is enabled as the update source, check whether the folder
containing the latest components has the corresponding signature files for secure
digital download. The absence of the * . sig file will cause an unsuccessful
component download and update.

If Trend Micro ActiveUpdate is enabled as the update source, check the
connection from the Domino server to the ActiveUpdate server.

a. Usenslookup to verify that the Domino server can resolve the
ActiveUpdate server’s FQDN.

b. Ping the following from the Domino server:
smid56-p.activeupdate.trendmicro.com

c. Telnet the ActiveUpdate server at port 80 to make sure the Domino server can
connect via HTTP.

d. Ifan HTTP proxy is being used to update from the Internet, access the
following URL to test the connection:



http://smid56-p.activeupdate.trendmicro.com/activeupdate/server.ini
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The Internet browser will either display the content of server. ini file or
ask you permission to download it to the computer. Check the Domino
console to see whether SMDupd returns an error message.

If ScanMail still cannot update components, enable SMDupd debugging and then
contact Trend Micro Support (see Debugging ScanMail Tasks on page 11-6).

Scheduled Scan/Update Issue

An SMID scheduled scan/update cannot be re-run if the scheduler failed to start at the
scheduled time. A workaround for this issue is:

1.  Add smddbs/smdupd as a stattup setver task in notes. ini.

2. Use the same settings that are specified in the Scheduled Scan/update settings to
configure the Manual Scan/update settings.

When the Domino server encounters a restart, such as a nightly backup,
smddbs/smdupd will run the same scan/update tasks as the scheduled
scan/update.

Recovering a Corrupt ScanMail Database

11-4

If for some reason, a ScanMail database becomes corrupted, you can try to recover the
database by performing a consistency check on the database. To do this, type the
following command at the Domino server console:

load fixup {database path and file name}

For example, if the administrator wants to recover a corrupted Configuration Database,
the following command should be issues from the Domino server console:

load fixup smd\smconf.nsf

If the database can no longer be recovered, you may opt to recreate the database (see
Using the Database Templates to Recreate ScanMail Databases on page 11-5).

Note: Recreating a database does not restore its original contents.
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Using the Database Templates to Recreate
ScanMail Databases

If the ScanMail database becomes corrupted and is irrecoverable, use the corresponding
ScanMail database templates to recreate these databases.

Note: Recreating a ScanMail database does not restore the original database contents. If the

corrupted database was the Configuration database, then the administrator needs to
redefine the policies, rules, and filters (or replicate the configuration database from
another ScanMail server after the local Configuration Database is recreated).

To recreate a ScanMail database:

1.

>

® 3@

Obtain a * . NTF copy of the database you would like to replace and place it in the
Domino Data directory.

Launch a Notes Client, and then open the Workspace tab containing the ScanMail
databases (see Adding ScanMail Database Icons to the Notes Workspace on page 3-3 for
details on how to add ScanMail icons to the Notes Workspace).

Select the ScanMail database to recover.

On the main menu, click to File > Application > Replace Design. The Replace
Database Design window appears.

Click Template Server.

Click the corresponding server from the list; then, click OK.

Select the Show advanced templates check box.

From the templates list, select the corresponding ScanMail template to replace the
corrupted database.

Click Replace. If the template file had not been signed using the ID used during
ScanMail installation; then, sign the new database with this ID.
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Deep Discovery Advisor Agent Issue

If the Deep Discovery Advisor Agent does not connect with Deep Discovery Advisor,
then perform the following steps:

1. Make sure that the SMID server is connected with the Deep Discovery Advisor.

2. Verify the API key in Deep Discovery Advisor Settings. See Configuring Deep
Discovery Advisor Settings on page 5-13 for the detailed configuration steps.

Note: If you do not have the Deep Discovery Advisor API Key, then contact your
Deep Discovery Advisor administrator to obtain the API Key.

Debugging ScanMail Tasks

Do one of the following debug procedures:
To debug ScanMail SMDreal, SMDdbs, SMDmon, SMDsch, or SMDcm tasks:
Type and run the following commands on the Domino console:
tell {scan task} quit
load {scan task} -debug {level}
where {level} canbe 1,2, or 3.
To debug ScanMail EMfilter tasks:

a. Open notes. ini using a text editor (for example, notepad. exe).

Tip: Use care when modifying Domino or ScanMail * . ini files.
To ensure that you can rollback to the original settings, back up notes. ini.

b. Add this parameter as the last notes.ini entry:
SMDEMDEBUG=1

c. Save and close notes.ini.
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Debug Levels

The ScanMail scanning tasks uses the following debug levels:

LEVEL DESCRIPTION

1 Shows fatal errors only

2 Shows abbreviated debug information
3 Shows detailed debug information

Note: Debug levels for the Extension Manager and Extension Manager filter cannot be set.

Debug Results

For scan task debugging, ScanMail writes logs to files with the following naming
convention:

{servertaskname} {yyyymmdd}.dbg

where:
{servertaskname} is the name of the ScanMail task

{yyyymmdd} is the year, month, and day the log file is generated

Examples:
*  Windows: nSMDreal _20040211.dbg

Other debug logs are:
*  SMDEXT.dbg for Extension Manager task
* SMDEMF .dbg for Extension Manager filter task (SMDEMF)

* <Domino Data>\SMDTemp\dbsetup.log for ScanMail database
setup debug logs
ScanMail saves all debug files to the \ SMDtemp folder under the Domino
Data directory.
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Understanding ScanMail Error Messages

The following table explains the most common ScanMail messages that may appeat on

the Domino server console:

MESSAGE

CAUSE

WHAT To Do

SMDreal: Unable to create mes-
sage queue. Restart Domino
server.

Domino server may
not be running prop-
erly.

Restart the Domino server.

SMDreal: Unable to initialize
common message. Unload and
then reload SMDreal.

Message files are
missing.

Uninstall, and then re-install
ScanMail.

SMDreal: Unable to initialize
scan engine. Check the scan
engine and pattern file.

The scan engine or
pattern file is miss-
ing.

smconf.nsf
does not contain pol-
icy document

Uninstall, and then re-install
ScanMail.

Create a policy in
smconf.nsf, and then load
smdreal again

SMDreal: Missing Extension
Manager in notes. ini.
Re-install ScanMail.

ScanMail was
installed using a
wrong installation
package. Alterna-
tively, ScanMail was
removed manually.

Uninstall, and then re-install
ScanMail.

SMDreal: Invalid Activation
Code. Activate ScanMail via the
Configuration Database and then
reload SMDreal.

Activation Code (AC)
was not entered
during ScanMail
installation.
Alternatively, an
invalid AC was
entered.

Enter a valid AC using the
ScanMail Configuration
Database > Administration >
Product License document.
See Registering and Activating
SMID on page 2-42.

SMDreal: The trial period has
expired. Obtain a Registration
Key and then activate ScanMail.

An AC trial version

was entered during
installation, and the
AC already expired.

See Renew SMID Maintenance
on page 2-44

SMDreal: Unable to load policy.
Check Configuration Database
and then reload SMDreal.

The Configuration
Database might be
corrupt.

SMDreal: Unable to load
Message Database. Check
smmsg.nsf and then reload
SMDreal.

smmsg.nsf
(ScanMail Message
Database) might be
corrupt.

Reinstall ScanMail.
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MESSAGE

CAUSE

WHAT To Do

SMDdbs: Invalid database list
settings. Check the database list
in the Manual or Scheduled scan
rule setting.

The format of the
database list in the
Configuration
Database is
incorrect.

Check Databases to Scan list in
the Real-time Database Scan,
Scheduled Scan, or Manual
Scan documents. Use
semicolons to separate multiple
entries.

SMDreal: Unable to read Domino
directory. Check server status.

The fully qualified
name (FQDN) of the
Domino server is
empty. Alternatively,
other Domino
configuration is
wrong.

Correct the Domino settings.

SMDreal: Cannot open database
{database name}. Check the
database name in the
Configuration Database.

ScanMail cannot
open the database
when trying to scan
the special document
in that database.
Probably, the
database was
deleted before
ScanMail was able to
scan it.

No action needed.

SMDdbs: Cannot read Database
Scan settings. Check
Configuration Database.

Database Scan
setting is incorrect.

Check database scan rule (see
Creating Real-time Database Scan
Rules on page 4-14).

SMDupd: Unable to run multiple
SMDupd instances

Scheduled update,
manual update, or
update task from the
Control Manager
server are running at
the same time.

Wait until an update is finished,
then run another update task.
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MESSAGE

CAUSE

WHAT To Do

SMDupd: Invalid parameter

The Update task only
accepts 4 kinds of
format parameter,
which represent
update that was
triggered from 3
different sources. If
the parameter did not
follow the required
format, this message
will be displayed.

SMDupd: Unable to initialize the
update task

Unable to obtain the
correct update
settings or
ActiveUpdate cannot
be invoked.

Check the manual scan
document or scheduled update
rule (see Running Mannal Scan
on page 4-64 or Updating
Components on page 6-3).

SMDupd: Unable to set up
connection. Check network
connection. Refer to ScanMail
Help > Troubleshooting section
for details.

Connection to the
ActiveUpdate server
cannot be
established.

Check the network connection
and the proxy server connection
and configuration. Refer to
<ScanMail Installation
Path>\AU Log\TmuDump.txt
for details.

SMDupd: Unable to download
components. Check server status
or refer to ScanMail Help >
Troubleshooting section for
details.

Network congestion
or unable to perform
integrity checking for
the downloaded
component.

Refer to <ScanMail
Installation

Path>\AU Log\TmuDump. txt
for details.

SMDupd: Unable to update
component(s), the Activation
Code already expired.

AC already expired.

See Renew SMID Maintenance
on page 2-44

SMDupd: Unable to update to the
latest version. Refer to ScanMail
Help > Troubleshooting for
details.

Connection to the
ActiveUpdate server
cannot be
established or
unable to perform
integrity checking for
the downloaded
component.

Check the network connection
and the proxy server connection
and configuration.

Refer to <ScanMail
Installation

Path>\AU Log\TmuDump.txt
for details.

SMD Loader: The executable file
exceeds the allowable maximum
size {maximum size}

The path name of
executable file is too
long. This could be
caused by multiple
cascading
subdirectories or
long file names.

Reinstall ScanMail on a directory
with a short path name.
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MESSAGE

CAUSE

WHAT To Do

SMD Loader: Unable to find the
latest program directory

Unable to find Scan-
MailInstallPath
innotes.ini.
This is caused by
incomplete installa-
tion or manual dele-
tion of ScanMail files.

Reinstall ScanMail or add
ScanMailInstallPath
parameter and value in
notes.ini.

SMD Loader: Unable to browse
the latest program directory
{path}

The path name spec-
ified by ScanMail-
InstallPathis an
invalid path or direc-

tory.

Reinstall ScanMail or add the
correct
ScanMailInstallPath
parameter and value in
notes.ini.

SMD Loader: Unable to load
dynamic library "%s"

SMDsch: Unabile to start the
scheduled task "%s"

Unable to load the
dynamic library
because a file is
missing, corrupted,
or has insufficient
permission.

Reinstall ScanMail or obtain a
valid file and overwrite the cor-
rupted one on the Domino
server.
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Chapter 12

Getting Support

Trend Micro is committed to providing service and support that exceeds our users’
expectations. This chapter contains information on how to get technical support.
Remember, you must register your product to be eligible for support.

This chapter includes the following topics:

Before Contacting Technical Support on page 12-2

Contacting Technical Support on page 12-2

Reporting Spam and False Positives to Trend Micro on page 12-3
Introducing Trendlabs on page 12-3

Other Useful Resources on page 12-4
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Before Contacting Technical Support

Before contacting technical support, two things you can quickly do to find a solution to
your problem:

*  Check your documentation: the manual and online help provide comprehensive
information about ScanMail. Search both documents to see if they contain your
solution.

*  Visit our Technical Support Web site: our Technical Support Web site contains
the latest information about all Trend Micro products. The support Web site has
answers to previous user inquiries.

To search the Knowledge Base, visit

http://esupport.trendmicro.com/support/supportcentral /supportcentral.do

Contacting Technical Support
In addition to phone support, Trend Micro provides the following resources:
*  Email support
support@trendmicro.com

*  Help database- configuring the product and parameter-specific tips

*  Readme- late-breaking product news, installation instructions, known issues, and
version specific information

*  Knowledge Base- technical information procedures provided by the Support team:

http://esupport.trendmicro.com/support/supportcentral/supportcentral.do

*  Product updates and patches
http:/ /www.trendmicro.com/download

To locate the Trend Micro office nearest you, open a Web browser to the following
URL:

http:/ /www.trendmicro.com/en/about/contact/overview.htm

To speed up the problem resolution, when you contact our staff please provide as much
of the following information as you can:

¢ Product Activation Code
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¢ ScanMail Build version
*  Exact text of the error message, if any

*  Steps to reproduce the problem

Reporting Spam and False Positives to Trend
Micro

To report a spam email message, forward the message, including all headers, to:
spam@support . trendmicro.com

To report messages that ScanMail incorrectly identified as spam (a false positive),
forward the message, including all headers, to:

false@support.trendmicro.com

Trend Micro regularly updates the anti-spam rule and engine with information from the
messages you provide. Your assistance helps reduce future spam and false positive
messages.

Introducing TrendLabs

Trend Micro TrendLabs is a global network of antivirus research and product support
centers that provide continuous 24 x 7 coverage to Trend Micro customers around the
wortld.

Staffed by a team of more than 250 engineers and skilled support personnel, the
TrendLabs dedicated service centers in Paris, Munich, Manila, Taipei, Tokyo, and Irvine,
CA. ensure a rapid response to any virus outbreak or urgent customer support issue,
anywhere in the world.

The TrendLabs modern headquarters, in a major Metro Manila I'T park, has earned ISO
9002 certification for its quality management procedures in 2000 - one of the first
antivirus research and support facilities to be so accredited. Trend Micro believes
TrendLabs is the leading service and support team in the antivirus industry.
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Other Useful Resources

Trend Micro offers a host of services via its Web site, www.trendmicro.com.

124

Internet-based tools and services include:

Virus Map— monitors virus incidents around the world
HouseCall™-— Trend Micro online virus scanner

Virus risk assessment— the Trend Micro online virus protection assessment program
for corporate networks


www.trendmicro.com

Appendix A

Understanding Threats in a Domino
Environment

ScanMail stops the spread and acquisition of computer malware (both known and
unknown) in an IBM Notes environment.

This appendix includes the following sections:
*  Understanding Malware on page A-2
*  How Malware Spreads in a Notes Environment on page A-5
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Understanding Malware

Malware refers to any program that executes and performs activities that are outside of
the uset’s consent. A virus is a form of malware. Other examples of malware include
Trojans, Worms, Backdoors, Denial of Service attacker agents, Joke programs, and
several other smaller categories of malicious code.

Viruses are just part of a large of group of malicious programs called malware, coined
from the two words “malicious software”. When we say “malicious”, we mean that the
program is doing something outside of our knowledge or consent. Calling every type of
malware a virus would be like calling every kind of vehicle that you see on the street a
car, when in fact some are not.

We often associate the term “viruses” with any type of malicious code. That is incorrect.
3
as not every malicious code is a virus.

In fact, malware is the best term to describe malicious code. Malware has many
sub-categories including:

e Viruses

*  Worms

e Trojans

*  Joke programs

Descriptions for each sub-category are provided below.

Viruses

A computer virus is a segment of code that has the ability to replicate. Viruses usually
replicate by infecting files. When a virus infects a file, it attaches a copy of itself to the
file in such a way that when the former is executed, the virus is also run. When this
happens, the infected file also becomes capable of infecting other files.

Generally, there are three kinds of viruses:
* File
File viruses may come in different types— there are DOS viruses, Windows viruses,

macro viruses, and script viruses. All of these share the same characteristics of
viruses except that they infect different types of host files or programs.
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*  Boot

Boot viruses infect the partition table of hard disks and boot sector of hard disks
and floppy disks.

*  Script
Script viruses are viruses written in script programming languages, such as Visual
Basic Script and JavaScript and are usually embedded in HTMIL documents.

VBScript (Visual Basic Script) and Jscript (JavaScript) viruses make use of
Microsoft's Windows Scripting Host to activate themselves and infect other files.
Since Windows Scripting Host is available on Windows 98, Windows 2000 and
other Windows operating systems, the viruses can be activated simply by
double-clicking a * . vlos or * . js file from Windows Explorer.

What is so special about script viruses? Unlike programming binary viruses, which
require assembly-type programming knowledge, virus authors programs script
viruses as text. A script virus can achieve functionality without low-level
programming and with code as compact as possible. It can also use predefined
objects in Windows to make accessing many parts of the infected system easier (for
example, for file infection, for mass-mailing). Furthermore, since the code is text, it
is easy for others to read and imitate the coding paradigm. Because of this, many
script viruses have several modified variants.

For example, shortly after the “I love you” virus appeared, antivirus vendors found
modified copies of the original code, which spread themselves with different subject
lines, or message bodies.

Whatever their type is, the basic mechanism remains the same. A virus contains code
that explicitly copies itself. In the case of file viruses, this usually entails making
modifications to gain control when a user accidentally executes the infected program.
After the virus code has finished execution, in most cases, it passes back the control to
the original host program to give the user an impression that nothing is wrong with the
infected file.

Take note that there are also cross-platform viruses. These types of viruses can infect
files belonging to different platforms (for example, Windows and Linux). However, such
viruses are very rare and seldom achieve 100% functionality.

A-3



Trend Micro™ ScanMail™ for IBM Domino™ Administrator's Guide

Worms

A computer worm is a self-contained program (or set of programs) that is able to spread
functional copies of itself or its segments to other computer systems. The propagation
usually takes place via network connections or email attachments. Unlike viruses, worms
do not need to attach themselves to host programs. Worms often use email and
applications, such as Microsoft™ Outlook™, to propagate. They may also drop copies
of themselves into shared folders or utilize file-sharing systems, such as Kazaa, under
the assumption that users will likely download them, thus letting the worm propagate. In
some cases, worms also use chat applications such as ICQ, AIM, mIRC, or other
Peer-to-Peer (P2P) programs to spread copies of themselves.

Trojan Horses

A Trojan horse is a destructive program that comes concealed in software that not only
appears harmless, but also comes in a particulatly attractive form (such as a game or a
graphics application). There may be instances when a Trojan does not have a destructive
payload. Instead, it may contain routines that can compromise the security of your
system or the entire network. These types of Trojans are often referred to as Backdoor
Trojans.

Trojans are non-replicating malware — they do not replicate by themselves and they rely
on the user to send out copies of the Trojan to others. They sometimes achieve this by
hiding themselves inside desirable software (that is, computer games or graphics
software), which novice users often forward to other users.

Joke Programs

A Joke program is an ordinary executable program with normally no malicious intent.
Virus authors create joke programs for making fun of computer users. They do not
intend to destroy data but some inexperienced users may inadvertently perform actions
that can lead to data loss (such as restoring files from an older backup, formatting the
drive, or deleting files).

Since joke programs are ordinary executable programs, they will not infect other
programs, nor will they do any damage to the computer system or its data. Sometimes,
joke programs may temporarily reconfigure the mouse, keyboard, or other devices.
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However, after a joke program finishes its execution or the user reboots the machine,
the computer returns to its original state. Joke programs, while normally harmless, can
be costly to an organization.

Web Reputation

The Web Reputation features now provided with ScanMail for IBM Domino help
ensure that Web pages users access are safe and free from Web threats, like malware,
spyware, and phishing scams, which are designed to trick users into providing personal
information. The Web Reputation functionality contained in SMID identifies unsafe
URL:s in email according to their reputation rating. Additionally, the administrator can
add additional URLs to this list. See Configure Web Reputation on page 4-35.

When enabled, Web Reputation queries Trend Micro servers to obtain ratings, which are
correlated with multiple sources, including Web page links, domain and IP address
relationships, spam sources, and links in spam messages. By obtaining ratings online,
Web Reputation uses the latest available information to block harmful pages. Web
Reputation helps deter users from following malicious URLs. Web Reputation queries
Trend Micro servers for the reputation rating when an email message with a URL in the
message body is received. Depending on the configuration, Web Reputation can
quarantine, delete, or tag the email message that contains these URLs.

How Malware Spreads in a Notes Environment

ScanMail provides constant detection and protection of the three points of entry where
the Notes Client environment is most vulnerable:

e Email transmissions— ScanMail performs real-time scanning on all incoming and
outgoing email messages and their attachments to stop malware from entering your
system, or infecting someone else’s (for example, a customer)

¢ Client database accesses— ScanMail monitors database files that are modified in real
time to prevent viruses from being archived among your stored database documents
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*  Replications— ScanMail checks all files modified through the Notes database
replicator in real time to keep viruses from being replicated from other Notes
servers

Replication

Domino
Server 1 Server 2

4 2 2/&8 32 2

|i—) |i— |i— |i— /i —) |i—

Virus infected Client Client Client | | Client Client Client

document Network A Network B
An infected file was Domino Server 1stores Domino S 1
attached to a Notes the mail into ten recipient Chedu EI‘VEI‘. ans :
mail and was sent to . P SC.hEdUIEd r‘ep'hcahcm.
mailboxes. One of the with server 2, spreading
other users. o : :
recipients posts the mail the virus to that server

FIGURE A-1. A virus infected document spreading in a Notes
environment.

In addition to real-time scan, ScanMail helps end the cycle of recurring infections with

manual or scheduled sweeps of the entire database and mail message attachments. See
Types of Scans for introduction to ScanMail scanning,
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Appendix B

ScanMail for IBM Domino Best
Practices

This appendix provides the best practices for optimized operations and maximum
performance of ScanMail. This includes:

*  Tuning the Domino Server on page B-2

*  Performance Recommendations on page B-2

B-1



Trend Micro™ ScanMail™ for IBM Domino™ Administrator's Guide

Tuning the Domino Server

Trend Micro recommends the following settings for servers running ScanMail for IBM
Domino:

*  (Windows only) Set HKEY Local Machine\System\
CurrentControlSet\Control\PriorityControl\
Win32PrioritySeparation to 0 rather than the default value of 24, in
accordance with IBM recommendations for better server performance.

*  (All platforms) Create two Mail.box databases (mail routing databases) to load
balance message throughput based on workload

Review Domino documentation for additional recommendations.

Performance Recommendations

Using the ScanMail for IBM Domino memory-based scanning feature improves
scanning performance. Memory can be allocated to ScanMail for real-time replication,
email, and database scanning, and manual and scheduled database scanning,

When scanning, detecting, and cleaning viruses, at least two SMDreal tasks are
recommended for most environments. When enabling spam scanning and filter policies,
additional SMDreal tasks are recommended.

Note: Trend Micro continually assesses whether different filtering rule structures have
different performance ramifications.
The recommendations found in this Appendix are subject to change without prior
notice. Please consult Trend Micro support to ensure up-to-date information.




Appendix C

Program File and Folder Lists

This appendix provides a list of the ScanMail files and folder structures. These files and
folders are available upon a successful application installation.

For the list of installation and uninstallation logs, see Locating Installation and Uninstallation
Logs on page 11-2.
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ScanMail for Windows

Refer to Tuble C-1 for the list of files created by a successful ScanMail and Control
Manager agent installation on a Windows server.

TABLE C-1. ScanMail files and folders available on a Windows server

FILE/FOLDER DESCRIPTION
...\IBM\Domino Contains the ScanMail loader, filter, extension man-
.. .ndbsetup.exe ager, end-user quarantine, dbsetup, and ScanMail
.. .nSMDcm.exe configuration files.

...nSMDdbs . exe
.. .nSMDDTAS . exe
. .nSMDEUQ. exe
.. .nSMDemf . exe
. .nSMDext .dll
. .nSMDmon . exe
. .nSMDreal . exe
...nSMDsch.exe
. ..nSMDsupp . exe
. .nSMDupd. exe
.smd.ini
. .WINDOWS\smdsys.ini The main ScanMail for IBM Domino configuration file
...\Program Files\Trend The ScanMail for IBM Domino default installation
Micro\ScanMail for Domino folder
...\engine Contains the TMASE and virus scan engine folders
...\engine\atse Contains the Trend Micro Advanced Threat Scan
engine
.\engine\tmase Contains the Trend Micro Anti-spam Engine (TMASE)
.\engine\tmufe Contains the Trend Micro tmufe engine
.\engine\vsapi Contains the Trend Micro scan engine
.\pattern Contains the TMASE and virus scan rule/pattern fold-
ers
.\pattern\tmase Contains the TMASE rule files
.\pattern\vsapi Contains the virus pattern file, spyware pattern and
Intellitrap pattern files
.\program Contains the ScanMail readme file and the binary and
configuration file folders
A\program\VS.#.#. #### Contains the ScanMail binary and configuration files
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TABLE C-1. ScanMail files and folders available on a Windows server

FILE/FOLDER DESCRIPTION
.\Uninstall Contains the ScanMail uninstall program
.IBM\Domino\Data\smd Contains the ScanMail databases and templates

under the Domino Data directory

.IBM\Domino\Data\smdtemp Contains the Setup dbsetup. logand the
temporary files used by the ScanMail scan tasks
under the Domino Data directory.

.IBM\Domino\Data\smd\smtemp | The SpanMaiI folder used to extract temporary files for
scanning.

ScanMail for Linux

Refer to Table C-2 for the list of files created by a successful ScanMail and Control
Manager agent installation on a Linux server.

TABLE C-2. ScanMail files and folders available on a Linux server

FILE/FOLDER DESCRIPTION
/etc/smdsysV3.ini The ScanMail for IBM Domino main configuration file
/opt/trend/SMID/ The ScanMail for IBM Domino default installation

folder. The installation can however, be done in any
other folder.

.../engine/atse Coqtains the Trend Micro Advanced Threat Scan

engine

./engine/tmase Contains the Trend Micro Anti-spam Engine (TMASE)

./engine/vsapi Contains the Trend Micro scan engine

./pattern/tmase Contains the TMASE rule files

./pattern/vsapi fC_Iontains the virus, spyware, and Intellitrap pattern
iles

. /engine/tmufe Contains the Trend Micro tmufe engine

. /program Contains the ScanMail readme file and the binary and

configuration file folders
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TABLE C-2.

ScanMail files and folders available on a Linux server

FILE/FOLDER

DESCRIPTION

.../program/V5.#.#. ####

Contains the ScanMail binary and configuration files
Where:
e _#.# (the first two) indicate the minor
version
o _#### (the last four #) indicate the build
number

/opt/lotus/notes/latest/ibm-

Contains the ScanMail configuration, binary, and data-

pow base files under the Domino Program directory. The
.libsmdext.a Domino Program directory can however, be any other
. .smdcm folder.
. .smddbs
.smddtas
. smdeuqg
. smdemf
. smdmon
.smdreal
. .smdsch
. .smdsupp
.smdupd
../smd Contains the ScanMail databases and templates
under the Domino Data directory
. ./smdtemp Contains the Setup dbsetup . 1ogand the tempo-
rary files used by the ScanMail scan tasks under the
Domino Data directory.
. /smd/smtemp The ScanMail default folder used to extract temporary

files for scanning which is under the Domino Data
directory.




Appendix D

SMLD 5.5 and SMID 5.6 Feature
Comparison

The following table presents a comparison of Trend Micro ScanMail for Lotus Domino
(SMLD) 5.5 and ScanMail for IBM Domino (SMID) 5.6.
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D-2

TABLE D-1.  SMLD 5.5 and SMID 5.6 feature comparison
FEATURE SMLD 5.5 SMID 5.6

Supports Domino 6.5.x No No
Supports Domino 6.0.x No No
Supports Domino 5.0.13a, 5.0.12, 5.0.11 No No
Supports Domino 7.0.2, 7.0.3, 8.0 No No
Supports Domino 8.0.1, 8.0.2, 8.5, 8.5.1, 8.5.2, Yes Yes
8.5.3, 8.5.4 and Domino 9
Supports Linux 32-bit and 64-bit Yes Yes
Supports cluster server Yes Yes
(full support with task on each server and trusting)
Supports partitioned servers Yes Yes
Simultaneous installation on multiple partitions Yes Yes
Scripted/silent installation on all platforms Yes Yes
Preparation for replication during installation Yes Yes
Configuration of ACL during installation Yes Yes
Database signing during installation No No
Database signing with alternate ID/password or skip No No
signing
Replicates Configuration database across platforms Yes Yes
Supports installation parameterization Yes Yes
Multi-instance support Yes Yes
Supports new CM and Management Communica- Yes Yes
tion Protocol (MCP) Agents

SUPPORTED DOMINO APPLICATIONS

IBM Domino Database (.nsf) Yes

Yes
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TABLE D-1.  SMLD 5.5 and SMID 5.6 feature comparison (Continued)
FEATURE SMLD 5.5 SMID 5.6
IBM Domino Web Access (formerly iNotes Web Limited Limited
Access)
Native 64-bit support Yes Yes

PRODUCT ACTIVATION

SCANNING (GENERAL)

Trend Micro Online Registration system Yes Yes
One Activation Code (either for ScanMail for IBM Yes Yes
Domino or ScanMail for IBM Domino Suite)

Activation Code (Suite with Data Loss Prevention) Yes Yes

MAIL SCANNING

Multi-threaded scanning Yes Yes
Multi-threaded scan tasks Yes Yes
Separate actions for Adware/Spyware Yes Yes

Real-time scan Yes Yes
Advanced Threat scan Yes Yes
Mail scan rule based on mail sender/recipient Yes Yes
Different scan settings for users/groups with excep- Yes Yes
tions

Scheduled scanning with different settings at differ- Yes Yes
ent times

Virus cleaning upon detection Yes Yes
Configurable action upon detection Yes Yes
Nested compressed file scanning with selectable Yes Yes
scanning depth

MIME/HTML body scanning for script viruses Yes Yes
Malicious notes script, hot spots, and URL scanning Yes Yes
Signature-based scanning Yes Yes
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D-4

TABLE D-1.  SMLD 5.5 and SMID 5.6 feature comparison (Continued)
FEATURE SMLD 5.5 SMID 5.6

Supports trusted antivirus server(s) to avoid Yes Yes
rescanning

Selectively scans embedded OLE objects Yes Yes
IntelliTrap support Yes Yes
Microsoft Office 2007 support Yes Yes
Microsoft Office 2010 support Yes Yes
Decompression algorithm support RAR, SFX, CHM, Yes Yes

NSIS, and ZIP SFX files

Anti-spam support Yes Yes
End User Quarantine Yes Yes
Enables End User Quarantine for specified No Yes
users/groups

Deploys End User Quarantine to mail templates No Yes

WEB REPUTATION

ADWARE DETECTION

Configurable action upon detection

SPYWARE DETECTION
Configurable action upon detection

MAIL/BANDWIDTH MANAGEMENT

Web reputation support Yes Yes
Local Web reputation support Yes Yes
Web reputation notification No Yes

Redirects email for approval Yes Yes
Supports selectable grouping of file types Yes Yes
APT Prevention Filter Yes Yes
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extension name

CONTENT FILTERING (REQUIRES SCANMAIL FOR IBM DOMINO SUITE / EMANAGER)

TABLE D-1.  SMLD 5.5 and SMID 5.6 feature comparison (Continued)
FEATURE SMLD 5.5 SMID 5.6

Configurable attachment blocking by true file type Yes Yes
(individual file types)
Configurable action for Microsoft Office macros Yes Yes
Configurable attachment blocking by extension or Yes Yes
filename
Configurable attachment blocking by true file type Yes Yes
(group)
Strips macros from Microsoft Office documents Yes Yes
Delays mail according to a specific schedule Yes Yes
Blocks mail depending on size Yes Yes
Lower priority setting Yes Yes
Blocks mail based on the attachment’s true file type Yes Yes
Blocks mail based on the attachment’s file or Yes Yes

Message header field scanning Yes Yes
Filters for text in message body Yes Yes
Filters for text in message attachment Yes Yes
Regular expression support Yes Yes
Microsoft Office 2007 file support Yes Yes
Microsoft Office 2010 file support Yes Yes
Additional OLE layer scanning support for a maxi- Yes Yes
mum of 20-layers

Uses heuristics technology Yes Yes
Supports Approved/Blocked Senders lists Yes Yes
Configurable filter sensitivity Yes Yes
Uses rule file Yes Yes
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TABLE D-1.  SMLD 5.5 and SMID 5.6 feature comparison (Continued)
FEATURE SMLD 5.5 SMID 5.6

Real-time scanning Yes Yes
Scheduled scanning Yes Yes
Manual scanning Yes Yes
Configurable time period for multiple real-time scan- Yes Yes
ning configurations
Script scanning support in real-time scanning Yes Yes
Scheduled scanning within defined time periods Yes Yes
(maximum duration)
Support for several scheduled scans with different Yes Yes
settings
Resume a scan that did not finish Yes Yes
Script scanning support in scheduled scanning Yes Yes
Configurable scan schedule through Configuration Yes Yes

database

DATA Loss PREVENTION FILTERING

Message header field scanning Yes Yes
Filters for text in message body Yes Yes
Filters for text in message attachment Yes Yes
Microsoft Office 2007/2010 file support Yes Yes
Additional OLE layer scanning support for a Yes Yes
maximum of 20-layers

Uses heuristics technology Yes Yes
Specify file names to be excluded from all data loss Yes Yes
prevention filters

Configurable filter sensitivity Yes Yes
Uses rule file Yes Yes
Real-time scanning Yes Yes
Scheduled scanning Yes Yes
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TABLE D-1.  SMLD 5.5 and SMID 5.6 feature comparison (Continued)
FEATURE SMLD 5.5 SMID 5.6

Manual scanning Yes Yes
Configurable time period for multiple real-time Yes Yes
scanning configurations
Script scanning support in real-time scanning Yes Yes
Scheduled scanning within defined time periods Yes Yes
(maximum duration)
Support for several scheduled scans with different Yes Yes
settings
Resume a scan that did not finish Yes Yes
Script scanning support in scheduled scanning Yes Yes
Configurable scan schedule through configuration Yes Yes

database

ADMINISTRATION

Full integration with R6/5 Administrator Client and No No
Notes Client

Lotus Notes 7/8 support Yes Yes
IBM Notes 9 support Yes Yes
Remote administration through a Web interface Yes Yes
Remote administration through a Notes Client Yes Yes
User interface uses frames and follows the latest Yes Yes
Trend Micro standard

Server status monitoring available through user Yes Yes
interface

Server task watch dog Yes Yes
Task status monitoring Yes Yes
Share server settings and antivirus policies between Yes Yes
servers and groups of servers

User-defined and controlled rules to define actions Yes Yes
Ability to define rules based on users and groups Yes Yes
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ANTIVIRUS AND CONTENT SECURITY COMPONENT UPDATES

TABLE D-1.  SMLD 5.5 and SMID 5.6 feature comparison (Continued)
FEATURE SMLD 5.5 SMID 5.6
Configurable server settings that are policy-inde- Yes Yes
pendent
Role-based access configurable through the Notes Yes Yes
interface
One-button information collector (Support Tool) Yes Yes

Manual update Yes Yes
Select components and set recurring scheduled Yes Yes
updates

Automated pattern update through ActiveUpdate Yes Yes
Automated scan engine update through ActiveUp- Yes Yes
date

Automated program updates through ActiveUpdate Yes Yes
Pattern/Engine integrity check after update Yes Yes
Product integrity check after update Yes Yes
Full and Small pattern download support for Yes Yes
TMASE.

IntelliTrap pattern update support Yes Yes

NOTIFICATION OPTIONS

Customized notifications Yes Yes
Notifications via IBM Instant Messaging (ScanMail Yes Yes
for Domino for Windows only)

Sender, recipient, or administrator notifications Yes Yes
Separate notifications to internal/external users Yes Yes
Rich text configurable message Yes Yes
Supports notification insertion in a MIME email Yes Yes
Safe stamp in the message subject Yes Yes
Safe stamp in Notes message body Yes Yes
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TABLE D-1.  SMLD 5.5 and SMID 5.6 feature comparison (Continued)

FEATURE SMLD 5.5 SMID 5.6
Safe stamp in SMTP message body Yes Yes
Multiple disclaimer support Yes Yes
Single disclaimer inserted when an email passes Yes Yes
multiple servers
Supports disclaimer positioning Yes Yes

QUARANTINE

Automatically deletes quarantined logs based on Yes Yes
type, age, and records to retain

Supports resend/restore of quarantined items Yes Yes
Supports forwarding of quarantined items No Yes

LOGGING/STATISTICS

Exports statistics to a Microsoft Excel spreadsheet Yes Yes
Automatically deletes logs Yes Yes
Identify the sender of an infected message Yes Yes
Identify infected file Yes Yes
Supports Threat Connect information portal access Yes Yes
Records the recipient information Yes Yes
Records the action taken on a threat Yes Yes
Graphical email statistics/reports Yes Yes
Log search No Yes
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